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Introducing Matrox RT.X2

This chapter provides an 
overview of Matrox RT.X2, and 
describes the available Matrox 
RT.X2 documentation
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Welcome to Matrox RT.X2
Matrox RT.X2 products let you get maximum productivity from Adobe Premiere 
Pro, and are ideal for corporate communicators, event videographers, project 
studios, educational facilities, and digital filmmakers. Matrox RT.X2 SD is for 
users who want to deliver in SD only, while Matrox RT.X2 and RT.X2 LE give 
you the flexibility to edit, view, and output HD and SD material. For details on all 
the Matrox RT.X2 products, see the Matrox Video website at 
www.matrox.com/video.

About this manual
This manual explains how to use Matrox RT.X2 with the provided Matrox 
software, including how to use your RT.X2 system with Adobe Premiere Pro.

¦ Note Throughout the Matrox RT.X2 documentation, the term “RT.X2” refers 
to RT.X2, RT.X2 LE, and RT.X2 SD, unless indicated otherwise.

Style conventions
The following style conventions are used in this manual:

• The names of files, directory paths, and manuals appear in italics. For 
example:

$ The data is stored in the sample.wav file.

$ The file is located in your C:\Windows\System directory.

$ Please refer to your Matrox RT.X2 Installation Manual.

• Menus and commands that you need to choose are displayed in the form 
Menu > Command. For example, File > Save means click File in the 
menu bar, then click Save in the menu that appears.

• The names of keys are displayed in small capital bold letters, such as the 
CTRL key.

• A plus (+) sign is used to indicate combinations of keys and/or mouse 
operations. For example:

$ CTRL+C means to hold down the CTRL key while pressing the C key.

$ SHIFT+click means to hold down the SHIFT key while you click an item 
with the mouse.
pter 1, Introducing Matrox RT.X2

http://www.matrox.com/video
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How video formats are expressed
With the exception of NTSC and PAL, all SD and HD video formats are 
expressed in the Matrox RT.X2 documentation and dialog boxes as follows:

VRp or i or PsF @ n fps

Where:

• VR is the vertical resolution. For 1440×1080 video, however, both the 
horizontal and vertical resolutions are specified.

• p or i or PsF represents progressive, interlaced, or progressive segmented 
frame video.

• @ n fps is the frame rate in frames per second.

Here are some examples:

• 486p @ 23.98 fps Represents 720×486 progressive video at 23.98 frames 
per second.

• 720p @ 59.94 fps Represents 1280×720 progressive video at 59.94 
frames per second.

• 1440x1080i @ 29.97 fps Represents 1440×1080 interlaced video at 29.97 
frames per second. This format is used for HDV 1080i material.

• 1080i @ 29.97 fps Represents full-size 1920×1080 interlaced video at 
29.97 frames per second.

Other documentation
In addition to this user guide, the following Matrox RT.X2 documents are 
available:

• Matrox RT.X2 Installation Manual Provides detailed instructions for 
installing your Matrox RT.X2 hardware and software, including how to 
connect your external devices to the RT.X2 breakout box.

• Matrox RT.X2 Release Notes Provides any important last-minute 
information and known issues.
Other documentation
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Your notes
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Calibrating Your DVI Monitor

for Video
This chapter explains how to 
use the Matrox DVI Calibration 
Utility to calibrate your Matrox 
RT.X2 DVI monitor for video.
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Overview
¦ Note This chapter does not apply to RT.X2 LE or RT.X2 SD.

The Matrox DVI Calibration Utility is a unique tool designed to calibrate your 
DVI monitor so that it performs like a traditional broadcast video monitor. This 
utility provides a wizard that walks you through the calibration process using 
specially designed patterns to effectively identify and compensate for the 
processing errors that may be present in your DVI monitor. The Matrox DVI 
Calibration Utility calibrates your monitor’s black and white levels, white point, 
gamma response, and hue and chroma.

¡ Important To use the Matrox DVI Calibration Utility, your DVI monitor must 
support a display resolution of at least 1280×720.

This utility is optimized for calibrating DVI monitors that display the DVI output 
from RT.X2 at its exact resolution without any scaling. If the DVI output is scaled 
by your monitor, a blue-only filter will be required to calibrate your monitor’s 
color (hue and chroma). In this case, you must use a third-party blue-only filter 
(for example, a blue gel filter, or blue-only calibration glasses) that completely 
blocks out all colors except for blue.

¦ Note This utility is best viewed at a display resolution of 1280×800 or higher.

Calibrating your DVI monitor
The Matrox DVI Calibration Utility provides on-screen instructions to calibrate 
your DVI monitor. At the end of the calibration process, you must save your 
calibration settings to a file. Once saved, the calibration settings are automatically 
loaded as your system’s current calibration settings. If you’re calibrating more 
than one DVI monitor, you can calibrate and save settings for each monitor and 
load the corresponding settings at any time (see “Loading Matrox DVI 
calibration settings” on page 7). You can later choose to enable or disable the 
loaded calibration settings (see “Enabling and disabling the Matrox DVI 
calibration settings” on page 8).

The Matrox DVI Calibration Utility uses the Matrox WYSIWYG Control Panel 
to display the specially designed patterns that are required to calibrate your DVI 
monitor. Therefore, you’ll need to configure your Matrox WYSIWYG output 
settings as explained in this section. For more information about using the 
Matrox WYSIWYG Control Panel, see “Configuring the Matrox WYSIWYG 
Control Panel” on page 114.

¡ Important When running the Matrox DVI Calibration Utility, make sure that 
you don’t run any other application that uses your Matrox RT.X2 hardware, such 
as Adobe Premiere Pro, or any other application that displays Matrox 
WYSIWYG output.
pter 2, Calibrating Your DVI Monitor for Video
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°To run the Matrox DVI Calibration Utility:

1 Ensure that your DVI monitor is connected to the DVI output on your 
RT.X2, turn the DVI monitor on, and allow it to warm up for about 20 or 30 
minutes.

2 Right-click the  icon on your Windows taskbar and configure your 
Matrox WYSIWYG output settings as follows:

$ Enable WYSIWYG Output must be selected.

$ Choose Output Configuration and on the Video Output page, set the 
DVI output to RGB - calibrated. This is required in order to run the 
Matrox DVI Calibration Utility and output the adjusted RGB DVI video 
to your DVI monitor.

$ All other required Matrox WYSIWYG output settings will be 
automatically set by the DVI Calibration Utility.

3 Click OK to save your video output settings.

4 Right-click the  icon on your Windows taskbar, and choose Matrox DVI 
Calibration Utility.

5 Follow the onscreen instructions to calibrate your DVI monitor.

6 When prompted at the end of the calibration process, save your calibration 
settings to a file anywhere on your system. Once saved, your settings are 
automatically loaded as your system’s current DVI calibration settings. You 
can later choose to enable or disable the loaded calibration settings (see 
“Enabling and disabling the Matrox DVI calibration settings” on page 8).

¦ Note The calibration settings file is saved as an .mtx file. If you cancel the 
DVI calibration, or close the utility at any time before saving the calibration 
settings, the current calibration settings will be lost.

Loading Matrox DVI calibration settings
After calibrating your DVI monitor and saving your calibration settings to a file 
(see “Calibrating your DVI monitor” on page 6), the calibration settings are 
automatically loaded as the current DVI calibration settings for your system. You 
can, however, load another DVI calibration settings file at any time, but only one 
calibration settings file can be loaded for your system at any given time. Once 
loaded, you can enable or disable the calibration settings (see “Enabling and 
disabling the Matrox DVI calibration settings” on page 8).

¦ Note If your system has multiple users, the loaded calibration settings apply to 
the logged on user only.
Loading Matrox DVI calibration settings
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1 Right-click the  icon on your Windows taskbar, choose Output 
Configuration and on the Video Output page, set the DVI output to RGB - 
calibrated.

2 Click OK to save your video output settings.

3 Right-click the  icon on your Windows taskbar, and choose Matrox DVI 
Calibration Utility.

4 From the Welcome page, click Load Settings.

5 When prompted, select your desired .mtx calibration settings file, and then 
click Open.

Enabling and disabling the Matrox DVI 
calibration settings

The DVI calibration settings that are loaded for your system (see “Loading 
Matrox DVI calibration settings” on page 7) can be enabled or disabled. When 
using a program that supports Matrox RT.X2 video output, you can configure the 
Matrox video output settings for that program to enable or disable the loaded 
DVI calibration settings. For example, you can configure the RT.X2 video output 
settings that you want to use with Adobe Premiere Pro as explained in 
“Specifying your video output settings” on page 16.

When you set the DVI video output to RGB - calibrated, the video that is output 
from the RT.X2 DVI output will have the color settings that are saved in the 
currently loaded calibration file. To disable the loaded calibration settings and 
output DVI video from RT.X2 with its native color settings, set the DVI video 
output to RGB - native.

¦ Note When you configure your Matrox WYSIWYG output settings, the 
settings apply to all programs that display Matrox WYSIWYG output. This 
means that when you set the DVI video output to RGB - calibrated using the 
Matrox WYSIWYG Control Panel, the currently loaded calibration settings will 
be applied when you preview DVI video using any program that displays Matrox 
WYSIWYG output, such as Adobe After Effects. For more information about 
using the Matrox WYSIWYG Control Panel, see “Configuring the Matrox 
WYSIWYG Control Panel” on page 114.
pter 2, Calibrating Your DVI Monitor for Video
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Defining Your Adobe Premiere Pro

Settings
This chapter explains how to 
define various settings for 
using Matrox RT.X2 with Adobe 
Premiere Pro. This includes 
creating a new Matrox project, 
and specifying your sequence 
and export settings.
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Running antivirus software with Adobe 
Premiere Pro

To avoid having dropped frames or other performance issues when working with 
your Matrox project, make sure that you disable any antivirus scanning of files 
while running Adobe Premiere Pro. If possible, schedule your antivirus scanning 
at a time when you’re not using Premiere Pro, such as overnight or on the 
weekend.

Setting your system’s volume levels
To properly capture and play back audio in Adobe Premiere Pro, make sure 
you’ve set appropriate recording and playback volume levels for your system as 
follows:

1 Right-click the speaker icon on the Windows taskbar and choose Playback 
Devices.

¥ Tip If you don’t see the speaker icon, right-click the Windows taskbar and 
choose Properties. In the Notification Area, indicate that you want the 
Volume icon to be shown.

2 From the list of available devices, double-click the device that you want to 
use with your Matrox RT.X2 system.

3 Click the Levels tab, and for each of the controls (Line-in, Microphone, 
etc.) make sure the volume slider is at an appropriate level, such as at 
midpoint. As well, make sure that each control is not muted.

¦ Note If you have an active audio stream connected to an input on your audio 
card via the RT.X2 breakout box, you must mute the input to avoid hearing 
the audio when you’re not working in Premiere Pro.

4 Click OK, and click the Recording tab.

5 From the list of available devices, double-click the device (input) that you 
want to use as the audio source, such as Line-in, with your Matrox RT.X2 
system.

6 Click the Levels tab, and make sure the volume slider is at an appropriate 
level, such as at midpoint.

7 Repeat steps 5 and 6 for every audio input source that you intend to use with 
your Matrox RT.X2 system. For example, if you intend on recording audio 
from a microphone, set the volume levels for the Microphone input.

8 Click OK.
pter 3, Defining Your Adobe Premiere Pro Settings
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Creating a new Matrox project
Creating a new Matrox project involves specifying the location of your scratch 
disks and selecting a Matrox sequence preset. For more information about using 
the Matrox sequence presets for working with different types of sequences, see 
Appendix B, “Matrox RT.X2 Workflows.”

°To create a new Matrox project:

1 Start Adobe Premiere Pro and click the New Project icon. The New 
Project dialog box appears. You can leave all the settings on the General 
page at the default settings. For details on changing these settings, see your 
Adobe Premiere Pro documentation.

2 Click the Scratch Disks tab, and use the Browse button to select an 
appropriate A/V drive for each scratch disk type. When specifying the 
location of your scratch disks, make sure you follow the recommendations in 
your Adobe Premiere Pro documentation. For example, store your video and 
audio files on a separate hard drive dedicated to your media assets.

¥ Tip Specifying the same scratch disk settings for all your projects will help 
shorten the amount of time it takes to open new or existing projects.

3 From the Location list, select where you want to save your project.

4 In the Name box, specify a name for your project.

5 Click OK to save your settings. The New Sequence dialog box opens on 
the Sequence Presets page.

6 Under Available Presets, select the preset that matches the type of 
sequence you want to create from the appropriate Matrox folder. For 
example, if you want to create an NTSC sequence and work in a standard 4:3 
editing environment, expand the 720×486 and NTSC folders under
Matrox - SD, then select the Standard preset.

Remarks
$ To work with PAL DV clips, make sure that you select a Matrox DV-PAL 

preset.

$ Matrox RT.X2 SD supports creating SD sequences only. Therefore, the 
Matrox HD presets are not available on RT.X2 SD.

7 In the Sequence Name box, specify a name for your sequence.

8 Click OK to apply the settings.

¦ Note If you want to export your sequence to a DV-1394 device other than 
DVCPRO HD, you need to copy or import your Matrox sequence into a native 
Adobe Premiere Pro sequence. For more details about exporting to tape, see 
“Exporting your sequence to tape” on page 39.
Creating a new Matrox project
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Defining your player settings
By default, each monitor in Adobe Premiere Pro (Source Monitor, Program 
Monitor, Trim Monitor, etc.) uses the Adobe Player to play material. However, in 
order to also preview the video simultaneously on your video monitor when 
working with Matrox RT.X2, your player settings need to be set to use the 
Matrox Player. To do this, choose Edit > Preferences > Player Settings and 
choose Matrox Player as the default player.

Remarks
• When using the Multi-Camera Monitor to preview a multi-camera sequence, 

you can choose between single-camera preview (active camera only) and 
quad-camera preview (all four camera previews) on your video monitor. For 
single-camera preview, select Show Preview Monitor in the Multi-Camera 
Monitor menu. For quad-camera preview, clear Show Preview Monitor.

• You can also use the Matrox Player to preview video played back from the 
timeline on your video monitor when working in Adobe Encore. To set the 
default project player to Matrox Player in Adobe Encore, go to the 
Advanced page of the Project Settings dialog box.

Displaying warnings in Adobe Premiere Pro’s 
Events panel

Matrox RT.X2 uses Adobe Premiere Pro’s Events panel to issue certain error 
messages and warnings. To display these, choose Window > Events. For more 
information about using the Events panel, see your Adobe Premiere Pro 
documentation.

A note about realtime playback capabilities
In most cases, Matrox clips and clips supported by Adobe Premiere Pro that 
match the frame size and aspect ratio of your sequence will play back in real 
time. For example, an XDCAM EX or P2 720p @ 29.97 fps clip will be realtime 
in any Matrox 720p sequence. You can also apply various realtime effects to your 
clips as explained in Chapter 4, “Setting Up Realtime Effects with Adobe 
Premiere Pro.”

When Premiere Pro requires clips to be rendered, a red render bar appears above 
the clips on the timeline. After playing back your sequence, a red bar will appear 
over any sections of the sequence that have dropped frames. To ensure that you 
don’t have dropped frames when you export your sequence to tape, you should 
play back your sequence and render all sections that have a red render bar before 
performing your export.
pter 3, Defining Your Adobe Premiere Pro Settings
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Remarks
• For the best quality output when previewing a sequence that has an 

interlaced video format, make sure that you choose Display Both Fields in 
the Program Monitor menu.

• If you set the playback resolution in the Program Monitor to anything other 
than full resolution, a yellow render bar may appear above realtime sections 
of the timeline. However, these sections will still play back in real time.

Defining your sequence settings
The Matrox Playback Settings dialog box has several pages that you can use to 
specify various settings for editing in Adobe Premiere Pro on Matrox RT.X2. 
When you select a Matrox sequence preset, a Matrox editing mode is 
automatically set for your sequence, and many settings are optimized for editing 
on Matrox RT.X2.

¡ Important The general and DV-1394 output settings in the Matrox Playback 
Settings dialog box apply to your entire project. The video output settings, 
however, are specific to your sequence. Any video output settings you specify for 
a particular video format will be applied the next time you create a new Matrox 
sequence in that same format. If you change any of the video output settings, the 
new settings will be applied to all previously created sequences that have that 
video format in your project. For example, if you create a new NTSC sequence, 
the settings you apply for that new NTSC sequence will also be applied to any 
previously created NTSC sequences in your project.

Specifying your general settings
To specify your general sequence settings on Matrox RT.X2:
Defining your sequence settings
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1 Choose Sequence > Sequence Settings and click the Playback 
Settings button. 

2 Click the General tab.

3 Under Scrubbing Mode, select Frame, 1st Field, or 2nd Field to indicate 
whether you want to display frames or only one field when you scrub a 
sequence in the Timeline panel. For example, you may want to scrub the 
first or second field to eliminate the flickering that can be seen in your 
picture when you pause while scrubbing interlaced video. Scrubbing fields 
can also be used to check for any dropped fields that may have occurred in 
your video during a telecine process.

¦ Note The scrubbing mode will be set to Frame if you’re working with a 
sequence that has a progressive video format.

4 Under Video Luma Level, select the type of processing that you want to be 
applied to luminance levels in your video when rendering and previewing 
video in a sequence:

$ Broadcast Processes video using the standard legal range of luminance 
levels for broadcast video. Any super black or super white luminance 
levels (that is, levels that fall below the standard black level or exceed the 
standard white level) are clipped.

$ Post Production Processes video for post production. Any super black 
or super white luminance levels in your video are retained.

5 Under A/V Sync Adjustment, drag the slider to adjust the A/V 
synchronization of clips played back in a sequence. If your audio starts later 
pter 3, Defining Your Adobe Premiere Pro Settings
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than the associated video, increase the A/V sync value. Alternately, if your 
audio starts before the associated video, decrease the A/V sync value. Be 
aware that if you decrease the value too much, you may experience audio 
crackling.

¦ Note To return the slider to it’s default setting, click its D button. This button 
is available for all sliders in the Matrox dialog boxes.

6 Under Error Reporting, select Report dropped frames on playback if 
you want to be warned each time frames are dropped when you play back 
video from the Timeline panel. Otherwise, clear this option.

¦ Note Once playback of the sequence has stopped, a red bar will appear over 
segments of the sequence that have dropped frames, even if you don’t choose 
to report dropped frames. To ensure that your sequence will play back without 
dropped frames, you should render all sections identified with red bars as 
explained in your Adobe Premiere Pro documentation.

7 Under Sequence Playback, indicate how you want your sequence to be 
played back:

$ Postroll after stop Applies postroll when you stop playback of a 
sequence. If you clear this option, the playback will stop at the 
current-time indicator, and you’ll see a slight jump in the video output 
when the playback stops (but the correct frame will be displayed).

$ Accelerate playback of non-realtime segments Improves playback 
performance of non-realtime segments, such as Adobe native effects. 
Clear this option only if you experience issues while playing back 
non-realtime segments of a sequence.

8 Under Realtime Engine, you can select the options you want for using 
Matrox RT technology:

$ Enable Matrox RT technology Select this to enable Matrox RT 
technology, which provides realtime Matrox effects and acceleration of 
many Premiere Pro effects. You can clear this option if you want the 
realtime performance of your project to depend only on the capabilities of 
Premiere Pro and your computer system.

$ Premiere Pro Accelerated Effects Select the options you want for 
your realtime/accelerated Premiere Pro effects (available only when 
Matrox RT technology is enabled):

• Accelerate effects and transitions Select this if you want realtime 
playback of Premiere Pro effects and transitions that support this 
feature as explained in Chapter 4, “Setting Up Realtime Effects with 
Adobe Premiere Pro.” Because Matrox emulates Premiere Pro’s native 
version of these effects and transitions, if you don’t like the emulation 
you can clear this option to revert to Premiere Pro’s native version that 
requires rendering.
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• Accelerate Motion Select this if you want realtime playback of 
Premiere Pro’s Motion effect. You can clear this option to turn off the 
Matrox acceleration and revert to Premiere Pro’s version that requires 
rendering.

9 Click OK to save your settings and return to the Sequence Settings dialog 
box.

Specifying your video output settings
You can specify various settings to configure your video output signals from the 
RT.X2 breakout box.

°To specify your video output settings:

1 Choose Sequence > Sequence Settings and click the Playback 
Settings button. 

2 Click the Video Output tab.

3 Under Master Output Format, select the video format you want for all 
video outputs from the RT.X2 breakout box. Depending on the video format 
of your sequence, you may not be able to change the master output format.

4 If the Aspect Ratio Conversion list is available, such as when the video 
output for an HD sequence is downconverted to NTSC or PAL, select one of 
the following settings for the video output:

$ 16x9 Letterbox Outputs the widescreen 16:9 picture in letterbox mode 
by adding black bars at the top and bottom of the picture for display on a 
standard 4:3 television screen.

$ Anamorphic Outputs the widescreen 16:9 picture as horizontally 
compressed 4:3 video, which retains the picture’s full vertical resolution 
for display on a widescreen television. To display the video with the 
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correct proportions on an NTSC or PAL monitor, select the 16:9 display 
setting on the monitor.

5 If the Pulldown Method list is available, select the pulldown method you 
want to be applied to your output video (Standard 2:3 or Advanced 
2:3:3:2). Depending on the frame rate of your sequence and the current 
master output format, a pulldown method may automatically be selected.

6 Under Analog Setup (NTSC), select the setup level you want for your 
NTSC analog video:

$ 0 IRE Applies a setup level of 0 IRE. You should select this option only 
when working with a commercial DV device that uses the Japanese 
analog NTSC setup of 0 IRE. For example, if the video appears too bright 
when you play back DV clips on your NTSC monitor, you can change the 
setup to 0 IRE to output your DV clips at the correct brightness.

$ 7.5 IRE Applies the standard NTSC setup level of 7.5 IRE.

7 Under Analog Output Type, select the type of analog video output you 
want. If you’re outputting SD analog video, you can select Component or 
Composite & S-Video. If you’re outputting HD analog video, the analog 
output type will be set to Component.

8 Select Allow Super White to allow the highest luminance level of your 
video output to exceed the standard maximum white level. Select Allow 
Super Black to allow the lowest luminance level of your video output to fall 
below the standard black level.

¦ Note Super white and super black should not be allowed when producing 
your final video production for broadcast.

9 Under DVI Output Type, select the type of DVI video that you want to be 
sent from RT.X2’s DVI output (not applicable to RT.X2 LE or RT.X2 SD):

$ RGB - calibrated Outputs adjusted RGB DVI video using the currently 
loaded Matrox DVI calibration settings for your DVI monitor. For details 
on calibrating your DVI monitor and loading calibration settings using the 
Matrox DVI Calibration Utility, see Chapter 2, “Calibrating Your DVI 
Monitor for Video.”

$ RGB - native Outputs native RGB DVI video that does not apply any 
calibration compensation. Select this when you want to disable the 
currently loaded Matrox DVI calibration settings and output DVI video 
from RT.X2 using its native color settings for previewing video on your 
DVI monitor.

10 Click OK to save your settings and return to the Sequence Settings dialog 
box.
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Selecting your DV-1394 output settings
You can choose to output a Matrox sequence over the 1394 interface to perform 
an export to a DVCPRO HD device.

¦ Note DV-1394 export to DVCPRO HD is supported for 1080i @ 25 fps, 
29.97 fps, and 720p @ 59.94 fps sequences only. For more information about 
exporting to a DVCPRO HD device, see “Exporting to a DVCPRO HD device 
using DV-1394 device control” on page 43.

°To select your DV-1394 output settings:

1 Choose Sequence > Sequence Settings and click the Playback 
Settings button. 

2 Click the DV-1394 Output tab.

3 Select Enable 1394 output for export to tape if you want your sequence 
to be output over the 1394 interface when you perform an export to tape (that 
is, when you choose File > Export > Export to Tape). This lets you record 
your sequence to a DVCPRO HD device.

¡ Important Because this option requires additional system resources, you 
may find that when this option is selected some effects that were previously 
realtime will drop frames and require rendering (you’ll see a red bar over 
these segments after playing back your sequence). Therefore, you should 
select this option only when you want to export your sequence to a 
DVCPRO HD device.

4 Click OK to save your settings and return to the Sequence Settings dialog 
box.
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Defining your video preview settings
When you select a Matrox sequence preset, an appropriate preview file format 
and codec are automatically set for previewing your video on Matrox RT.X2. 

Depending on your sequence’s video format, you can select a different codec to 
render your video previews. For details on configuring Matrox codec settings, see 
“Configuring the Matrox DVCPRO HD codec” on page 122, “Configuring the 
Matrox Uncompressed codecs” on page 122, and “Configuring the Matrox 
MPEG-2 I-frame codecs” on page 123.

Remarks
• When you configure a Matrox uncompressed codec (SD or HD resolution), 

make sure that you select 8-bit as your bit depth and set the scan mode to 
match your sequence’s video format. For example, if you are working with a 
progressive sequence, set the bit depth to 8-bit and the scan mode to 
Progressive.

• The Matrox DVCPRO HD codec is supported for rendering video previews 
in 1080i @ 25 fps and 29.97 fps projects only. When you configure the 
Matrox DVCPRO HD codec, make sure that you choose the frame rate that 
matches your sequence’s video format.

• When selecting a standard or widescreen preview file format for an SD 
sequence, make sure that you select the format that matches your sequence’s 
video format, such as NTSC Standard for a Matrox NTSC standard 
sequence.

• The Matrox MPEG-2 I-frame codec is not supported for rendering video 
previews in Matrox NTSC and 486p sequences. As an alternative for these 
sequences, you can set the preview file format to I-Frame Only MPEG to 
render your video previews using the Adobe MPEG I-frame codec.

For details on specifying additional settings for your video previews, see your 
Adobe Premiere Pro documentation.
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Defining your capture settings
The Matrox Capture Settings dialog box has pages that you can use to specify 
your settings for capturing video and audio in Adobe Premiere Pro on Matrox 
RT.X2. If you want to capture material using RS-422 device control, see “Setting 
up Matrox RS-422 device control” on page 37. If you want to capture material 
from a DV-1394 device using device control, you can use Adobe DV/HDV 
device control as explained in your Adobe Premiere Pro documentation.

¦ Note When you specify your capture settings on Matrox RT.X2, VU meters 
can be displayed to let you monitor your audio input levels. For more 
information, see “Monitoring audio levels for capture” on page 27.

Specifying your video capture settings
Matrox RT.X2 lets you capture your video to various formats depending on the 
video format of your sequence. For example, if you’re working with an SD 
sequence, you can capture to a DV format such as DVCPRO to create .avi files 
for use in your Premiere Pro projects. For certain HD sequences, you can capture 
DVCPRO HD material natively over the DV-1394 interface to an .avi file.

When working with an SD sequence, you can also choose to capture video to an 
.m2v file for DVD authoring using Adobe Encore. For details about specific 
limitations when capturing to Matrox .m2v files, see “Notes about capturing to 
Matrox .m2v files” on page 28.

°To specify your settings for capturing video in Adobe Premiere Pro on 
Matrox RT.X2: 

1 Choose Project > Project Settings > General.

2 From the Capture Format list, select Matrox AVI to capture to an .avi file, 
or Matrox M2V to capture to an .m2v file (for SD sequences only).

¦ Note If you want to capture DV material other than DVCPRO HD natively 
over the 1394 interface, you need to use a native Adobe Premiere Pro DV or 
HDV capture format. For details on how to capture material in Adobe Premiere 
Pro, see your Adobe Premiere Pro documentation.
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3 Click the Configure button, then click the Video Capture Settings tab.

4 Under Input Device, select the device from which you want to capture 
material (this may be automatically set for you based on your sequence’s 
video format):

$ RT.X2, RT.X2 LE, or RT.X2 SD to capture material from an analog source 
connected to your RT.X2 breakout box.

¦ Note Analog input is not supported for 486p, 576p, 720p, 1440×1080p, 
and 1080p sequences.

$ DV-1394 to capture material from a DV-1394 device connected to your 
system. For capture to a Matrox .avi file, DV-1394 input is supported only 
for native DVCPRO HD capture when working with 1080i, 1080p 
@ 29.97 fps, and 720p @ 23.98 fps, 25 fps, 29.97 fps, and 59.94 fps 
sequences. For capture to a Matrox .m2v file, DV-1394 input is supported 
for all SD sequences.

¦ Note Capturing audio from a DV-1394 device is not supported for a 720p 
@ 25 fps sequence.

5 If you selected the RT.X2 breakout box as your input device, from the Input 
Source list, select the type of input you want to capture (Component, 
Composite, or S-Video). This will be set to Component when capturing 
analog video for an HD sequence (not supported on RT.X2 SD).

Remarks
$ If you selected DV-1394 as your input device, the name of the DV-1394 

device connected to your system will appear in the Input Source box.

$ If Matrox RT.X2 can’t detect your source device when you start a capture, 
you’ll receive an error message. Either black video will be captured or the 
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capture won’t be able to start until a valid input signal is present. In either 
case, you must make sure that your source device is switched on and 
properly connected to your system to properly capture the video.

6 From the Input Format list, select the video format that matches your 
source video. Depending on your sequence’s video format, you may not be 
able to change the input format. If needed, Matrox RT.X2 will apply an 
appropriate pulldown method to convert the incoming video to your 
sequence’s video format. For example, if your sequence’s video format is 
1080p @ 23.98 fps and you set the Input Format to 1080i@29.97fps, a 
standard reverse pulldown (2:3 cadence) will be applied to capture the video 
to 1080p @ 23.98 fps. 

7 From the Input Aspect Ratio list, select the aspect ratio of your SD source 
video (4:3 or 16:9). For example, to capture video that was recorded using 
the standard TV screen format, select 4:3. To capture video that was 
recorded using the widescreen 16:9 format, select 16:9. If you’re capturing 
video for an HD sequence, the Input Aspect Ratio will be set to 16:9.

8 Under Capture Format, select your desired capture format from the list. If 
you’re capturing DVCPRO HD material to an .avi file from a DV-1394 
device, the video will be captured natively over the DV-1394 interface and 
the Capture Format will be set to Native DVCPRO HD. If you’re 
capturing to an .m2v file, the Capture Format will be set to Matrox 
MPEG-2 IBP.

¦ Note The capture formats that are available in the Capture Format list 
depend on the video format of your sequence. For more information, see 
“Supported video compression formats” on page 147.

$ Matrox DV/DVCAM Captures video to DV or DVCAM format. 

$ Matrox DVCPRO Captures video to DVCPRO format. 

$ Matrox MPEG-2 I-frame Captures video to MPEG-2 intra-frame 
format using the 4:2:2 Profile @ Main Level at a selected data rate (SD 
resolution only). For the best results when capturing video clips on which 
you’ll be applying chroma key effects, you should use this codec instead 
of a DV codec.

$ Matrox MPEG-2 I-frame  HD Captures video to MPEG-2 intra-frame 
format using the 4:2:2 Profile @ High Level at a selected data rate (HD 
resolution only). This is the only capture format available to capture 
analog video for 1440×1080i and 1080i sequences.

9 If you’re capturing to a Matrox MPEG-2 format, click the Configure button 
to configure your MPEG-2 settings. For details on the available settings, see 
“Selecting your MPEG-2 I-frame settings” on page 29, or “Selecting your 
MPEG-2 IBP settings” on page 31. Once you’ve configured your settings, 
click OK to return to the Matrox Capture Settings dialog box.
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10 If you’re capturing Panasonic VariCam material, select Enable VariCam 
capture (supported only for a 720p @ 23.98 fps or 25 fps sequence). 
Matrox RT.X2 will remove the redundant (filler) frames from the VariCam 
input during capture and create a clip in the same format as your sequence 
for editing. 

¡ Important When you select Enable VariCam capture, audio cannot be 
captured. When batch capturing VariCam clips, you must indicate that you 
want to capture video only by selecting Video on the Logging pane of the 
Capture panel under Setup.

11 Select Use Automatic Gain Control (AGC) if you want the gain of your 
composite or S-Video input signal to be adjusted automatically to 
compensate for very bright or dark images. This improves the brightness or 
contrast of your picture.

12 From the Input Type list, select the type of equipment you’re using for 
capture:

$ Broadcast-quality Source Select this if your source device is 
broadcast-quality. This setting provides the best capture results for most 
devices.

$ Consumer-quality Source Select this if you’re having problems 
capturing video because your source device doesn’t meet 
broadcast-quality standards. For example, the capture may be interrupted 
when you try to capture from certain composite and S-Video devices, 
especially from low-quality VCRs. If this happens, selecting 
Consumer-quality Source will allow the video to be captured, but you 
may experience dropped frames during the capture.

¦ Note For any change to the input type to take effect, you must restart 
Premiere Pro and open your project again.

13 Click OK to save your settings and return to the Project Settings dialog 
box. 
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Specifying your audio capture settings
You can specify various audio capture settings, such as to specify your input 
source and the type of audio files (either stereo .wav or mono .wav) that you want 
to create when capturing audio on Matrox RT.X2.

Remarks
• When you capture to an .avi file on Matrox RT.X2, the clip’s video and audio 

are saved to the .avi file, and the clip’s audio is also saved to one or more 
separate .wav files. You could choose to edit the separate .wav files using 
audio post-processing software, such as Adobe Soundbooth. 

• When you capture to an .m2v file on Matrox RT.X2, the clip’s associated 
audio is always saved to one or more separate stereo .wav files.

°To specify your settings for capturing audio in Adobe Premiere Pro on 
Matrox RT.X2: 

1 Choose Project > Project Settings > General.

2 From the Capture Format list, select Matrox AVI to capture to an .avi file, 
or Matrox M2V to capture to an .m2v file (for SD sequences only).

3 Click the Configure button, then click the Audio Capture Settings tab:

4 If you selected the RT.X2 breakout box as your video input device (see 
“Specifying your video capture settings” on page 20), you must also select 
the source from which you want to capture audio. Your audio source must 
match the audio input where you connected the cable labeled TO AUDIO 
CARD IN from your RT.X2 breakout box as explained in your Matrox RT.X2 
Installation Manual. For example, if you plugged the TO AUDIO CARD IN 
connector into the Line-In jack (or corresponding jack) on your sound card, 
select Line-In from the Input Source list.
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Remarks
$ If all available audio inputs don’t appear in the Input Source list, select 

List all audio inputs. If your audio input connection does not appear in 
the list, you must unplug the TO AUDIO CARD IN connector and 
connect it to an audio input on your sound card that appears in the list.

$ If your analog audio source appears with an * beside it in the list, your 
sound card does not have matching audio inputs and outputs. In this case, 
choose the audio source with an * that matches your audio input, make 
sure that your source is playing back audio, and click Advanced 
Settings. In the provided dialog box, select an analog audio passthrough. 
If you can hear audio, then you’ve selected the correct analog audio 
source and passthrough. If you can’t hear audio, try selecting a different 
analog audio source and/or passthrough.

$ The Capture Format (bit-depth) for your captured audio files is set to 
16-bit.

5 If you want the VU meters to be displayed each time you configure your 
Matrox RT.X2 capture settings or open the Capture panel, select Show VU 
meters. For details on using the VU meters, see “Monitoring audio levels 
for capture” on page 27.

6 Under Capture Files, indicate whether you want to capture to stereo or 
mono audio files, and select which channels you want to save to separate 
.wav files.

$ From the File Type list, select Stereo to save your captured audio to 
stereo .wav files, or Mono to save your captured audio to mono .wav files. 
If you’re capturing an .m2v clip, the File Type will be set to Stereo.

$ From the Filename lists, select which stereo pairs or mono channels you 
want to save to your .wav files. When capturing from a DV-1394 device, 
you can capture up to two stereo files or up to four mono files. Select 
None if you don’t want a particular .wav file to be created. When Matrox 
RT.X2 saves each .wav file, it assigns a .Stereo.wav or .Mono.wav suffix 
to the base name you gave for the associated video file. For example, if 
you’ve named your video file MyFile.avi, the associated stereo audio files 
would be named MyFile.Stereo1.wav, MyFile.Stereo2.wav, etc. 

Remarks
$ The channels that you choose to save to the first stereo.wav file or first 

two mono.wav files will be embedded in the associated .avi file. When 
you import your .avi file to the Project panel, the clip’s separate .wav files 
will also be imported, and the embedded audio in the .avi file will be 
ignored. The clip’s .avi file and first associated .wav file, however, will 
appear as a single Movie clip in your project. The embedded audio in the 
.avi file will be used only if the .avi file does not have any associated .wav 
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files. Therefore, if you perform audio post processing on your .avi files, 
make sure you delete the associated .wav files so that only the embedded 
audio in the .avi files will be used in your project.

$ When performing an audio-only capture, Matrox RT.X2 supports capture 
of only one stereo pair. Your first stereo or first two mono channels will be 
saved to a single stereo .wav file (any other channels will be ignored). 
When RT.X2 saves the .wav file of an audio-only capture, it does not 
assign the .Stereo.wav suffix to the filename. 

7 Click OK to save your settings and return to the Project Settings dialog 
box. 
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Monitoring audio levels for capture
If you select Show VU meters on the Audio Capture Settings page, each 
time you configure your Matrox RT.X2 capture settings or open the Capture 
panel to start a capture in Adobe Premiere Pro, VU meters will be displayed to let 
you monitor the levels of your currently selected audio input source.

As you play your audio source, the color of the input level is green at or below
–12 dBSF, yellow between –12 and –6 dBFS, and red above –6 dBFS. The 
clipping detectors will “light up” (become red) whenever audio clipping occurs. 
The peak level indicators are thin lines that show the highest level recently 
reached. These indicators will show the peak level for about two seconds or until 
a higher peak level is reached.

If needed, adjust the audio level on your source device to keep the average input 
level between –30 and –10 dBSF. You can also use Windows Volume Control to 
adjust your audio input levels as explained in “Setting your system’s volume 
levels” on page 10.

Clipping detectors

Peak level indicators
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Notes about capturing to Matrox .m2v files
When capturing to Matrox .m2v files, keep the following points in mind:

• Automatic scene detection (Scene Detect) is not supported, but batch capture 
is supported.

• Batch capture to Matrox .m2v files is not frame accurate.

• An associated .xmp metadata file is created for all captured and logged 
(offline) .m2v clips. These files are created in your specified video capture 
folder, and contain time code and other information that you provided for 
your .m2v clips, such as tape name, description, and scene. You can open the 
.xmp files in Adobe Bridge. Take care not to delete the .xmp files and always 
keep them with their associated .m2v files. Otherwise, you won’t be able to 
batch capture logged .m2v clips, and the time code information won’t appear 
for your .m2v clips in the Project panel.

• Matrox .m2v files are to be used for DVD authoring with Adobe Encore. 
However, if you want to use your Matrox .m2v clips in Adobe Premiere Pro, 
be aware of the following issues:

$ The associated .wav files for your .m2v clips are not automatically 
imported to the Project panel.

$ When performing a batch capture of .m2v clips, the captured video and 
audio clips won’t be automatically imported to the Project panel. Because 
you won’t be able to link the logged (offline) clips to the captured files on 
disk, you’ll have to import the batch captured .m2v clips manually. As 
well, if you recapture clips using batch capture, captured video clips will 
be imported automatically only if you choose to delete the original media 
files from disk.

$ When you place a Matrox .m2v clip on a video track, an empty associated 
.wav clip will be placed on an audio track beneath it. To get rid of this 
clip, select it in the sequence and choose Clip > Unlink. Once you’ve 
unlinked the .wav from the .m2v, you can select the .wav clip on the audio 
track and delete it.

$ It’s recommended that you don’t add handles (extra frames) to your 
captured .m2v clips. If you do, the handles will be appropriately trimmed 
from the video when you add the clip to your sequence, but the handles 
won’t be trimmed from the associated audio.
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Selecting your MPEG-2 I-frame settings
When you select the Matrox MPEG-2 I-frame or Matrox MPEG-2 I-frame HD 
format to capture video, you can specify various settings for the MPEG-2 I-frame 
compression. 

°To select your MPEG-2 I-frame settings: 

1 Click the Configure button. This displays a dialog box similar to the 
following:

2 Drag the Data Rate slider until your desired data rate is displayed. The 
higher the data rate you select, the better the video quality will be. The range 
of available data rates depends on whether you’re using the Matrox MPEG-2 
I-frame HD or SD format.

¡ Important Depending on the capabilities of your system, you may drop 
frames if you select a data rate higher than 125 Mb/sec.

3 To apply advanced settings to your MPEG-2 I-frame file, click the 
Advanced button.

¦ Note The default advanced settings should provide good results for most 
applications. We recommend that you change these settings only when needed 
for special purposes. 

4 Under Rounding Type, select one of the following:

$ MPEG-2 Rounds the AC coefficients up to the nearest whole number 
when calculating the quantization coefficient. 

$ Matrox Custom Truncates the AC coefficients to the lowest whole 
number when calculating the quantization coefficient. In some cases, this 
setting may yield less artifacts in graphics.

5 Under DC Precision, select the bit-depth precision of the DC intra block.
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¦ Note The higher the DC precision value that’s used to capture or render 
your video, the more likely that the DC content will be increased at the expense 
of the AC content in the encoded stream. This may result in lowering the 
overall quality of the compressed stream at a specified data rate. 

6 Under Zig Zag Type, select one of the following:

$ Regular Sets the regular (default) zig zag scanning pattern of the AC 
coefficient of the DCT block as defined in the ISO/IEC 13818-2 (figure 
7-2) specification documentation.

$ Alternate Sets an alternate zig zag scanning pattern of the AC 
coefficient of the DCT block as defined in the ISO/IEC 13818-2 (figure 
7-3) specification documentation. Use this setting when capturing or 
rendering video at a high data rate (that is, at a data rate of about 50 
Mb/sec for SD video, or 100 Mb/sec or higher for HD video).

7 Select the Force Frame-based DCT setting to render macroblocks as 
frames rather than as fields. In some cases, graphics will yield less artifacts if 
this option is selected.

8 Click OK to save your settings.
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Selecting your MPEG-2 IBP settings
When capturing video to a Matrox .m2v file using Adobe Premiere Pro, the 
capture format is set to Matrox MPEG-2 IBP. You can specify various settings for 
the MPEG-2 IBP compression.

°To select your MPEG-2 IBP settings:

1 Click the Configure button. This displays a dialog box similar to the 
following:

2 Under Data Rate (Mb/sec), you can select the encoding type and data rate 
for the MPEG-2 IBP compression.

$ Encoding type From this list, select one of the following:

• Constant bit rate (CBR) Video is compressed at your selected 
target data rate, which is useful when you need to limit or predict the 
size of your .m2v file. However, if your video is very complex (such as 
scenes with many colors or sharp edges), you’ll need to select a high 
data rate to avoid having frames of very blocky video in your file.
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• Variable bit rate (VBR) Video is compressed at varying data rates 
based on the complexity of the video. The target data rate you select is 
used as the average data rate for the compression.

$ Min, Target, and Max sliders Use these sliders to select your desired 
data rate. The higher the target data rate you select, the better the video 
quality will be. Only the Target slider will be available if you selected 
Constant bit rate (CBR). If you selected Variable bit rate (VBR), all 
three sliders will be available so that you can set the minimum, target, and 
maximum data rates for the video compression.

¦ Note Adobe Encore requires CBR-encoded .m2v files longer than about two 
minutes to be transcoded. VBR-encoded .m2v files do not require transcoding 
in Adobe Encore.

3 Under GOP Structure, you can customize the GOP structure for the 
MPEG-2 IBP compression as follows:

$ GOP length Determines the number of frames in the GOP (Group of 
Pictures).

$ Subgroup length Determines the subgroup length of B-frames and 
P-frames in the GOP, after the initial I-frame. For example, a subgroup of 
3 appears as “BBP,” and a subgroup of 2 appears as “BP.” The available 
subgroup lengths depend on your selected GOP length.

4 Under Profile, the 4:2:0 profile is selected, which uses 4:2:0 
luminance/chrominance sampling and is suitable for broadcast transmission 
and distribution on DVD.

5 Under Motion Estimation, drag the slider to adjust the quality of the 
motion estimation used for the video compression. The default setting gives 
good results for most video. However, if you have a lot of fast motion in your 
video, such as fast-paced sports footage, you can get better results by 
dragging the slider to the right (towards Slow/High quality). This improves 
the quality of the motion estimation, but decreases the speed of the video 
compression. Alternately, if you have mostly slow-paced video, you may 
want to drag the slider to the left (towards Fast/Low quality) to decrease 
the quality of the motion estimation and speed up the video compression.

6 Click OK to save your settings.
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Exporting to a Matrox .avi file
Several software codecs are included with Adobe Premiere Pro so that you can 
export your video to different formats. Your Matrox RT.X2 system adds several 
Matrox Video for Windows (VFW) codecs to the ones included with Premiere 
Pro to allow you to export your sequence to a Matrox .avi file. For more 
information about using the Matrox Video for Windows codecs, see Chapter 7, 
“Using the Matrox Video for Windows Codecs.”

If your system includes a Matrox CompressHD card, you can also export your 
sequence to a Matrox MAX H.264 file as explained in your Matrox CompressHD 
Installation and User Guide.

Remarks
• When batch encoding clips that use the same Matrox VFW codec, they must 

have the same codec settings. For example, you cannot export multiple clips 
with the Matrox MPEG-2 I-frame HD codec that have different data rates. 
You can, however, batch encode clips using different Matrox VFW codecs 
and clips that use the same Matrox VFW codec with identical codec settings.

• To export clips from a Matrox NTSC or 486p sequence to a 720×480 
Matrox .avi file using a Matrox VFW DV or MPEG-2 I-frame codec, you 
must crop the height of the video by applying cropping on the Source page 
of the Export Settings dialog box as follows:

GPU-accelerated effects disabled (software only)

Crop settings

Sequence format Export to DV Export to MPEG-2 I-frame

NTSC Top = 5, Bottom = 1 Top = 5, Bottom = 1

486p Top = 4, Bottom = 2 Top = 6, Bottom = 0

GPU-accelerated effects enabled

Crop settings

Sequence format Export to DV Export to MPEG-2 I-frame

NTSC Top = 3, Bottom = 3 Top = 5, Bottom = 1

486p Top = 4, Bottom = 2 Top = 6, Bottom = 0
Exporting to a Matrox .avi file
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°To export your sequence to a Matrox .avi file:

1 Unless you want to export your entire sequence, position the work area bar 
over the section of the sequence you want to export.

2 Choose File > Export > Media. This opens the Export Settings dialog 
box.

3 From the Format list, select Microsoft AVI.

¦ Note The Microsoft AVI format lets you export your sequence using any 
Matrox VFW codec. Although the Matrox AVI format is also available, it is 
provided only for exporting a 720p sequence to a Matrox .avi file so that you 
can export the sequence to a DVCPRO HD device. For details, see “Preparing 
a 720p sequence for export to a DVCPRO HD device” on page 44.

4 From the Preset list, select a Matrox preset that matches the video format 
you want for your exported file. (If you want to export to 486p format, you 
can select a Matrox 720×480p preset.)

5 Select Export Video and Export Audio if you want to export both video 
and audio.

¦ Note Exported audio will be embedded in your .avi file. Matrox RT.X2 does 
not support audio-only exports to an .avi file.
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6 Click the Video tab. Under Video Codec, you can select the Matrox codec 
you want, depending on the video format to which you’re exporting.

$ Matrox DV/DVCAM Renders video to DV or DVCAM format.

$ Matrox DVCPRO Renders video to DVCPRO format.

$ Matrox DVCPRO50 Renders video to DVCPRO50 or D-9 format.

$ Matrox DVCPRO HD Renders video to DVCPRO HD format (for 
1080i and 720p video only).

$ Matrox MPEG-2 I-frame Renders video to MPEG-2 intra-frame 
format using the 4:2:2 Profile @ Main Level at a selected data rate (SD 
resolution only).

$ Matrox MPEG-2 I-frame + Alpha Renders video to MPEG-2 
intra-frame format with alpha using the 4:2:2 Profile @ Main Level at a 
selected data rate (SD resolution only).

$ Matrox MPEG-2 I-frame HD Renders video to MPEG-2 intra-frame 
format using the 4:2:2 Profile @ High Level at a selected data rate.

$ Matrox MPEG-2 I-frame HD + Alpha Renders video to MPEG-2 
intra-frame format with alpha using the 4:2:2 Profile @ High Level at a 
selected data rate.
Exporting to a Matrox .avi file
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$ Matrox Uncompressed SD Renders video to 8-bit or 10-bit 
uncompressed SD format.

$ Matrox Uncompressed SD + Alpha Renders video to 8-bit or 10-bit 
uncompressed SD format with alpha.

¡ Important To export to NTSC or 486p format using a Matrox 
Uncompressed SD codec, you must set the frame size to 720×486 using the 
Width and Height settings on the Video page.

$ Matrox Uncompressed HD Renders video to 8-bit or 10-bit 
uncompressed HD format.

$ Matrox Uncompressed HD + Alpha Renders video to 8-bit or 10-bit 
uncompressed HD format with alpha.

7 If you selected a Matrox codec that requires configuration, click the Codec 
Settings button. For details, see “Configuring the Matrox DVCPRO HD 
codec” on page 122, “Configuring the Matrox Uncompressed codecs” on 
page 122, and “Configuring the Matrox MPEG-2 I-frame codecs” on 
page 123.

8 From the Frame Rate list under Basic Settings, set the appropriate frame 
rate for the video format to which you are rendering. For example, if you are 
rendering to 1080i @ 29.97 fps format, set the frame rate to 29.97.

9 From the Source Range list in the Source Panel, select the range you want 
to export, such as Work Area.

10 Click Queue to send your export request to Adobe Media Encoder, or click 
Export to immediately start your export.

For information about other video export settings and using Adobe Media 
Encoder, see your Adobe Media Encoder documentation.

Exporting a Matrox NTSC or 486p sequence to 
MPEG-2 for DVD authoring

When you choose File > Export > Media to export a sequence, Adobe 
Premiere Pro provides the MPEG2-DVD export format in the Export Settings 
dialog box, which lets you export your sequence to a DVD-compliant MPEG-2 
file suitable for use with most DVD authoring programs, such as Adobe Encore. 
To export a Matrox NTSC or 486p sequence to a 720×480 MPEG2-DVD format, 
you must crop the height of the video by applying cropping on the Source page 
of the Export Settings dialog box as follows:

• To export an NTSC sequence, set Top = 5, and Bottom = 1

• To export a 486p sequence, set Top = 6 and Bottom = 0

For details on how to export to MPEG2-DVD format, see your Adobe Premiere 
Pro documentation.
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Setting up Matrox RS-422 device control
Matrox RS-422 device control lets you control any device that supports the 
RS-422 SMPTE time code protocol when capturing or exporting material to tape 
in Adobe Premiere Pro. To use this device control, you must use an RS-232 to 
RS-422 adapter cable to connect the serial device control port on your source 
device or recorder to the serial port on your computer.

°To configure your RS-422 device control settings:

1 Choose Edit > Preferences > Device Control.

2 From the Devices list, select Matrox RS-422 Device Control.

3 Click Options to display the following dialog box:

4 From the Port list, select the COM port on your computer to which you’ve 
connected your device.

5 From the Time Source list, select the time source to be used for controlling 
your device:

$ LTC Longitudinal Time Code recorded on a track adjacent to the video 
(this is the default time source). This type of time code can be read at all 
tape speeds, except still.

$ VITC Vertical Interval Time Code that is recorded onto the vertical 
blanking interval of the video. This type of time code can be read 
whenever an image is displayed, but not usually during high-speed 
operation.

$ LTC+VITC Select this if you want your device to decide which type of 
time code to use in different operational modes. You should select this 
option only if you’re sure that the two types of time code match on your 
tape.

$ Control Track Select this if you want to use only your tape’s control 
track as the time source. Because using the control track is not as reliable 
Setting up Matrox RS-422 device control
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as LTC or VITC for device control, you should select this option only if 
you’re having problems using the time code on your tape.

6 From the Time Base list, select the time base that matches your tape, such as 
30 fps Drop Frame if you’re using NTSC video with drop frame time code, 
or 25 fps if you’re using PAL video.

7 Beside Time Code Offset, specify the number of frames to adjust the start 
time for capture and export to tape, if needed. For example, if capture and 
export to tape are starting three frames too early (that is, three frames before 
your specified In point), enter a time code offset of 3. Alternately, if capture 
and export to tape are starting three frames too late, enter a time code offset 
of -3. For an example of how to calibrate your device for frame-accurate 
export to tape, see “Obtaining a frame-accurate export to tape using Matrox 
RS-422 device control” on page 42.

8 Select Use VTR’s internal cue if the Matrox RS-422 device control is 
having problems cueing your VTR, such as when you cue to a specific In or 
Out point. Because using the VTR’s internal cueing method slows down the 
cueing, you should select this option only you’re experiencing problems 
cueing to a time code when using RS-422 device control.

9 Click OK to save your settings.

For details on capturing with device control, see your Adobe Premiere Pro 
documentation. For information about exporting your Matrox sequence to tape, 
see “Exporting your sequence to tape” on page 39.

Remarks
• You must set your device to Remote or VTR mode.

• You must stripe your tapes with continuous and consecutive time code. You 
can stripe your entire tape with time code by recording black video for the 
duration of the tape.

• When capturing material, make sure that you don’t specify any preroll or 
time code offset value in the Device Control section of the Settings pane. 
Instead, a preroll of about five seconds will automatically be applied, and 
you must specify any required time code offset in the Matrox RS-422 
Device Control Settings dialog box.
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Exporting your sequence to tape
To export your Matrox sequence to tape without using device control, simply 
play back your sequence and record the output from any of the available outputs 
on your Matrox RT.X2 system. If your recorder supports RS-422 device control, 
you can export your sequence to tape using Matrox RS-422 device control as 
explained in the next section, “Exporting to tape using Matrox RS-422 device 
control.”

To export your Matrox sequence to a DVCPRO HD device over the 1394 
interface, you can use Adobe DV/HDV device control as explained in “Exporting 
to a DVCPRO HD device using DV-1394 device control” on page 43. To export 
to a DV-1394 device other than DVCPRO HD, you must copy or import your 
Matrox project into a native Adobe Premiere Pro project and use Adobe 
DV/HDV device control as explained in your Adobe Premiere Pro 
documentation.

Remarks
• To avoid repeated or missing frames when performing an export to tape with 

device control, add about five seconds of black video or color bars to the 
start of your sequence.

• To avoid having discontinuous (broken) time code recorded onto your tape, 
set your recorder to generate time code internally based on time code already 
present on the tape (this setting is called INT REGEN on some devices). 
Don’t use free run or external time code regeneration mode.

• To avoid problems when exporting your sequence to tape, make sure that 
your project’s auto-save feature is turned off. To do this, choose Edit > 
Preferences > Auto Save and make sure that Automatically save 
projects is not selected. Once your export is complete, you can turn the 
auto-save feature back on.

Exporting to tape using Matrox RS-422 device 
control
With Matrox RS-422 device control, you can perform either an insert or assemble 
edit to record your Matrox sequence onto tape as follows:

1 Open your project, activate the Matrox sequence that you want to export to 
tape, and position the work area bar over the section of the sequence that you 
want to export.

2 If you haven’t already done so, play back your sequence and render any 
non-realtime sections that are identified with a red render bar.

3 Make sure that you’ve properly connected your recorder and configured 
Matrox RS-422 device control as explained in “Setting up Matrox RS-422 
device control” on page 37.
Exporting your sequence to tape
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4 Load a striped recordable tape into your recorder, and set your recorder to 
Remote or VTR mode.

5 Choose File > Export > Tape to display the following dialog box:

6 To review or change your RS-422 device control settings, click Device 
Options. This displays the Matrox RS-422 Device Control Settings 
dialog box as explained in “Setting up Matrox RS-422 device control” on 
page 37 (except you won’t be able to change the specified port).

7 Under Export to Tape Mode, you can specify the type of export you want 
to perform and the tracks you want to be recorded:

$ Assemble Records all tracks (video and audio) sequentially onto the 
tape. The control track and previously recorded material on the tape will 
be replaced with the material recorded from your sequence.

$ Insert Records selected tracks (video and/or audio), without affecting 
the control track. This lets you perform a video or audio dub. For 
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example, you can choose to record only video, only selected audio tracks, 
or video and selected audio tracks from your sequence.

¦ Note Check your device’s documentation to determine its recording 
capabilities for assemble and insert editing. Some recorders may not support 
insert editing.

8 Use the transport controls to play back your tape. The current time code of 
your tape appears in the text box above the transport controls. You can also 
use the J, K, and L shortcut keys to control the shuttle. Press J to shuttle left, 
L to shuttle right, and K to stop. Pressing J or L multiple times increases the 
speed of the shuttling.

9 Specify where you want the recording to start and stop on your tape as 
follows:

$ Click the Set In Point button ( ) to specify where you want the 
recording to start, or enter the required time code in the In box.

$ Click the Set Out Point button ( ) to specify where you want the 
recording to stop, or enter the required time code in the Out box. 
Alternately, you can select Duration and enter the duration you want for 
the recording. The Out point will then be calculated for you. By default, 
the duration is set to the duration of the work area. You can click Reset at 
any time to set the duration back to the duration of the work area.

¦ Note When Out is selected, the duration is calculated based on your 
selected In and Out points. When Duration is selected, the Out point is 
calculated based on your specified In point and duration.

10 If needed, enter the number of frames to offset the playback of your 
sequence beside Playback Offset. For example, if the playback starts too 
late and you’re missing the first three frames of your sequence recorded on 
the tape, enter an offset of -3. If the playback starts too early and the first 
three frames of your sequence are repeated, enter an offset of 3.

¡ Important Before adjusting the Playback Offset, you should first make 
any required adjustment to the Time Code Offset for your device as 
specified in the device control settings. For an example of how to calibrate 
your device for frame-accurate export to tape, see “Obtaining a 
frame-accurate export to tape using Matrox RS-422 device control” on 
page 42.

11 Click Export to start the export to tape.
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Obtaining a frame-accurate export to tape 
using Matrox RS-422 device control
In order to obtain a frame-accurate export to tape when using Matrox RS-422 
device control, there are two different settings that you may need to adjust:

• The Time Code Offset in the Matrox RS-422 Device Control Settings 
dialog box determines when your device starts recording on the tape. If the 
recording doesn’t start on the tape at your specified In point, you can adjust 
this offset so that the recording starts earlier or later.

• The Playback Offset in the Matrox RS-422 Export to Tape dialog box 
determines when your sequence starts playing back. Depending on your 
system, you may need to adjust this offset so that your sequence starts 
playing back earlier or later.

Here’s an example of how to calibrate your RS-422 device for frame-accurate 
export to tape:

1 Stripe an NTSC tape with continuous and consecutive time code starting at 
00:00:00:00.

2 Create a new Matrox NTSC sequence with a bars and tone clip about ten 
seconds long containing time code starting at 00:00:00:00. Make sure you 
place the clip at the start of your sequence.

¥ Tip You can create a bars and tone clip by right-clicking in the Project 
panel and choosing New Item > Bars and Tone. You can add time code to 
the clip by applying a Timecode effect as explained in your Adobe Premiere 
Pro documentation.

3 Set up Matrox RS-422 device control with the Time Code Offset set to 0 
(see “Setting up Matrox RS-422 device control” on page 37).

4 Export your sequence to tape and set the In point for the recording to 
00:00:10:00 and the Playback Offset to 0 (see “Exporting to tape using 
Matrox RS-422 device control” on page 39).

5 When the export to tape is finished, play back your tape and check where the 
recording started. For example, if the bars and tone clip started recording at 
00:00:09:25 on your tape (five frames before your specified In point), then 
you need to set the Time Code Offset to 5. Alternately, if the recording 
started at 00:00:10:05 (five frames after your specified In point), then you 
need to set the Time Code Offset to -5.

6 Make any required adjustment to the Time Code Offset in the Matrox 
RS-422 Device Control Settings dialog box, and perform another export 
to tape with the In point for the recording set to 00:00:30:00 and the 
Playback Offset set to 0.

7 When the export to tape is finished, go to 00:00:30:00 on your tape (the 
recording should have started at that time code), and check which frame 
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from your sequence has been recorded. You should see frame 00:00:00:00 
from your bars and tone clip at 00:00:30:00 on your tape, with no repeated 
frames. For example, if frame 00:00:00:00 has been repeated for the next 
five frames, then your sequence started playing back five frames too early 
and you need to set the Playback Offset to 5. Alternately, if you see frame 
00:00:00:05 from your bars and tone clip recorded at 00:00:30:00, then the 
sequence playback started five frames too late and you need to set the 
Playback Offset to -5.

Exporting to a DVCPRO HD device using 
DV-1394 device control
When working with a Matrox 1080i @ 25 fps, 29.97 fps, or 720p @ 59.94 fps 
sequence, you can choose to export your sequence to a DVCPRO HD device over 
the 1394 interface using Adobe DV/HDV device control.

¡ Important To export a 720p @ 23.98 fps, 29.97 fps, or 59.94 fps sequence to a 
DVCPRO HD device over the 1394 interface, you must first export your 
sequence to a Matrox .avi file using the Matrox DVCPRO HD codec in 720p @ 
59.94 fps format, import your Matrox .avi file to a new 720p @ 59.94 fps 
sequence, and then export your sequence to tape. DV-1394 export to DVCPRO 
HD is not supported for any other 720p format. For more information, see 
“Preparing a 720p sequence for export to a DVCPRO HD device” on page 44.

°To export your sequence to tape over the 1394 interface:

1 Open the project and activate the sequence you want to export to tape.

2 If you’re exporting a 1080i @ 25 fps or 29.97 fps sequence, play back your 
sequence and render any non-realtime sections that are identified with a red 
render bar using the Matrox DVCPRO HD codec (see “Defining your video 
preview settings” on page 19).

3 Make sure your DV-1394 device is properly connected and turned on, and 
that you’ve enabled the DV-1394 output for export to tape as explained in 
“Selecting your DV-1394 output settings” on page 18.

4 If you’re using a camcorder, switch it to VTR mode. 

5 Load a striped recordable tape into your DV-1394 device.

6 Make sure that you’ve set up Adobe DV/HDV device control as explained in 
your Adobe Premiere Pro documentation. 

7 Choose File > Export > Export to Tape.

For information about exporting your sequence to tape using Adobe Premiere 
Pro, see your Adobe Premiere Pro documentation.
Exporting your sequence to tape
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Preparing a 720p sequence for export to a DVCPRO HD 
device
In order to export a Matrox 720p @ 23.98 fps, 29.97 fps, or 59.94 fps sequence to 
a DVCPRO HD device over the 1394 interface, you must first export your 
sequence to a Matrox .avi file using the Matrox DVCPRO HD codec in 720p @ 
59.94 fps format as follows:

1 Activate the Matrox sequence that you want to export, and choose File > 
Export > Media to open the Export Settings dialog box.

2 From the Format list, select Matrox AVI (for PTT only).

3 The Preset will be set to Matrox 720p @ 59.94 fps. Appropriate export 
settings are automatically applied, and the codec is set to Matrox DVCPRO 
HD (no configuration settings are required).

4 Click Export to start your export.

Once the export has finished, create a new Matrox 720p @ 59.94 fps sequence, 
import your Matrox .avi file, and place it on the timeline. You can now export the 
new sequence to tape as explained in “Exporting to a DVCPRO HD device using 
DV-1394 device control” on page 43.
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Creating an SD project in 16:9 format
When editing on Matrox RT.X2, you can choose to work with SD source video 
that’s been recorded in either the 4:3 standard TV screen format, or the 
widescreen 16:9 format.

°To create an SD project in 16:9 format on Matrox RT.X2, do the following:

1 Record your video onto tape with your camera set to the widescreen 16:9 
format. The video will be recorded as horizontally compressed 4:3 
(anamorphic) video.

2 Start Adobe Premiere Pro and create a new Matrox project using the 
appropriate Matrox widescreen preset, such as NTSC widescreen, for your 
sequence (see “Creating a new Matrox project” on page 11). This ensures 
that the effects you create on Matrox RT.X2 will be displayed with the 
correct proportions when viewed in 16:9 format.

3 Capture your video clips as you normally would. Select the 16:9 display 
option on your NTSC or PAL video monitor to “unsquish” the video and 
play it back in widescreen format without distortion. 

4 If you create animations, titles, or graphics for your project using a program 
that lets you set the pixel aspect ratio, use the appropriate setting for 16:9 
display:

$ For NTSC or 486p video, set the pixel aspect ratio to 1.185.

$ For PAL or 576p video, set the pixel aspect ratio to 1.422.

If you can’t set the pixel aspect ratio, create your image at 864×486 for 
NTSC or 486p video, or at 1024×576 for PAL or 576p video. After you’ve 
created your image, resize only its width to 720. When you resize the image, 
your text or graphic will appear elongated on your computer screen.

5 Edit your project as you would a standard 4:3 project. 

¦ Note Be aware that if your video monitor is displaying in 4:3 format, certain 
effects may appear elongated because of the horizontal scaling. Setting your 
monitor to 16:9 will display the effects with the correct proportions.

6 Record your finished project onto tape. Remember that you’ll need a 
monitor capable of displaying material in 16:9 format to properly view your 
master tape.
Creating an SD project in 16:9 format
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Your notes
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Setting Up Realtime Effects with Adobe

Premiere Pro
This chapter explains how to 
set up realtime Matrox effects 
such as color corrections and 
wipes using the Matrox 
realtime plug-in for Adobe 
Premiere Pro.
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Available effects
The Matrox realtime plug-in for Adobe Premiere Pro lets you set up the 
following realtime1 Matrox effects in your Matrox projects2:

• Color corrections.

• Chroma key and luma key effects.

• Chroma clamper effect.

• Wipes.

The following Adobe effects are also accelerated for realtime playback:

• Black and white.

• Crop.

• Timecode.

• Motion.

• Video opacity (fades).

• Additive dissolve, cross dissolve, dip to black, and dip to white transitions.

• Speed changes.

• Graphics overlays using single-frame graphics files with an alpha-key 
channel.

When you install Matrox Mtx.utils, all the Matrox effects are added to Adobe 
Premiere Pro. You set up Matrox effects in your projects the same way as other 
effects included with your Adobe software. For example, you apply a Matrox 
wipe to your clips in Adobe Premiere Pro just as you would any other type of 
transition, except that the controls provided let you create a Matrox wipe, as 
explained in this chapter. For instructions on setting up Adobe Premiere Pro 
effects and transitions, refer to your Adobe documentation.

¥ Tip You can filter the Effects panel to show only the effects and transitions that 
are accelerated by your Matrox hardware by clicking the  button at the top of 
the Effects panel.

1 Applying certain Adobe Premiere Pro settings to your clips may require you to render 
your effects, such as when you apply Field Options, Frame Hold, or Interpret Footage 
settings.

2 The Matrox color correction, chroma key, luma key, and chroma clamper effects are 
also available in Adobe After Effects.
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How to apply a Matrox video effect in Adobe 
Premiere Pro

The Matrox plug-in for Adobe Premiere Pro allows you to apply several Matrox 
video effects to your clips. To apply a Matrox video effect, drag the desired effect 
from the Effects panel onto the clip in the Timeline panel.

By default, the Matrox video effects are found in the Matrox bin under Video 
Effects.

¥ Tips
• You can also apply preconfigured Matrox video effects found in the Matrox 

Effect Presets bin under Presets.

• If you can’t see the Effects panel, choose Window > Effects. If you can’t 
see the Effect Controls panel, choose Window > Effect Controls.

How to apply a Matrox video transition in 
Adobe Premiere Pro

In Adobe Premiere Pro, the Matrox wipe transitions are found in the Matrox bin 
under Video Transitions in the Effects panel.

There are numerous methods to create transitions in Premiere Pro. Use the 
method that works best for you to apply your Matrox wipes. For information on 
applying transitions, see your Adobe Premiere Pro documentation.
How to apply a Matrox video effect in Adobe Premiere Pro
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Applying a mask to your Matrox effects
The Matrox color correction, chroma key, and luma key effects allow you to add 
a mask to define the area where you want to apply your effect. For example, you 
may want to apply a color correction to only one area of your clip and leave the 
rest of the clip untouched. 

°To adjust the mask properties: 

Click the triangle next to Mask to expand the property list. 

The properties under Mask let you control the area on the clip where you want to 
apply the mask. You can enter the values you want in the text boxes or drag the 
appropriate sliders (Left, Right, Top, and Bottom).

• Left Adjusts the left edge of your mask.

• Right Adjusts the right edge of your mask.

• Top Adjusts the top edge of your mask.

• Bottom Adjusts the bottom edge of your mask.

• Select Mask Displays a dialog box in which you can apply your mask 
settings (see “Using Select Mask” on page 51).

• Invert Inverts the mask so that your effect is applied outside the mask, 
instead of within the mask.
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Using Select Mask 
To apply a mask to your Matrox effect using the Select Mask dialog box, click 
the triangle next to the Select property to expand it, then click the Select Mask 
button:

The Select Mask dialog box allows you to apply a mask in two ways:

• Click and drag directly in the Select Mask window to create the rectangular 
area where you wish to apply the mask.

You can resize the mask area by dragging any side of the rectangle. For ex-
ample, dragging the right side of the rectangle adjusts the right edge of the 
mask area. To resize the entire mask area at once, drag one of the corners 
(the corner that’s diagonally opposite the corner you are moving will remain 
stationary).

• Use the Left, Right, Top, and Bottom controls to adjust any edge of your 
mask by a given number of pixels. You can enter values in the text boxes or 
drag the sliders to resize your mask area. For example, drag the Left slider to 
adjust the left edge of your mask area.
Applying a mask to your Matrox effects



52

Cha
Creating a Matrox primary color correction
Color correction is important for all productions, whether you want to achieve 
continuity when cutting between shots, ensure broadcast safe levels, or establish 
and emphasize a “look.” Matrox color correction provides basic proc amp 
control, three-way color correction complete with master, shadows, midtones, 
and highlights control, and input and output level control. You can also easily 
match colors with a reference shot. For more information about color matching, 
see “Matching colors between two clips” on page 63.

¥ Tip Adobe Premiere Pro includes a workspace setup that is optimized for 
working with clips and effects to facilitate color correction. To prepare your 
workspace for color correction, choose Window > Workspace > Color 
Correction.

°To set up a Matrox primary color correction:

Click the triangle next to Matrox Color Correction (Primary) or Matrox Color 
Correction (Primary - Advanced) to expand the property list.

¦ Note The RGB Curves and Tonal Range settings are available only with the 
advanced versions of the Matrox primary and secondary color correction effects. 
Because the advanced versions of these effects require additional system 
resources, you should apply them only if you want to use the RGB Curves or 
Tonal Range settings.

• Enable Split View Select this option to split your clip into two sections in 
the Program Monitor and on your video monitor. One section will display 
your clip as you adjust the color correction controls, and the other section of 
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the clip will remain unchanged. For more information, see “Using Split 
View” on page 54.

¡ Important This option is for preview only. You should clear it before you 
render your clip, otherwise the split will appear in your video output.

• Proc Amps The processing amplifier (proc amp) controls allow you to 
adjust different aspects of your clip:

$ Hue Adjusts the tint of the colors in the image.

$ Saturation Adjusts the saturation (vividness) of the image’s colors.

$ Contrast Adjusts the difference in luminance between the lightest and 
darkest areas of the image.

$ Brightness Adjusts the level of black in the image.

• RGB Curves Lets you use curves to adjust the red, green, and blue color 
channels of your clip individually, or use a master curve to adjust all color 
channels simultaneously. For more information, see “Using RGB curves” on 
page 56.

• Color Balance These controls let you adjust the mixture of colors in your 
clip.

$ Tonal Range Allows you to fine-tune the tonal ranges of your clip by 
reducing the range of pixels included for shadows, midtones, or 
highlights. For more information, see “Adjusting tonal range” on page 58.

$ Graphical Allows you to see a graphical representation of your changes 
when you adjust the color balance settings. You can also modify most of 
the color balance settings directly within the graph. For more information, 
see “Using the color balance graph” on page 59.

$ Numerical Lets you adjust your color balance settings numerically by 
entering values in the text boxes, or by dragging the corresponding sliders. 
You can adjust the Hue, Saturation, and Luminance for each tonal 
range.

• Master (Hue, Saturation, and Luminance) Affects all areas of 
your clip from the lightest white to the darkest black.

• Shadows (Hue, Saturation, and Luminance) Affects the darkest 
areas of your clip.

• Midtones (Hue, Saturation, and Luminance) Affects the areas 
with tones between the darkest and lightest areas of your clip.

• Highlights (Hue, Saturation, and Luminance) Affects the lightest 
areas of your clip.

• Luma Mapping

$ Graphical Allows you to see a graphical representation of your changes 
when you adjust the luma mapping settings. You can also modify the 
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luminance of your clip directly within the graph. For more information, 
see “Using the luma mapping graph” on page 65.

$ Numerical Lets you adjust the luma mapping settings numerically by 
entering values in the text boxes, or by dragging the corresponding sliders. 

• Input Levels (Black and White)  These controls let you fine-tune 
your clip’s brightness and contrast by changing the luminance value 
that represents black, white, or gray. Doing so expands or compresses 
the range of luminance levels in your clip, which increases or decreases 
your clip’s tonal range.

For example, by increasing the black value, you set black in your clip 
to a higher luminance value, which compresses the luminance range 
and darkens your clip proportionally.

• Output Levels (Black and White) These controls let you map the 
values under Input Levels to any level of black and white. You can 
reduce contrast in your clip, or reverse the luminosity of your clip by 
setting black to a higher value than white.

• Gamma Use this to adjust the midtones in your clip without 
adjusting black or white.

• Mask  Allows you to apply a mask to your effect. For more information, 
see “Applying a mask to your Matrox effects” on page 50.

Using Split View
The Split View option allows you to split your clip in two for preview on your 
Program Monitor and your video monitor. One section displays your clip as you 
adjust the color correction controls, while the other section of the clip remains 
unchanged.

There are two ways to enable Split View. You can select the Enable Split View 
option in the Effect Controls panel, or work directly in Adobe Premiere Pro’s 
Program Monitor using your mouse. 
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Working with Split View in the Program Monitor 
To activate the Split View controls in the Program Monitor, click the Transform 
icon ( ) beside the name of the Matrox color correction effect in the Effect 
Controls panel. The Split View button will appear in the upper left corner of the 
Program Monitor: 

Enable Split View by clicking the Split View button. You can then drag the 
handles on the corners of the split rectangle to define the area you want to split. 
You can also drag the split rectangle to move it to a specific region of your clip. 
The area within the split view rectangle will display any color correction you 
make, while the area outside remains unchanged. 

In the following example, the split view rectangle has been moved to display the 
color correction in the area surrounding part of the Chinese character on the wall: 

Remarks
• The Split View option is for preview only. You should disable it before 

rendering your material, otherwise the split will appear in your video output.

• If you enable Split View and create a mask outside the split view rectangle, 
you will not be able to see it. The mask will only be visible when you move 
the split view rectangle directly over it. If you invert a mask that is not in the 
split view rectangle area, the whole clip will be inverted since the mask is 
ignored.

Split View button
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Using RGB curves

¦ Note The RGB Curves settings are available only with the advanced versions 
of the Matrox primary and secondary color correction effects.

With RGB curves, you can individually adjust the red, green, and blue color 
channels across the entire tonal range of your clip, or adjust all three color 
channels simultaneously with a master curve. RGB curves allow you to achieve 
color effects that would be difficult, if not impossible, to achieve using the Color 
Balance settings, and also give you a high degree of control over the color 
channels in each tonal range. For example, you can easily add a red, green, or 
blue tint to your clip, or use the master curve as a way to adjust the brightness and 
contrast of your clip.

Each curve is displayed on a grid with the horizontal axis representing the input 
or current pixel value, and the vertical axis representing the output value of the 
pixel after the curve adjustment is applied. By default, a curve starts as a straight 
line with two end points, one at the bottom left of the grid (shadows), and the 
other at the top right of the grid (highlights). Before any adjustments are made, 
each point on the curve has the same input and output value. 

0 Default end point 
(shadows)

1 Default end point 
(highlights)

0

1
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Click the R, G, or B button to select the curve corresponding to the color channel 
you want to adjust, or click the Master button for the master curve, and then drag 
the curve to obtain your desired effect. For example, click the R button and drag 
the top right end point towards the top left of the grid to increase the slope of the 
curve and add red to the clip. Drag that same point towards the bottom right of 
the grid to decrease the slope of the curve and remove red from the clip. Clicking 
the Enable button will show/hide any adjustments you have made to the RGB 
channels at any time (you do not need to click Enable to start adjusting the 
curves). 

¥ Tip For increased precision, hold down the ALT key while you drag the curve, 
or the CRTL key to change your cursor into a crosshair that will help you align 
your curve to the grid. 

You can add up to 14 control points to each curve in addition to the two default 
end points. These control points act as anchors that allow you to lock your curve 
so adjustments can be applied only to specific tonal ranges. Click on a curve to 
add control points, and hold the SHIFT key while clicking a control point to 
delete it (end points cannot be deleted). Adjusting the points in the top right area 
of the grid affects highlights, the middle area affects midtones, and the bottom 
left area affects shadows. For example, the following S-shaped master curve adds 
contrast in the midtones range, without creating any completely black or white 
areas. 
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If you want to reset the Master, R, G, or B curve to its default setting at any time, 
click the appropriate Reset button.

¥ Tip By applying a mask to your clip, you can adjust the RGB channels for that 
specific area of your clip, or invert the mask to isolate that same area from being 
affected by your RGB adjustments.

Adjusting tonal range

¦ Note The Tonal Range settings are available only with the advanced versions 
of the Matrox primary and secondary color correction effects.

Using the tonal range curves allows you to fine-tune the range of pixels that are 
affected when you make a color correction to the shadows, midtones, or 
highlights of your clip using the color balance graph. For more information, see 
“Using the color balance graph” on page 59. 

The histogram shows the distribution of pixels in each tonal range of your clip. In 
the following example, the histogram represents a clip with a high amount of 
shadows (left), a lesser amount of midtones (middle), and an even lesser amount 
of highlights (right).

Click the Shadows, Midtones, or Highlights button to select the curve 
corresponding to the tonal range you want to adjust, and then drag the curve as 
desired to reduce the number of pixels to be included in each tonal range. 

¦ Note You cannot increase the number of pixels in a tonal range. For example, 
you can’t extend the shadows curve into the highlights range.

Red curve Reset button

0 Shadows 1 Midtones 2 Highlights

0 1 2
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Using the color balance graph
The color balance graph allows you to modify the Color Balance settings for 
each tonal range directly within the color maps. You can also perform an auto 
balance or a color match using the buttons beneath the color maps. For more 
information, see “Performing an auto balance” on page 62 and “Matching colors 
between two clips” on page 63. Depending on which color map you use, you can 
adjust your clip globally, or only the shadows, midtones, or highlights.

You can drag the handle in the center of any color map to adjust the color balance 
(Hue and Saturation) for a specific tonal range, such as to adjust the color 
balance globally throughout your clip using the Master color map, or adjust the 
color balance of only the shadows using the Shadows color map. Drag the 
handle toward a color you want to increase in your clip, or away from a color you 
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want to decrease. For example, if you move the handle towards red, you also 
decrease cyan by the same amount, as shown in the following diagram:

¥ Tip For increased precision, hold down the ALT key while you drag the handle.

If you want to reset the color balance (Hue and Saturation) setting, click the 
Reset Color Balance button under the color map you are using.

To adjust the luminance for a tonal range, drag the corresponding luminance 
slider under the appropriate color map. For example, if you want to adjust the 

MAGENTARED

YELLOW BLUE

CYANGREEN

Reset Color 
Balance button
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luminance for only the shadows, drag the luminance slider under the Shadows 
color map.

Luminance 
slider
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Performing an auto balance
Before matching colors, you can perform an auto balance on your target clip to 
automatically apply a color shift to your clip to compensate for different lighting 
conditions. To do this, click the Auto Balance button under the corresponding 
color map and use the eyedropper to select the area you want to correct in your 
clip. For example, to balance your clip’s highlights, click the Auto Balance 
button under the Highlights color map, and click (or click and drag) on the 
lightest area of your clip. The auto balance is performed immediately.

¦ Note To perform an auto white balance, click the Auto White Balance button 
under the Master color map, and click (or click and drag) on a white or light gray 
area of your clip.

Auto Balance 
button
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Matching colors between two clips
You can perform a color match to match colors between two clips (such as skin 
tone, sky, etc.). The color match lets you select colors from a reference clip to 
match to your target clip. You can affect the colors globally (Master), or just the 
Shadows, Midtones, or Highlights. 

You can select the colors for your reference color and match color by either 
clicking the Color Picker button or the eyedropper.

The eyedropper can be used in two ways:

• Click the eyedropper button and click on the desired color in your clip.

• Click the eyedropper button and click and drag anywhere on your clip to 
create a rectangular area containing the color you want to select. The 
selected color will be an average of the pixel information contained within 
the rectangle.

°To perform a color match:

1 Prepare your workspace for color correction by choosing Window > 
Workspace > Color Correction.

2 Open your target clip (clip that contains the colors you want to correct) in the 
Source Monitor.

¦ Note For best results when using a target clip that has multiple effects 
applied to it, create a nested sequence and open it in your Source Monitor 
before performing the color match. For more information about creating 
nested sequences, see your Adobe Premiere Pro documentation.

3 Apply the Matrox Color Correction effect to your target clip on the 
timeline.

4 Use the controls under the Reference Monitor to move to a frame in your 
reference clip that contains the colors you want to match.

5 Use the controls under the Source Monitor to go to the frame in your target 
clip that contains the colors you want to match to your reference clip.

EyedropperColor Picker button
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6 Select a reference color from your reference clip by using the Reference 
Color eyedropper under the color map you want to affect (Master, 
Shadows, Midtones, or Highlights). 

7 For example, to match a very dark color in your reference clip to your target 
clip, click the Reference Color eyedropper under the Shadows color map, 
and click (or click and drag) on the desired color in your reference clip.

8 Select a match color from your target clip in the Source Monitor window by 
using the Match Color eyedropper under the corresponding color map 
(Master, Shadows, Midtones, or Highlights).

Reference Color eyedropper

Match Color eyedropper
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Using the luma mapping graph
To modify your luma mapping values directly in the graph, click the triangle next 
to the Luma Mapping Graphical property to expand it:

• Map This is the default view when you first expand the Graphical 
property. You can drag the handles in the graph to adjust the Input and 
Output levels for black and white, as well as the Gamma.

• Plot Click this button to plot the luminance values in the current frame of 
your clip to the histogram (the plot will reflect any color correction changes 
you’ve made). Each luminance value present in your image appears as a 
vertical line in the histogram. A longer line indicates a higher amount of 
pixels in your image of that line’s luminance value. You can drag the handles 

0 Input 
Black 
Level
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White 
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2 Output 
Black 
Level
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White 
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4 Gamma
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in the graph to adjust the Input and Output levels for black and white, as 
well as the Gamma.

• Auto Black Click this to define the darkest pixels in your clip as black. 
The intermediate luminance values are proportionally redistributed. 

• Auto White Click this to define the lightest pixels in your clip as white. 
The intermediate luminance values are proportionally redistributed.

¦ Note If you want to restore the default luminance values at any time, click 
the Restore Default Values button.

0 Input 
Black 
Level

1 Input 
White 
Level

2 Output 
Black 
Level

3 Output 
White 
Level

4 Gamma
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Default Values 
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Creating a Matrox secondary color correction
Matrox secondary color correction offers all the properties found in Matrox 
primary color correction, with the added capability of limiting the color 
correction to a specific range of pixels using the selective key properties. For 
example, secondary color correction can be used to change the color of a dress, 
deepen the background sky color, or to achieve an effect where only one object or 
person remains in color while the rest of the image becomes black and white. For 
details on how to isolate a color and make the rest of the clip black and white, see 
“Creating a color pass effect” on page 76.

¥ Tip Adobe Premiere Pro includes a workspace setup that is optimized for 
working with clips and effects to facilitate color correction. To prepare your 
workspace for color correction, choose Window > Workspace > Color 
Correction.

°To set up a Matrox secondary color correction:

Click the triangle next to Matrox Color Correction (Secondary) or Matrox 
Color Correction (Secondary - Advanced) to expand the property list.

¦ Note The RGB Curves and Tonal Range settings are available only with the 
advanced versions of the Matrox primary and secondary color correction effects. 
Because the advanced versions of these effects require additional system 
resources, you should apply them only if you want to use the RGB Curves or 
Tonal Range settings.
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• Enable Split View Select this option to split your clip into two sections in 
the Program Monitor and on your video monitor. One section will display 
your clip as you adjust the color correction controls, and the other section of 
the clip will remain unchanged. For more information, see “Using Split 
View” on page 54.

• Proc Amps The processing amplifier (proc amp) controls allow you to 
adjust different aspects of your clip:

$ Hue Adjusts the tint of the colors in the image.

$ Saturation Adjusts the saturation (vividness) of the image’s colors.

$ Contrast Adjusts the difference in luminance between the lightest and 
darkest areas of the image.

$ Brightness Adjusts the level of black in the image.

• RGB Curves Lets you use curves to adjust the red, green, and blue color 
channels of your clip individually, or use a master curve to adjust all color 
channels simultaneously. For more information, see “Using RGB curves” on 
page 56.

• Color Balance These controls let you adjust the mixture of colors in your 
clip.

$ Tonal Range Allows you to fine-tune the tonal ranges of your clip by 
reducing the range of pixels included for shadows, midtones, or 
highlights. For more information, see “Adjusting tonal range” on page 58.

$ Graphical Allows you to see a graphical representation of your changes 
when you adjust the color balance settings. You can also adjust and 
modify most of the color balance settings directly within the graph. For 
more information, see “Using the color balance graph” on page 59.

$ Numerical Lets you adjust your color balance settings numerically by 
entering values in the text boxes, or by dragging the corresponding sliders. 
You can adjust the Hue, Saturation, and Luminance for each tonal 
range.

• Master (Hue, Saturation, and Luminance) Affects all areas of 
your clip from the lightest white to the darkest black.

• Shadows (Hue, Saturation, and Luminance) Affects the darkest 
areas of your clip.

• Midtones (Hue, Saturation, and Luminance) Affects the areas 
with tones between the darkest and lightest areas of your clip.

• Highlights (Hue, Saturation, and Luminance) Affects the lightest 
areas of your clip.

• Luma Mapping
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$ Graphical Allows you to see a graphical representation of your changes 
when you adjust the luma mapping settings. You can also modify the 
luminance of your clip directly within the graph. For more information, 
see “Using the luma mapping graph” on page 65.

$ Numerical Lets you adjust your luma mapping settings numerically by 
entering values in the text boxes, or by dragging the corresponding sliders. 

• Input Levels (Black and White)  These controls let you fine-tune 
your clip’s brightness and contrast by changing the luminance value 
that represents black, white, or gray. Doing so expands or compresses 
the range of luminance levels in your clip, which increases or decreases 
your clip’s tonal range.

For example, by increasing the black value, you set black in your clip 
to a higher luminance value, which compresses the luminance range 
and darkens your clip proportionally.

• Output Levels (Black and White) These controls let you map the 
values under Input Levels to any level of black and white. You can 
reduce contrast in your clip, or reverse the luminosity of your clip by 
setting black to a higher value than white.

• Gamma Use this to adjust the midtones in your clip without 
adjusting black or white.

• Mask  Allows you to apply a mask to your effect. For more information, 
see “Applying a mask to your Matrox effects” on page 50.

• Selective Key The selective key settings allow you to apply the color 
correction effect to a specific range of pixels in your clip. Performing a 
selective key is similar to performing a chroma or luma key, however, with a 
selective key you are applying color correction to the keyed area instead of 
transparency. For example, if you use the selective key properties to select 
red as your Hue color, the color correction will be applied to the red regions 
in your clip. You can enable each keyer (Hue, Saturation, and Luma) 
individually, or enable all three at the same time to get the desired results. 

$ Graphical Allows you to see a graphical representation of your changes 
when you adjust the selective key Numerical settings. You can also 
modify the settings directly within the graph and perform an auto key. For 
more information, see “Using the selective key graph” on page 72.

$ Numerical Lets you adjust your key settings numerically by entering 
values in the text boxes, or by dragging the corresponding sliders.

• Hue Key This type of key lets you select areas to be keyed (affected 
by the color correction) based on their hue.

$ Enable Select this to enable the Hue Key properties and hue key 
indicator in the selective key graph.
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$ Hue Use this to rotate the indicator around the perimeter of the color 
spectrum so that you can select different hues (colors) on which to key.

$ Aperture Use this to widen or narrow the aperture of the indicator 
to increase or decrease the range of colors on which you want to key.

$ Softness Sets the amount of softness applied to the range of colors 
specified in the aperture region.

• Saturation Key This lets you select colors to be keyed (affected by 
the color correction) based on their saturation value. Pale colors have a 
low saturation value, while vivid colors have a high saturation value.

$ Enable Select this to enable the Saturation Key properties and 
saturation key indicator in the selective key graph.

$ Low Clip Use this to select the lower saturation values to be keyed. 

$ Low Gain Use this to set the range of saturation values you want 
to be partially affected based on the value set by the Low Clip control. 
As you increase the Low Gain setting, more pixels are partially 
affected by the color correction. If you decrease the Low Gain control, 
less pixels are partially affected.

A Low Gain setting of 100 provides the widest range for maximum 
color correction. Alternately, a gain setting of 0 creates a key where 
saturation values are either completely affected or left untouched. You 
can think of the Low Gain control as defining an “Affected to 
Untouched” range for keying the pale colors in your image.

$ High Gain This control is similar to the Low Gain setting, except 
you use it to set the range of higher saturation values you want to be 
partially affected based on the value set by the High Clip control. As 
you increase the High Gain setting, less pixels are partially affected 
by the color correction. If you decrease the High Gain setting, more 
pixels are partially affected. You can think of the High Gain control 
as defining an “Untouched to Affected” range for keying the vivid 
colors of your image.

$ High Clip This control is similar to Low Gain, except you use it to 
select the higher saturation values to be keyed.

¦ Note The values you can select using the Low Clip and Low Gain 
controls are dependent on the High Clip and High Gain controls, and 
vice versa. This prevents the low and high controls from keying on 
the same values.

• Luma Key This type of key lets you select areas to be keyed (affected 
by the color correction) based on their luminance value.

$ Enable Select this to enable the Luma Key properties and luma key 
indicator in the selective key graph.
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$ Low Clip Use this to select the lower (darker) luminance values to 
be keyed. A Low Clip setting of 0 represents black, and a setting of 
255 represents white. Intermediate settings represent different shades 
of gray, from very dark to very light gray.

$ Low Gain Use this to set the range of luminance values you want 
to be partially affected based on the value set by the Low Clip control. 
As you increase the Low Gain setting, more luminance values 
become partially affected by the color correction.

A Low Gain setting of 100 provides the widest range for maximum 
color correction. Alternately, a gain setting of 0 creates a key where 
the luminance values are either completely affected or left untouched. 
You can think of the Low Gain control as defining an “Affected to 
Untouched” range for keying the dark areas of your image.

$ High Gain This control is similar to Low Gain, except you use it 
to set the range of luminance values you want to be partially affected 
based on the value set by the High Clip control. You can think of the 
High Gain control as defining an “Untouched to Affected” range for 
keying the lighter areas of your image.

$ High Clip This control is similar to Low Clip, except you use it to 
select the higher (brighter) luminance values to be keyed.

¦ Note The values you can select using the Low Clip and Low Gain 
controls are dependent on the High Clip and High Gain controls, and 
vice versa. This prevents the low and high controls from keying on 
the same luminance values.

• Invert Key Select this to invert the key selection, giving you the 
opposite result of what you originally selected. 

• Show Key as Output Select this to display the matte used to define 
your selective key region. This enables you to further refine your key. 
Areas that are completely affected by the color correction are white, 
untouched areas are black, and gray areas are partially affected.

• Expand Outside Mask Applies the color correction settings outside 
the mask area. This setting is especially useful when setting up a color 
pass effect where you have several objects of the same color but want to 
retain the color for only one object. For more information, see 
“Creating a color pass effect” on page 76.
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Using the selective key graph
The selective key graph allows you to modify your selective key settings (Hue 
Key, Saturation Key, and Luma Key) directly in the graph. You can also 
perform an auto key.

• Map This is the default view when you first expand the graphical property. 
You can drag the handles to move the indicator to different regions in the 
graph to adjust the Hue Key, Saturation Key, and Luma Key settings.

In order to see the indicator and handles, you have to enable the key setting you 
want to use. For example, if you want to adjust the Hue Key properties, you need 
to click the Hue button in the selective key graph or select the Enable option in 
the Hue Key numerical properties. In the following graph, the Hue properties 
have been enabled. 

• Plot Click this button to plot the colors and luminance values that are 
present in the current frame of your clip. You can drag the handles to move 
the indicator to different regions in the graph to adjust the Hue Key, 
Saturation Key, and Luma Key properties. The luma plot histogram shows 
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each luminance value present in your image as a vertical line. A longer line 
indicates a higher amount of pixels in your image of that line’s luminance 
value. 

• Hue Click this button to enable or disable the Hue Key properties (Hue, 
Aperture and Softness). When enabled you will be able to see the Hue 
Key indicator and handles to modify the Hue Key properties in the selective 
key graph.

• Sat Click this button to enable or disable the Saturation Key properties 
(Low Clip, Low Gain, High Gain, and High Clip). When enabled you will 
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be able to see the Sat Key indicator and handles to modify the Saturation 
Key properties in the selective key graph.

• Lum Click this button to enable or disable the Luma Key properties (Low 
Clip, Low Gain, High Gain, and High Clip). When enabled you will be 
able to see the Lum Key indicator and handles to modify the Luma Key 
properties in the selective key graph.

• For both the Saturation Key and Luma Key properties, you can lock and 
move all the handles at the same time in the selective key graph by pressing 
SHIFT and then dragging any handle. If you press CTRL you can lock and 
move either the Low Clip and Low Gain handles or High Gain and High 
Clip handles. 
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¦ Note If you want to reset the hue, saturation, and luma key properties to the 
default settings at any time, click the appropriate Reset button.

• Show Key Click this button to display the matte used to define your 
selective key region. This enables you to further refine your key. Areas that 
are completely affected by the color correction are white, untouched areas 
are black, and gray areas are partially affected.

• Auto Key Click this button to automatically key on the most common 
color at the current frame (except gray). Selecting Auto Key affects values 
for the Hue Key, Saturation Key, and the Luma key properties. 
Alternately, you can use the auto key eyedropper to select a color on which 
you want to key. 

• The auto key eyedropper can be used in two ways:

$ Click the eyedropper button and click on a color on which you want to 
key.

$ Click the eyedropper button and click and drag anywhere on your clip to 
create a rectangular area containing the color on which you want to key. 
The selected color will be an average of the pixel information contained 
within the rectangle.

You can further refine your auto key color by using the plus and minus eye-
droppers. 

For example, if you selected light red as your auto key color and would like a 
dark red color in your clip to be included in the auto key, you can use the 
plus eyedropper to select that dark red in your clip. To remove colors from 
your auto key, use the minus eyedropper. 

¦ Note The Show Key mode and any color correction applied will be 
temporarily deactivated in the Program Monitor when using an eyedropper. 

Saturation Key 
Reset button

Auto key 
eyedropper

Plus and minus 
eyedroppers
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This allows you to see the original colors of your clip before any modifications 
were made.

• Indicator Click this button to turn the indicator lines on or off.

• Handles Click this button to turn the handles for the indicator lines on or 
off.

Creating a color pass effect
You can use the Matrox secondary color correction to create a color pass effect to 
convert your clip to black and white, with the exception of one specified color. 
This can be useful if you want to isolate a single color to make it prominent. 

In the following example, the pink color of the girl’s shirt has been retained, 
while the rest of the clip has been converted to black and white:

°To perform a color pass effect:

1 Click the Auto Key eyedropper in the selective key graph and click and drag 
anywhere on your clip to create a rectangular area containing the color you 
want to isolate.

2 Under Proc Amps, set the Saturation to 0.

3 Select Invert Key.

If you have more than one object of the same color but you want to isolate only 
one of those objects, you can apply a mask and use the Expand Outside Mask 
option to isolate the area that contains the color you want to remain intact. For 
example, if you have a clip that has two roses that are the same red and you 
would like only one of them to remain red, you can do the following.

°To perform a color pass effect using the Expand Outside Mask option:

1 Click the auto key eyedropper in the selective key graph and click and drag 
anywhere on your clip to create a rectangular area containing the color you 
want to isolate.

2 Under Proc Amps set the Saturation to 0.

3 Select Invert Key.

Pink shirt is isolated, 
while the rest of clip is 
grayscale.
pter 4, Setting Up Realtime Effects with Adobe Premiere Pro



77
4 Apply a mask surrounding the colored object you want to remain intact (see 
the next section, “Applying a mask to your Matrox effects).

5 Select Expand Outside Mask.

Overview of the Matrox chroma key effects
You can apply a Matrox chroma key or chroma key shadow effect to make certain 
areas of a foreground image transparent based on a color in that image, so that an 
underlying image can show through.

In the following example of a chroma key effect, our foreground image is a video 
clip of a woman sitting in front of a green backdrop, and our underlying image is 
a video clip of a sand dune:

By chroma keying on the particular shade of green in the backdrop of the 
foreground image, the backdrop area becomes transparent and the corresponding 
area of the underlying image shows through in the composite image as follows:

¡ Important The chroma key shadow effect includes controls for fine-tuning 
shadows in your effect. It is best to use the chroma key shadow effect when you 
are performing a chroma key without any additional effects. If you want to apply 

Foreground image Underlying image

+

Result of chroma key

=
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additional effects to your chroma key, you will get more desirable results by 
using the chroma key effect without shadow controls. For example, if you want to 
apply an Adobe Motion effect to your chroma key, you should use the chroma 
key effect and not the chroma key shadow effect.

Creating a chroma key or chroma key shadow 
effect

To set up a Matrox chroma key or chroma key shadow effect, click the triangle 
next to Matrox Chroma Key/Matrox Chroma Key Shadow to expand the 
property list: 

• Graphical Provides a graphical representation of the chroma key controls 
that you can use to select your key colors, and also lets you perform an auto 
key. 

$ Map Lets you select your key colors within a circular graph that 
contains a color spectrum.

$ Plot Displays a plot of the colors present in your clip so that you can 
select the particular colors on which you want to key.
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$ Show Key Click this button to display the matte used to create your key 
effect. This enables you to further refine your key. For example, when you 
display the matte, your key color (such as green) appears as black, and 
opaque areas appear as white. If you notice some white spots that you 
want to key, you can adjust the key controls until the undesired white 
spots disappear.

$ Auto Key Click this button to automatically key on the most common 
color at the current frame in your clip (except gray).

For details on selecting key colors within the graph or performing an auto 
key, see “Using the chroma key graph to modify key colors and perform an 
auto key” on page 81.

¦ Note You must expand the Graphical property in order to see the indicator 
when adjusting the chroma key controls.

• Hue Use this to rotate the indicator around the perimeter of the color 
spectrum so that you can select different hues (colors) on which to key.

• Aperture Use this to widen or narrow the aperture of the indicator to 
increase or decrease the range of colors on which you want to key.

• Saturation Use this to select colors that have a particular saturation value. 
Pale colors have a low saturation value and are located at or near the center 
of the spectrum. Vivid colors have a high saturation value and are located at 
or near the perimeter of the spectrum. Because pale colors have low 
saturation, you’ll find them more difficult to key on than the vivid colors.

• Saturation Threshold Use this to proportionally increase or decrease the 
region outside of your saturation range. This controls how closely the 
Saturation value must match the key color before a region becomes 
transparent.

For example, after applying a chroma key effect to a foreground image that 
includes dark areas or shadows that you want to preserve in your effect, you 
may find that these areas have become semi-transparent. By adjusting the 
Saturation Threshold, you can eliminate the key color from these dark 
areas, so that they’ll become completely opaque.

• Softness Use this to soften the edges of your key by blending parts of 
your foreground image with your underlying image. This makes certain 
areas of your foreground image partially transparent instead of completely 
transparent or opaque.

• Spill Removal Use this to remove the contamination (spill) that your key 
color may leave on or around the edges of your foreground image. Spill is 
usually caused by light reflecting from your solid color backdrop (key color) 
onto your foreground image. Spill Removal replaces your key color from 
the “spill areas” with the opposite color in the spectrum, which returns a 
more natural look to these areas.
Creating a chroma key or chroma key shadow effect
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• Chroma Suppression Use this to remove any tint that your key color 
imposes on your foreground image. For example, if your solid color 
backdrop (key color) is green and you are using a person in your foreground 
image, the person’s skin may have a green tint. You can adjust the Chroma 
Suppression to replace the green tint with the opposite color in the 
spectrum to return the person’s skin to a more natural-looking color.

¦ Note The following properties (Luminance and Shadow Suppression) 
are only available in the chroma key shadow effect.

• Luminance Use this to adjust the luminance of your shadow. Negative 
values increase the brightness of the shadow, while positive values decrease 
the brightness.

• Shadow Suppression Use this to make shadows in your clips less 
apparent. A higher value indicates less shadow.

• Mask Allows you to apply a mask to your effect. For more information, 
see “Applying a mask to your Matrox effects” on page 50.

• Transparent Outside Mask Select this option to apply transparency 
outside the mask area. This allows you to define a mask area where you want 
the keying to be performed, and show only your underlying image outside 
the mask. For more information, see “Applying a mask to your Matrox 
effects” on page 50.

• Invert Key Select this to invert the key selection, giving you the opposite 
result of what you originally selected.

• Show Key as Output Select this to display the matte used to create your 
key effect. This enables you to further refine your key. For example, when 
you display the matte, your key color (such as green) appears as black, and 
opaque areas appear as white. If you notice some white spots that you want 
to key, you can adjust the key controls until the undesired white spots 
disappear.
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Using the chroma key graph to modify key 
colors and perform an auto key
To modify your key colors directly within the chroma key graph or perform an 
auto key, click the triangle next to the Graphical property to expand it:

• Map This is the default view when you first expand the Graphical 
property. You can drag the handles in the color spectrum to move the 
indicator to different regions in the cube to adjust the Hue, Aperture, 
Saturation, and Saturation Threshold. 

¦ Note This graph will contain a luminance spectrum only if you are creating a 
chroma key shadow effect. You can drag the handle in the luminance spectrum to 
adjust the Luminance.

• Plot Click this button to plot the colors and luminance values that are 
present in the current frame of your clip. You can drag the handles in the 
chroma plot graph to move the indicator to different regions in the graph to 
adjust the Hue, Aperture, Saturation, and Saturation Threshold. The 
luma plot histogram shows each luminance value present in your image as a 
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vertical line. A longer line indicates a higher amount of pixels in your image 
of that line’s luminance value. 

¦ Note The Plot graph will contain a luma plot histogram only if you are 
creating a chroma key shadow effect. You can drag the handle in the luma plot 
histogram to adjust the Luminance.

• Show Key Click this button to display the matte used to create your key 
effect. This enables you to further refine your key. For example, when you 
display the matte, your key color (such as green) appears as black, and 
opaque areas appear as white. If you notice some white spots that you want 
to key, you can adjust the key controls until the undesired white spots 
disappear.

• Auto Key Click this button to automatically key on the most common 
color at the current frame (except gray). Selecting Auto Key affects values 
for Hue, Aperture, Saturation, and Saturation Threshold. If your clip 
consists of a uniform key color that is evenly lighted, Auto Key will usually 
give you a good-quality chroma key. Alternately, you can use the eyedropper 
to select a color on which you want to key. 

You can use the eyedropper in two ways:

$ Click the eyedropper button and click on a color on which you want to 
key.

3

3
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$ Click the eyedropper button and click and drag anywhere on your clip to 
select a rectangular area containing colors on which you want to key.

¦ Note The Show Key mode and any chroma key applied will be temporarily 
deactivated in the Program Monitor when using the auto key eyedropper. This 
allows you to see the original colors of your clip before any modifications 
were made.

• Indicator Click this button to turn the indicator on or off.

• Handles Click this button to turn the handles for the indicator on or off.
Creating a chroma key or chroma key shadow effect
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Overview of the Matrox luma key effect
You can apply a Matrox luma key to make certain areas of a foreground image 
transparent based on the luminance in that image, so that an underlying image 
can show through.

In the following example of a luma key effect, two video clips are combined to 
produce the effect of two cowboys riding through fire. Our foreground image is a 
video clip of a ring of fire against a black background, and our underlying image 
is a video clip of two men riding horses:

By luma keying on the particular luminance (brightness) of the black areas in the 
foreground clip, these areas become transparent and the corresponding areas of 
the underlying image show through in the composite image as follows:

Foreground image Underlying image

+

Result of luma key

=
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Creating a luma key effect
To set up a Matrox luma key effect, click the triangle next to Matrox Luma Key 
to expand the property list:

• Graphical Allows you to see a graphical representation of your changes 
when you adjust the property settings. You can adjust the luma key 
properties directly in the graph to select the luminance values on which you 
want to key. For more information, see “Using the luma key graph” on 
page 86.

• Transparency Use this control to set the transparency level of your key 
effect. Higher values indicate higher transparency. For example, a 
Transparency value of 100 makes the keyed area in your foreground image 
completely transparent, leaving the underlying image visible.

• Low Clip Use this to select the lower (darker) luminance values to be 
keyed. A Low Clip setting of 0 represents black, and a setting of 255 
represents white. Intermediate settings represent different shades of gray, 
from very dark to very light gray.

• Low Gain Use this to set the range of luminance values you want to be 
partially transparent based on the value set by the Low Clip control. As you 
increase the Low Gain setting, more luminance values become partially 
transparent to give you a softer-edged key.

A Low Gain setting of 100 provides the widest range for maximum 
softness. Alternately, a gain setting of 0 creates a hard key where the 
luminance values are either completely transparent or opaque. You can think 
Creating a luma key effect
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of the Low Gain control as defining a “Transparent to Opaque” range for 
keying the dark areas of your foreground image.

• High Clip This control is similar to Low Clip, except you use it to select 
the higher (brighter) luminance values to be keyed.

• High Gain This control is similar to Low Gain, except you use it to set the 
range of luminance values you want to be partially transparent based on the 
value set by the High Clip control. You can think of the High Gain control 
as defining an “Opaque to Transparent” range for keying the lighter areas of 
your foreground image.

The values you can select using the Low Clip and Low Gain controls are 
dependent on the High Clip and High Gain controls, and vice versa. This 
prevents the low and high controls from keying on the same luminance 
values.

• Mask  Allows you to apply a mask to your effect. For more information, 
see “Applying a mask to your Matrox effects” on page 50.

• Transparent Outside Mask Select this option to apply transparency 
outside the mask area. This allows you to define a mask area where you want 
the keying to be performed, and show only your underlying image outside 
the mask. For more information, see “Applying a mask to your Matrox 
effects” on page 50.

• Invert Key Select this to invert the key selection, giving you the opposite 
result of what you originally selected

• Show Key as Output Select this to display the matte used to create your 
key effect. This enables you to further refine your key settings. For example, 
when you display the matte, areas of your clip that are completely 
transparent appear as black, and opaque areas appear as white. If you notice 
some white spots that you want to key, you can adjust the key controls until 
the undesired white spots disappear.

Using the luma key graph
The luma key graph contains a luminance spectrum and a luminance eyedropper. 
You can drag the handles in the luminance spectrum to adjust the Transparency, 
Low Clip, High Clip, Low Gain, and High Gain properties.

Eyedropper 
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You can select luminance values on which to key by adjusting the Low Clip and 
High Clip handles, or you can use the luminance eyedropper to automatically 
pick the luminance value you want to key on. The eyedropper can be used in two 
ways:

• Click the eyedropper button and click on the color with the desired 
luminance value in your clip.

• Click the eyedropper button and click and drag anywhere on your clip to 
create a rectangular area containing the luminance values you want to select. 
The selected luminance will be an average of the luminance values contained 
within the rectangle.

¦ Note Any luma key displayed in the Program Monitor will be temporarily 
deactivated when using the luminance eyedropper. This allows you to see the 
colors of your clip before any modifications were made.

You can also adjust the softness of your key with the Low Gain, High Gain, and 
Transparency handles. All these adjustments affect the shape and size of the 
luminance selector as follows:

• Plot Click this button to see the luminance spectrum with a plot that shows 
each luminance value present in your image as a vertical line in the 
histogram. A longer line indicates a higher amount of pixels in your image of 
that line’s luminance value. You can drag the handles in the luma plot 
spectrum to adjust the Transparency, Low Clip, High Clip, Low Gain, and 
High Gain properties. Any adjustments made affect the shape and size of the 
luminance selector in the Luma Plot.

HIGH GAINLOW GAIN

TRANS
LOW CLIP HIGH CLIP
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Creating a wipe transition
The Matrox wipe transitions support standard dissolves, SMPTE wipes, and 
organic wipes with soft edges and color borders.

°To set up a Matrox wipe transition: 

Click the transition’s icon in your sequence, then click the Custom button in the 
Effect Controls panel. This opens the Customize Matrox Wipes dialog box:

1 Under Wipe Pattern, click the Select Pattern button and choose a pattern 
for your wipe.

2 If you would like to add a border to your wipe, select Enable under Border. 

$ Width Lets you adjust the width of your border by dragging the slider 
or entering a percentage in the text box.

$ Color Click this button to select a color for your border.
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$ Balance Lets you adjust the prominence of the border between image A 
and image B. For example, positive values make the border more 
prominent in image B, while negative values make the border more 
prominent in image A.

$ Reset Click this button to restore the default Border values.

3 Use the controls under Softness to create a soft edge on the border of your 
wipe. 

$ Nonlinear softness This option is selected by default. You may find it 
useful to clear this option when using certain wipe patterns. For example, 
nonlinear softness often provides better results when creating SMPTE 
wipes, while linear softness is usually preferable when creating organic 
wipes. 

$ Amount Lets you adjust the amount of softness by dragging the slider 
or entering a percentage in the text box. The higher the value, the less 
sharp the edge of your border or wipe will become. 

$ Reset Click this button at any time to restore the default Softness 
values.

4 Use the controls under Preview to preview your wipe transition:

$ Drag the slider beside the Play button to scrub through your transition.

$ Click the Play button or press the SPACEBAR to play back your transition. 
Select Loop if you’d like the wipe to play back continuously until you 
click Stop. 

You can adjust the wipe settings as your transition is playing to immediately 
see the result of your changes.

5 Use the controls under Presets to save and load your wipe transition 
settings. You can also create default settings for your wipe transitions.

$ Save Allows you to save your organic wipe settings to a file for future 
use. When you click the Save button, the Save As dialog box opens and 
allows you to name your effect and save it as a Matrox wipe transition 
(.mwt) file.

$ Load Click this button to load a previously created .mwt file.

$ Set as Default Sets your current wipe settings as the default settings 
for Matrox wipe transitions.

$ Restore Default Click this button to restore the default settings you 
specified using the Set as Default button.

For more information about setting up transitions, see your Adobe Premiere Pro 
documentation.
Creating a wipe transition
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Using the Matrox chroma clamper effect
You can use the Matrox chroma clamper effect to ensure that when you’ve 
applied effects that perform color space conversion on part of a clip, the clip’s 
colors remain constant throughout. Some Adobe Premiere Pro native effects 
perform color space conversions (YUV to RGB) that will clip RGB values to the 
acceptable range of 0-255 per color component. The clipping, however, is usually 
only required on clips that have very bright or highly saturated colors.

For example, if you split a clip that contains very bright or highly saturated colors 
and apply an Adobe basic 3D effect to one portion of the clip, you may notice 
minor color differences between the two halves on your video monitor. Applying 
the Matrox chroma clamper effect to the portion of the clip that does not have the 
Adobe effect ensures that colors remain constant throughout the clip.

Selecting your speed control method
You can choose the type of speed control that’s best suited for individual clips in 
your Premiere Pro projects. You can apply the Frame Blend option to a clip, 
which interpolates between the video fields or frames, and typically works well 
on standard or slow-paced video and camera pans. For fast action video you may 
get better results by clearing this option.

To change the speed control method for a clip in the Timeline panel, right-click 
the clip and select Frame Blend to use the speed control method that’s 
recommended for standard or slow-paced video and camera pans, or clear this 
option for fast-action video.
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This chapter explains how to 
use Matrox A/V Tools to 
capture clips, grab 
single-frame images, and play 
back clips in a clip list.
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About Matrox A/V Tools
Matrox A/V Tools is an application that allows you to capture and play back 
clips. With A/V Tools, you can:

• Capture analog video from your camera or VTR into .avi files on your 
computer.

• Use onscreen transport controls to navigate quickly and easily through clips 
on disk.

• Grab single-frame images and save them as .tga files, such as to create photo 
montages. 

• Change the order of clips in your clip list by simply dragging and dropping 
clips into the sequence you want.

Starting Matrox A/V Tools
1 Choose Start > Programs > Matrox Mtx.utils > Matrox AV Tools.

2 The Options dialog box pops up every time A/V Tools starts. For 
information about the settings in the Options dialog box, see “Defining your 
A/V Tools options” on page 96. To close the Options dialog box and start 
working with A/V Tools, click OK.
pter 5, Using Matrox A/V Tools
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Using the Matrox A/V Tools interface
Once you’ve specified your A/V Tools options, a dialog box similar to the 
following appears:

Here’s a brief description of the A/V Tools dialog box: 

0 New tab Use this tab to capture new clips to add to your clip list. See 
“Capturing clips” on page 105.

1 Edit tab Use this tab to edit clips, and update clip information. For details, 
see “Editing clips” on page 106.

2 Preview Window Allows you to preview video from your camera, VTR, 
or clips on disk. The preview is also displayed on your video monitor. 

3 CAM and Disk buttons These buttons let you switch between the 
following modes: 

2

3

4

5

6

7

8

0 1
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$ CAM mode lets you capture live video from your camera, or video on 
tape.

$ Disk mode lets you play back captured clips in your clip list.

4 Clip identification area This section contains several items to help you 
identify your clips. 

$ Tape ID Displays the name that you’ve assigned to the tape in your 
VTR. 

$ Clip ID Displays the base name for your new clips when using the New 
tab, or the name of the currently selected clip when using the Edit tab. For 
details, see “How A/V Tools assigns clip names” on page 105.

$ Comment Lets you enter comments that help you distinguish between 
clips in your clip list.

5 Transport controls A set of common transport controls that lets you 
easily navigate through clips on disk. For more information, see “Navigating 
through clips with the transport controls” on page 94.

6 Clip list A numbered list of clips and their properties. As you capture clips 
in A/V Tools, your clips are automatically added to the clip list. The clip list 
can be docked to the Matrox A/V Tools dialog box or float freely as a 
resizable window. For more information on using the clip list, see “Working 
with the clip list” on page 107.

7 Status bar Displays information about the operation you’re currently 
performing in A/V Tools, such as clip information and if frames are dropped 
during a capture.

8 Float/dock clip list button This button lets you dock the clip list to the 
Matrox A/V Tools dialog box, or detach the clip list so that you can move 
and resize it. For more information, see “Detaching and resizing the clip list” 
on page 109.

Using the A/V Tools pop-up menu
When you right-click anywhere in the clip list, a pop-up menu appears containing 
commands for working with A/V Tools. All commands present in the A/V Tools 
pop-up menu are described in this chapter. 

Navigating through clips with the transport 
controls
A/V Tools includes a common set of transport controls for navigating through 
clips on your hard drive when working in Disk mode. 

¦ Note The transport controls are disabled in CAM mode.
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The transport controls are much like those on your VTR:

Most of these controls perform standard transport functions, but some can be 
used for special tasks:

• Scrub Drag the slider on the Positioner to scrub through any clip in your 
clip list. Audio will be silent when you scrub a clip.

• Cue to In or Out point on disk Click the Rewind or Fast Forward 
button to cue to the beginning or end of a clip on disk. 

• View frame-by-frame Click the Frame Reverse or Frame Advance 
button.

• Play a clip on disk repeatedly Click the Loop button, then click the 
Play button.

Keyboard Shortcuts

Disk mode K

Play B

 Rewind Z

Fast Forward X

Frame Advance ’ (apostrophe)

Frame Reverse ; (semicolon)

Stop V

Loop A

Loop 
button

Positioner
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Changing the time code display
A value in a time code field can be displayed as a time code or a specific number 
of frames. The first time you run A/V Tools, the fields display time codes. To 
toggle between the two formats, press CTRL+SHIFT while the insertion point 
(flashing vertical bar) is in any time code field. 

For example, when working with NTSC clips, you could change a value of 24:04 
(24 seconds, 4 frames) to 724 frames by pressing CTRL+SHIFT, and then switch 
back to time codes again by pressing CTRL+SHIFT.

The time code format of your tape is indicated by the separator between the 
seconds and frames digits in the time code fields as follows: 

• A colon ( : ) indicates non-drop frame.

• A semicolon ( ; ) indicates drop frame.

Defining your A/V Tools options
Before capturing or playing back clips with A/V Tools, you need to specify 
various options, such as your editing video format and your capture and playback 
settings. 

°To define your options for A/V Tools:

1 Click the Options button. 

¦ Note The Options dialog box automatically pops up every time A/V Tools 
starts.

2 Under Capture Folder, specify the folder where you want to store your 
captured clips. For more information, see “Selecting your capture folder” on 
page 98. 
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3 Under Editing Video Format, select the video format and aspect ratio you 
want for your clips. For example, select NTSC and 4:3 if you want to capture 
and play back NTSC clips with a standard 4:3 aspect ratio.

Remarks
$ When you select an editing video format, many of the playback and 

capture settings are predetermined for you. All clips are captured to your 
selected video format, and clips added to the clip list must have the same 
frame size and frame rate. You can mix interlaced and progressive clips 
that have the same frame size and frame rate in a clip list.

$ Once your editing video format has been defined, it cannot be changed. 
You can run multiple instances of A/V Tools if you want to capture or 
play back clips with a different video format.

$ Your editing video format will automatically change if you load a .dvl file 
with a different format. For more information see, “Saving and loading a 
clip list” on page 107.

4 Under Display Time Code As, select the format that you want for 
displaying time codes in A/V Tools (applicable only if you’re using a video 
format that has a frame rate of 29.97 or 59.94). The format used is indicated 
by the separator between the seconds and frames digits in the time code 
fields as follows:

$ A colon ( : ) indicates non-drop frame.

$ A semicolon ( ; ) indicates drop frame.

5 Click the Playback Settings button to specify your playback settings (see 
“Defining your playback settings” on page 98).

6 Click the Capture Settings button to specify your capture settings (see 
“Defining your capture settings” on page 100). If capture is not supported for 
your selected editing video format, a message will be displayed to indicate 
that it is not supported.

7 Click OK to save your settings.
Defining your A/V Tools options
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Selecting your capture folder
You can select the folder where you want A/V Tools to store your captured clips 
by typing the drive and folder name directly into the Capture Folder box, or by 
using the Browse button.

To ensure the best capture and playback performance of your clips, save them on 
one of your A/V drives. 

A/V Tools will save your video and audio clips in a subfolder with the same 
name as the Tape ID. For example, if you selected D:\Matrox AV Tools Capture 
as your capture folder, all video and audio clips from tape “MyTape” will be 
saved in D:\Matrox AV Tools Capture\MyTape. 

Defining your playback settings
The Matrox Playback Settings dialog box has several pages that you can use to 
specify various settings for working with A/V Tools. When you select your 
editing video format in the Options dialog box, many settings are optimized for 
you.

Specifying your general settings
To specify your general settings for playback in A/V Tools:

1 Click the Options button in the Matrox A/V Tools dialog box.

2 Click the Playback Settings button. This displays the Matrox Playback 
Settings dialog box.

¦ Note You can also access the Matrox Playback Settings dialog box by 
right-clicking the clip list and selecting Playback Settings.

3 Click the General tab.

4 Under Scrubbing Mode, select Frame, 1st Field, or 2nd Field to indicate 
whether you want to display frames or only one field when you scrub your 
clips in the clip list using the transport controls. For example, you may want 
to scrub the first or second field to eliminate the flickering that can be seen in 
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your picture when you pause while scrubbing interlaced video. Scrubbing 
fields can also be used to check for any dropped fields that may have 
occurred in your video during a telecine process.

¦ Note When using a progressive editing video format, the scrubbing mode 
is set to Frame.

5 Under Video Luma Level, select the type of processing that you want to be 
applied to video luminance levels when playing back clips in the clip list:

$ Broadcast Processes video using the standard legal range of luminance 
levels for broadcast video. Any super black or super white luminance 
levels (that is, levels that fall below the standard black level or exceed the 
standard white level) are clipped.

$ Post Production Processes video for post production. Any super black 
or super white luminance levels in your video are retained.

6 Under A/V Sync Adjustment, drag the slider to adjust the A/V 
synchronization of clips played back in the clip list. If your audio starts later 
than the associated video, increase the A/V sync value. Alternately, if your 
audio starts before the associated video, decrease the A/V sync value. Be 
aware that if you decrease the value too much, you may experience audio 
crackling.

¦ Note To return the slider to it’s default setting, click its D button. This button 
is available for all sliders in the Matrox dialog boxes.

7 Click OK to save your settings. 
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Specifying your video output settings
You can specify various settings to configure the video output from Matrox 
RT.X2. Some of the settings are predetermined for you based on your editing 
video format.

°To specify your video output settings:

1 Click the Options button in the Matrox A/V Tools dialog box.

2 Click the Playback Settings button. This displays the Playback Settings 
dialog box. 

3 Click the Video Output tab. The video output settings are the same as those 
provided when using Adobe Premiere Pro as explained in “Specifying your 
video output settings” on page 16.

4 Click OK to save your settings.

Defining your capture settings
The Matrox Capture Settings dialog box has pages that you can use to specify 
your settings for capturing video and audio in A/V Tools. The settings available 
are based on your editing video format and your input source.

¦ Note When you specify your capture settings in A/V Tools, VU meters can be 
displayed to let you monitor your audio input levels.

Specifying your video capture settings
You can capture video to various formats, depending on your selected editing 
video format and source video format. For example, you can choose to capture 
NTSC clips to Matrox MPEG-2 I-frame .avi files.

°To specify your settings for capturing video in A/V Tools:

1 Click the Options button in the Matrox A/V Tools dialog box.

2 Click the Capture Settings button. This displays the Matrox Capture 
Settings dialog box. 

¦ Note You can also access the Matrox Capture Settings dialog box by 
right-clicking the clip list and selecting Capture Settings. 
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3 Click the Video Capture Settings tab.

4 From the Input Source list, select the type of input you want to capture 
(Component, Composite, or S-Video). This will be set to Component 
when capturing HD video (not supported on RT.X2 SD).

¦ Note If Matrox RT.X2 can’t detect your source device when you start a 
capture, you’ll receive an error message. Either black video will be captured 
or the capture won’t be able to start until a valid input signal is present. In 
either case, you must make sure that your source device is switched on and 
properly connected to your system to properly capture the video.

5 From the Input Format list, select the video format that matches your 
source video. Depending on your editing video format, you may not be able 
to change the input format. If needed, Matrox RT.X2 will apply an 
appropriate pulldown method to convert the incoming video to your editing 
video format. For example, if your editing video format is 1080p @ 
23.98 fps and you set the Input Format to 1080i@29.97fps, a standard 
reverse pulldown (2:3 cadence) will be applied to capture the video to 1080p 
@ 23.98 fps. 

6 From the Input Aspect Ratio list, select the aspect ratio of your SD source 
video (4:3 or 16:9). For example, to capture video that was recorded using 
the standard TV screen format, select 4:3. To capture video that was 
recorded using the widescreen 16:9 format, select 16:9. If you’re capturing 
HD video, the Input Aspect Ratio will be set to 16:9.

7 Under Capture Format, select your desired capture format from the list. 
The formats available in the list depend on your editing video format.

$ Matrox DV/DVCAM Captures video to DV or DVCAM format. 

$ Matrox DVCPRO Captures video to DVCPRO format. 
Defining your A/V Tools options



102

Cha
$ Matrox MPEG-2 I-frame Captures video to MPEG-2 intra-frame 
format using the 4:2:2 Profile @ Main Level at a selected data rate (SD 
resolution only). For the best results when capturing video clips on which 
you’ll be applying chroma key effects, you should use this codec instead 
of a DV codec.

$ Matrox MPEG-2 I-frame  HD Captures video to MPEG-2 intra-frame 
format using the 4:2:2 Profile @ High Level at a selected data rate (HD 
resolution only). This is the only capture format available when using a 
1440×1080i or 1080i editing format.

8 If you’re capturing to a Matrox MPEG-2 I-frame format, click the 
Configure button to configure your settings. The MPEG-2 I-frame settings 
for capture in Matrox A/V Tools are the same as when you capture using 
Adobe Premiere Pro. For more details, see “Selecting your MPEG-2 I-frame 
settings” on page 29.

9 Select Use Automatic Gain Control (AGC) if you want the gain of your 
composite or S-Video input signal to be adjusted automatically to 
compensate for very bright or dark images. This improves the brightness or 
contrast of your picture.

10 From the Input Type list, select the type of equipment you’re using for 
capture:

$ Broadcast-quality Source Select this if your source device is 
broadcast-quality. This setting provides the best capture results for most 
devices.

$ Consumer-quality Source Select this if you’re having problems 
capturing video because your source device doesn’t meet 
broadcast-quality standards. For example, the capture may be interrupted 
when you try to capture from certain composite and S-Video devices, 
especially from low-quality VCRs. If this happens, selecting 
Consumer-quality Source will allow the video to be captured, but you 
may experience dropped frames during the capture.

¦ Note For any change to the input type to take effect, you must restart Matrox 
A/V Tools.

11 Click OK to save your settings.
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Specifying your audio capture settings
You can specify various audio capture settings, such as to specify the type of 
audio files (either stereo .wav or mono .wav) that you want to create when 
capturing audio in A/V Tools. 

Remarks
• When you capture to an .avi file using A/V Tools, the clip’s video and audio 

are saved to the .avi file, and the clip’s audio is also saved to one or more 
separate .wav files. You could choose to edit the separate .wav files using 
audio post-processing software, such as Adobe Soundbooth.

• The separate .wav files are not supported in the A/V Tools clip list, but you 
can import them into Adobe Premiere Pro.

°To specify your settings for capturing audio in A/V Tools: 

1 Click the Options button in the Matrox A/V Tools dialog box.

2 Click the Capture Settings button. This displays the Matrox Capture 
Settings dialog box.

3 Click the Audio Capture Settings tab.

4 Under Input Source, select the audio input source you want to capture. 
Your audio source must match the audio input where you connected the 
cable labeled TO AUDIO CARD IN from your RT.X2 breakout box as 
explained in your Matrox RT.X2 Installation Manual. For example, if you 
plugged the TO AUDIO CARD IN connector into the Line-In jack (or 
corresponding jack) on your sound card, select Line-In from the Input 
Source list.

Remarks
$ If all available audio inputs don’t appear in the Input Source list, select 

List all audio inputs. If your audio input connection does not appear in 
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the list, you must unplug the TO AUDIO CARD IN connector and 
connect it to an audio input on your sound card that appears in the list.

$ If your analog audio source appears with an * beside it in the list, your 
sound card does not have matching audio inputs and outputs. In this case, 
choose the audio source with an * that matches your audio input, make 
sure that your source is playing back audio, and click Advanced 
Settings. In the provided dialog box, select an analog audio passthrough. 
If you can hear audio, then you’ve selected the correct analog audio 
source and passthrough. If you can’t hear audio, try selecting a different 
analog audio source and/or passthrough.

$ The Capture Format (bit-depth) for your captured audio files is set to 
16-bit.

5 If you want the VU meters to be displayed each time you configure your 
capture settings or start a capture in A/V Tools, select Show VU meters. 
The VU meters are the same as displayed when you capture audio using 
Adobe Premiere Pro (see “Monitoring audio levels for capture” on page 27).

6 Under Capture Files, indicate whether you want to capture to stereo or 
mono audio files, and select which channels you want to save to separate 
.wav files.

$ From the File Type list, select Stereo to save your captured audio to 
stereo .wav files, or Mono to save your captured audio to mono .wav files. 

$ From the Filename lists, select which stereo pairs or mono channels you 
want to save to your .wav files. Select None if you don’t want a particular 
.wav file to be created.When A/V Tools saves each .wav file, it assigns a 
.Stereo.wav or .Mono.wav suffix to the base name you gave for the 
associated video file. For example, if you’ve named your video file 
MyFile.avi, the associated stereo audio files would be named 
MyFile.Stereo1.wav, MyFile.Stereo2.wav, etc. 

¦ Note The channels that you choose to save to the first stereo.wav file or first 
two mono.wav files will be embedded in the associated .avi file.

7 Click OK to save your settings. 
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How A/V Tools assigns clip names
When using the New tab, Clip ID displays the base name for your new clips. For 
example, if the Clip ID is “MyClip,” A/V Tools will assign the name 
MyClip000.avi to the first new clip you capture, and continue naming clips 
sequentially (for example, MyClip001.avi, MyClip002.avi, etc.). Before 
capturing new clips, you can change the Clip ID to any base name you like. 

When editing clips using the Edit tab, Clip ID displays the name of the selected 
clip in the clip list. You can change the name by typing a new name in the Clip ID 
box on the Edit tab, then clicking Update. You can also change a clip ID directly 
in the clip list by typing a new name in the clip’s Clip ID box, then pressing 
ENTER.

¦ Note Changing the clip ID for a captured clip will not change the clip’s file 
name.

Capturing clips 
With A/V Tools you can capture live video from your camera, or video on tape. 
Capturing saves the clips as .avi files on your computer’s hard drive. 

¦ Note A/V Tools does not support capture from tape with device control.

Capturing live video
1 In the A/V Tools dialog box, click the CAM button. To capture live video, 

your device must be set to Camera mode.

2 In the Clip ID box, type the base clip name you’d like to be assigned to your 
clip. For more information, see “How A/V Tools assigns clip names” on 
page 105.

3 Click Capture.

4 A/V Tools will start capturing the clip. To stop the capture, click the Stop 
button.

5 Your captured clip is added to the clip list with its duration and an icon 
representing the first and last frames of the clip. 
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Capturing from tape without device control
1 In the A/V Tools dialog box, click the CAM button. To capture video from 

tape, your device must be set to VTR mode.

2 In the Tape ID box, type a name for the tape presently loaded in your VTR.

3 In the Clip ID box, type the base clip name you’d like to be assigned to your 
clip. For more information, see “How A/V Tools assigns clip names” on 
page 105.

4 Press the Play button on your device. You will see the video play back in the 
A/V Tools Preview Window and on your video monitor.

5 Click Capture.

6 A/V Tools will start capturing the clip. To stop the capture, click the Stop 
button.

7 Your captured clip is added to the clip list with its duration and an icon 
representing the first and last frames of the clip. 

Editing clips 
Matrox A/V Tools lets you update the clip ID and comment information for clips 
in your clip list, as well as change a clip’s In and Out icons.

Updating clip information
To update the clip ID and comment information for a clip, select the clip in the 
clip list and click the Edit tab. Type the new text in the text boxes, then click 
Update. For more information on the clip ID, see “How A/V Tools assigns clip 
names” on page 105.

Changing a clip’s In and Out icons
In and Out icons are the small icons representing the first and last frames of a 
clip in the clip list. These icons can be changed to better represent your clip.

°To change the In and Out icons of captured clips in the clip list: 

1 Use the transport controls to play back your clip in the preview window and 
on your video monitor. 

2 When you see the frame you want for the In icon, click Grab In Icon. A/V 
Tools automatically updates the icon.

3 When you see the frame you want for the Out icon, click Grab Out Icon. 
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Working with the clip list
The following sections explain how to add new clips to the clip list, play back 
clips, save and load clip lists, copy, move and delete clips, and how to detach and 
resize the clip list.

Adding clips 
You can add a clip or a series of clips (.avi files) to the clip list using any of the 
following methods:

• Drag an .avi file from a file management program, such as Windows 
Explorer, to the clip list. If you’re adding clips to an existing clip list, you 
can drag them to the bottom of the clip list, or place them in a specific 
position using the methods described in the section “Moving clips” on 
page 108.

• Right-click the clip list, then choose Import Clip from the pop-up menu (or 
double-click an empty area of the clip list). In the Open dialog box, select 
the .avi files you want to import, then click Open. 

Playing back clips
You can play back your clips one at a time, or in the same sequence as they 
appear in the clip list. To play back your clips: 

• Select a clip in the clip list and click the Play button on the transport 
controls.

• Right-click a clip on the clip list and choose Play.

• To play back multiple clips in sequence, select a range of clips in the clip list 
using SHIFT+click or select individual clips using control click, then use 
one of the afore-mentioned methods to play them back.

Saving and loading a clip list
To save a clip list, right-click the clip list. Choose Save As from the pop-up 
menu to save your current clip list as a .dvl file. 

You can load a clip list (.dvl) using any of the following methods:

• Right-click the clip list. Choose Open Clip List or Open Recent to select a 
recently opened clip list. 

• Drag a .dvl file from a file management program, such as Windows Explorer, 
to the clip list. 

• Double-click the .dvl file in Windows Explorer to start A/V Tools and load 
the clip list. Make sure that A/V Tools is not running when you do this.
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Remarks
$ The first time you double-click a .dvl file in Windows Explorer, you will 

need to specify Matrox A/V Tools as the program you want to use to open 
.dvl files. 

$ If you load a .dvl file to a clip list that already contains clips, it will 
replace the current clip list. If needed, your editing video format in A/V 
Tools will be changed to match the video format of the clips in the loaded 
clip list.

Copying clips
You can copy a clip or a series of clips in the clip list using either of the following 
methods:

• Select the clips you want to copy, right-click the clip list, then choose Copy 
from the pop-up menu. Select a clip in the clip list, then choose Paste to 
paste the copied clips above the currently selected clip.

• Select the clips you want to copy, then CTRL+drag the clips and drop them 
into the sequence you want.

¦ Note When copying a clip, the clip’s .avi file is not copied, only the reference 
to the clip on disk is copied. A/V Tools assigns the -Copy extension to the Clip ID 
of the copied clips.

Moving clips
You can change the order of clips in the clip list, such as to arrange clips in the 
order you want to play them back. To rearrange your clips, do any of the 
following: 

• Select the clips you want to move, then drag and drop them into the sequence 
you want. If you drag clips up in the clip list, the clips are inserted above the 
black line. If you drag clips down in the clip list, the clips are inserted below 
the black line. Releasing the mouse button places the clips in the list and 
ripples the position of all subsequent clips in the clip list.

• Select the clips you want to move, then right-click the clip list. Choose Cut 
from the pop-up menu to cut the clips. Select a clip in the clip list, then 
choose Paste to paste the clip above the currently selected clip. 

Deleting clips
Select the clips you want to delete, right-click the clip list, then choose one of the 
following from the pop-up menu: 

• To delete only the selected clips from the clip list, choose Delete Clip Only.

• To delete the selected clips and their corresponding files from your hard 
drive, choose Delete Clip+File. 
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Detaching and resizing the clip list
You can change the size of your clip list to suit your needs. First, detach the clip 
list from the Matrox A/V Tools dialog box by clicking the Float/dock clip list 
button ( ) above the clip list. Now the clip list can be freely moved and 
resized. To resize the clip list, drag the sides or corner of the clip list as needed. 
You can also use the standard Windows Maximize and Restore buttons in the 
top right corner of the window. 

After resizing, A/V Tools will automatically rearrange the clips in the clip list. To 
dock the clip list back to the Matrox A/V Tools dialog box, click the 
Float/dock clip list button, or click the Close button in the top right corner of 
the Clip List window. Once the window is docked again, A/V Tools will 
remember the previous size and location of the clip list for the next time you 
detach the clip list.

Grabbing a single-frame image
You can grab single-frame (still) images and save them as .tga files to use in your 
Adobe Premiere Pro projects. Your source video can be a clip on tape, a clip on 
disk, or live video.
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°To grab a single-frame image: 

1 Play back your source video. If it is on disk, you can use the transport 
controls to locate the clip

2 In the A/V Tools dialog box, click the Grab Image button to open the Grab 
Image dialog box.

3 When the frame you want is displayed in the Preview Window, click the 
Grab button. 

4 If you notice flickering in your image, you can choose to grab only one of 
the fields. From the Grab list, select Field 1 or Field 2. One field contains 
the odd-numbered scan lines in the frame, and the other field contains the 
even-numbered lines. Select the field that best displays your image. A/V 
Tools interpolates between the two consecutive scan lines to create the 
missing field. 

5 Click Save or Save As to save the image.

6 Click the Close button to return to the Matrox A/V Tools dialog box.

¦ Note If you do not specify a file name in the Save As text box, or if you select 
Auto Save, A/V Tools will assign a default name to the first grabbed image 
(such as MyImage01.tga or a name based on the last name you used) and 
continue naming images sequentially.
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Keyboard shortcuts
The following table provides a complete list of keyboard shortcuts available for 
using A/V Tools.

Keyboard Shortcuts

Disk mode K

CAM mode B

Play B

 Rewind Z

Fast Forward X

Frame Advance ’ (apostrophe)

Frame Reverse ; (semicolon)

Stop V

Loop A

Delete Clip Only DELETE

Delete Clip + File SHIFT+DELETE

Grab F5

Auto Save F6

Save F7

Import Clip CTRL+I

Select All CTRL+A

Cut CTRL+X

Copy CTRL+C

Paste CTRL+V

New Clip List CTRL+N

Open Clip List CTRL+O

Save Clip List CTRL+S
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Your notes
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Using the Matrox WYSIWYG Plug-ins

This chapter explains how to 
use the Matrox WYSIWYG 
Control Panel and plug-ins 
available with Matrox RT.X2 so 
that you can display the 
contents of your composition 
or animation on your video 
monitor.
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Overview
Together with your Matrox RT.X2 hardware, the Matrox WYSIWYG Control 
Panel and Matrox WYSIWYG plug-ins let you display the contents of your 
composition or animation on your video monitor. This lets you see the exact 
color temperature, safe-title area, and any interlaced artifacts as you work.

You can preview video played back using the following applications that are 
supported by the Matrox WYSIWYG plug-ins:

• Adobe After Effects, version 5.0 to CS5.

• Adobe Photoshop, version 7.0 to CS4 (32-bit only), and CS5 (32-bit and 
64-bit).

• Autodesk 3ds Max, version 7.0 to 2009 (32-bit only).

• Autodesk Combustion, version 4.0 to 2008 (32-bit only).

• eyeon Fusion, version 4.0 to 5.2 (32-bit only), 6.0 and 6.1 (32-bit and 
64-bit).

• NewTek LightWave 3D, version 7.0 to 9.2 (32-bit only), 9.6 and 10 (32-bit 
and 64-bit).

Configuring the Matrox WYSIWYG Control 
Panel

The Matrox WYSIWYG Control Panel lets you specify the settings you want for 
previewing video on your video monitor. To use the Matrox WYSIWYG Control 
Panel, right-click the  icon on your Windows taskbar. If you don’t see the 

 icon, choose Start > All Programs > Matrox Mtx.utils > Matrox 
WYSIWYG Control Panel.

The Matrox DVI Calibration Utility uses the Matrox WYSIWYG Control Panel 
to display specially designed graphics for calibrating your DVI monitor for video 
(not applicable to RT.X2 LE or RT.X2 SD). For details on calibrating your DVI 
monitor, see Chapter 2, “Calibrating Your DVI Monitor for Video.”

¦ Note By default, the Matrox WYSIWYG output to your video monitor is 
enabled. To disable it, clear the Enable WYSIWYG Output option in the 
Control Panel.

1 From the Project Format menu, select the format that matches your 
composition or animation, such as NTSC 4:3.

2 Choose Output Configuration to specify the video output settings you 
want for previewing your video. The available settings depend on your 
selected project format (editing video format), and are the same as those 
provided when using Adobe Premiere Pro as explained in “Specifying your 
video output settings” on page 16.
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3 If your video output format has a frame rate of 25 or 50 fps, and your DVI 
video monitor is unable to properly display your preview output, select 
Force DVI Output to 60 Hz (Bypass Autodetect). Otherwise, make sure 
this option isn’t selected to allow Matrox RT.X2 to automatically detect the 
frequency rates supported by your DVI video monitor and set the DVI output 
frequency accordingly.

4 From the Preview Type menu, select one of the following options for the 
preview:

$ Video Select this to view your composition or animation.

$ Alpha Channel Select this to view only your composition’s or 
animation’s grayscale alpha-key (matte) information.

5 From the Scaling menu, select one of the following options for your preview 
output:

$ Scale to fit Select this to scale your output to fit your video monitor. 
The aspect ratio of your project format will be preserved.

$ Original Size Select this to output your video without any scaling. If 
you are playing back HD clips in an SD project, your output will be 
centered on your video monitor.

Required steps to use the WYSIWYG plug-ins
The following sections list the steps required to use the Matrox WYSIWYG 
plug-in for each application in order to preview video on your video monitor.

¦ Note The following procedures may change with a subsequent release of the 
program.

Adobe After Effects
1 Start Adobe After Effects and import the footage you want to preview.

2 Drag the footage from the Project window to the Composition panel.

¦ Note In order for the preview to be updated on your video monitor when you 
scrub the timeline, you must disable OpenGL for your previews. To do this, 
choose Edit > Preferences > Previews, and clear the Enable OpenGL option.

Adobe Photoshop
1 Start Adobe Photoshop and open the file you want to preview.

2 Choose File > Export > Matrox WYSIWYG Preview.

Autodesk 3ds Max 
1 Start Autodesk 3ds Max and open the file you want to preview.

2 Open the Render Scene dialog box by choosing Rendering > Render 
Setup.
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3 Click the Common tab.

4 Under Render Output, click Devices.

5 In the Select Image Output Device dialog box, select Matrox WYSIWYG 
Preview, and click OK.

6 Click Render.

Autodesk Combustion
1 Start Autodesk Combustion and open the file you want to preview.

2 Choose File > Preferences > Framebuffer.

3 In the menu beside Framebuffer Type, select Matrox WYSIWYG 
Preview, and click OK.

eyeon Fusion
1 Start eyeon Fusion and open the file you want to preview.

2 Right-click on the file, and choose View On > Matrox WYSIWYG 
Preview.

NewTek LightWave 3D
1 Start NewTek LightWave 3D and load the file you want to preview by 

choosing File > Load > Load Scene.

2 Click the Render tab.

3 Under Options on the left hand side of the screen, click Render Globals.

4 From the Render Display menu, select Matrox WYSIWYG Preview.

5 Under Render on the left hand side of the screen, click Render Frame.
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Using the Matrox Video for Windows

Codecs
This chapter explains how to 
use the Matrox Video for 
Windows codecs to render 
material to Matrox .avi files.
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Overview
When using Video for Windows (VFW) programs to render material to an .avi 
file, such as in the case of a completed video production or an animation, you can 
use a Matrox VFW codec to create a Matrox .avi file. For example, you may want 
to render an animation to a Matrox MPEG-2 I-frame .avi file so that you can 
import the file as a realtime clip into your Adobe Premiere Pro projects on 
Matrox RT.X2.

When rendering compositions or animations that have an alpha channel, you can 
select a “+ Alpha” Matrox VFW codec to render to a Matrox uncompressed or 
MPEG-2 I-frame .avi file that contains the alpha-key information. This .avi file 
will be automatically keyed when you place the clip in an Adobe Premiere Pro 
sequence.

The following sections explain the various settings that you need to make to 
render material to a Matrox .avi file using a VFW program. For details on 
exporting a Matrox sequence in Adobe Premiere Pro, see “Exporting to a Matrox 
.avi file” on page 33.

¦ Note Although Matrox has tested many VFW programs, there may be certain 
operational limitations when using the Matrox VFW codecs with some of these 
programs (as well as with untested programs).

Using VFW programs without the RT.X2 
hardware

 If you installed the Matrox VFW software codecs for use without the RT.X2 
hardware (see “Installing the Matrox VFW software codecs on a system without 
the RT.X2 hardware” in your Matrox RT.X2 Installation Manual), you can render 
and play back Matrox .avi files without having the RT.X2 hardware in your 
computer. For example, if you captured clips to Matrox MPEG-2 I-frame format 
using Adobe Premiere Pro, you could edit and play back those clips on a system 
without the RT.X2 hardware, assuming that you installed the Matrox VFW 
software codecs on that system.
pter 7, Using the Matrox Video for Windows Codecs
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Before you start rendering
Before you start rendering material to a Matrox .avi file, make the following 
settings in your VFW program:

• Set the frame size (width and height) of your rendered material to 
full-screen, depending on the codec that you’ll be using.

$ DV/DVCAM, DVCPRO, DVCPRO50, or MPEG-2 I-frame SD:

• 720 × 480 to render to NTSC or 486p format.

• 720 × 576 to render to PAL or 576p format.

$ Uncompressed SD:

• 720 × 486 to render to NTSC or 486p format.

• 720 × 576 to render to PAL or 576p format.

$ MPEG-2 I-frame HD:

• 1280×720 to render to 720p format.

• 1440×1080 to render to 1440×1080i/p format.

• 1920×1080 to render to full-size 1080i/p format.

$ DVCPRO HD or Uncompressed HD:

• 1280×720 to render to 720p format.

• 1920×1080 to render to 1080i/p format.

• Set the appropriate frame rate for the video format to which you are 
rendering. For example, if you are rendering to PAL format, set the frame 
rate to 25 fps.

• If available, select the “Recompress” option. This allows you to render video 
using the same compression format, frame size, and frame rate as your 
source video but using a different data rate, scanning mode (interlaced or 
progressive), or bit depth (8-bit or 10-bit).

• If you’ll be rendering audio, set the audio sample rate to 48 kHz and the 
sample size to 16-bit (mono or stereo).

• For best results, make sure that there is no data rate limit set in your program 
for rendered material. This ensures that your .avi files will be rendered at the 
particular data rate you select.

¦ Note Before rendering a lot of material, check that your rendered animations 
and transitions such as wipes and slides play back smoothly. If they appear 
jumpy, try adjusting the field dominance or field order for your rendered material. 
Before you start rendering



120

Cha
Selecting color space conversion options
When you render material to an .avi file using a Matrox VFW codec, you can 
determine how you want the luminance levels and chroma information to be 
processed during the color space conversion that’s performed during the render.

¦ Note The default settings for color space conversion provide good results for 
most applications. We recommend that you change these settings only when 
needed for special purposes.

°To select the color space conversion options you want:

1 Choose Start > All Programs > Matrox Mtx.utils (or Matrox VFW 
Software Codecs) > Matrox VFW Codec Configuration.

2 In the provided dialog box under Color Space Conversion, select the 
options you want:

$ Standard Renders video using standard broadcast luminance levels. 
Super black and super white luminance levels are clipped.

$ Expanded Renders video using the full range of luminance levels. 
Super black and super white luminance levels are retained. You may want 
to use this setting, for example, to render material on which you’ll be 
applying luminance key effects.

¡ Important When rendering RGB graphics, selecting Expanded will 
create super black and/or white in your rendered images. For example, all 
black in your RGB graphics will become super black, and white will become 
super white. To render your RGB graphics with standard black and white 
levels, set your luminance range to Standard.
pter 7, Using the Matrox Video for Windows Codecs
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$ Chroma filtering and Chroma interpolation Select these options to 
adjust the chroma bandwidth of RGB graphics. This improves images that 
have abrupt changes between different colors, such as a blue box on a 
black or white background. You should select these options for most 
animation and compositing work (computer-generated material). For most 
video editing programs, however, it’s best that you not select these 
options. If you find that your rendered images appear to be blurred, try 
clearing one or both of these options.

3 Click OK to save your settings. Any change you make to your selected 
luminance range setting (such as switching from Standard to Expanded) 
will only take effect the next time you start your VFW program.

Rendering material to a Matrox VFW .avi file
When you render material to an .avi file, such as when you render a finished 
video production or an animation, you must select the compressor (codec) you 
want to create the file. The compressor determines the quality of your rendered 
video. Refer to your program’s documentation for instructions on how to select a 
compressor for your .avi file.

For information about exporting using Adobe Premiere Pro, see “Exporting to a 
Matrox .avi file” on page 33.

°To create a Matrox VFW .avi file:

1 Select one of the following codecs from your program’s list of available 
compressors:

$ Matrox DV/DVCAM Renders video to DV or DVCAM format.

$ Matrox DVCPRO Renders video to DVCPRO format.

$ Matrox DVCPRO50 Renders video to DVCPRO50 or D-9 format.

$ Matrox DVCPRO HD Renders video to DVCPRO HD format (for 
1080i and 720p video only).

$ Matrox MPEG-2 I-frame Renders video to MPEG-2 intra-frame 
format using the 4:2:2 Profile @ Main Level at a selected data rate (SD 
resolution only).

$ Matrox MPEG-2 I-frame + Alpha Renders video to MPEG-2 
intra-frame format with alpha using the 4:2:2 Profile @ Main Level at a 
selected data rate (SD resolution only).

$ Matrox MPEG-2 I-frame HD Renders video to MPEG-2 intra-frame 
format using the 4:2:2 Profile @ High Level at a selected data rate.

$ Matrox MPEG-2 I-frame HD + Alpha Renders video to MPEG-2 
intra-frame format with alpha using the 4:2:2 Profile @ High Level at a 
selected data rate.
Rendering material to a Matrox VFW .avi file
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$ Matrox Uncompressed SD Renders video to 8-bit or 10-bit 
uncompressed SD format.

$ Matrox Uncompressed SD + Alpha Renders video to 8-bit or 10-bit 
uncompressed SD format with alpha.

$ Matrox Uncompressed HD Renders video to 8-bit or 10-bit 
uncompressed HD format.

$ Matrox Uncompressed HD + Alpha Renders video to 8-bit or 10-bit 
uncompressed HD format with alpha.

¦ Note The Matrox Offline HD codec is not supported for rendering clips. 
This codec is provided only for playback of legacy Matrox Axio offline HD 
projects.

2 If you’ve selected a Matrox codec that requires configuration, click the 
button provided by your program that allows you to configure your codec 
settings. For more details, see the following sections.

Configuring the Matrox DVCPRO HD codec
When you choose to configure the Matrox DVCPRO HD codec, a dialog box 
similar to the following appears:

From the Frame Rate list, make sure that you select the frame rate that matches 
the frame rate specified for rendering video in your editing application.

Configuring the Matrox Uncompressed codecs 
When you choose to configure a Matrox Uncompressed codec (SD or HD 
resolution), a dialog box similar to the following appears:
pter 7, Using the Matrox Video for Windows Codecs
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1 Under Bit Depth, select the bit depth you want for your video. 

¦ Note Matrox RT.X2 does not support 10-bit uncompressed video.

2 Under Scan Mode, select the scan mode of your video. 

3 Click OK to save your selection. The settings you selected will be used each 
time you render material with your program, until you change the settings 
again.

Configuring the Matrox MPEG-2 I-frame codecs
When you choose to configure a Matrox MPEG-2 I-frame codec (SD or HD 
resolution), a dialog box similar to the following appears:

1 Drag the Data Rate slider until your desired data rate is displayed. The 
higher the data rate you select, the better the video quality will be. 
Depending on the capabilities of your system, however, you may not be able 
to smoothly play back video at a high quality using your VFW program. 

2 Beside Frame Rate, select a frame rate from the list. Make sure the frame 
rate you select is appropriate for the format to which you are rendering. 

3 To apply advanced settings to your MPEG-2 I-frame file, click the 
Advanced button.

¦ Note The default advanced settings should provide good results for most 
applications. It’s recommended that you change these settings only when 
needed for special purposes.

4 Beside DC Precision, select the bit-depth precision of the DC intra block. 
The higher the DC precision value that’s used to render your video, the more 
likely that the DC content will be increased at the expense of the AC content 
in the encoded stream. This may result in lowering the overall quality of the 
compressed stream at a specified data rate.

5 Under Zig Zag Order, select one of the following:
Rendering material to a Matrox VFW .avi file
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$ Regular Sets the regular (default) zig zag scanning pattern of the AC 
coefficient of the DCT block as defined in the ISO/IEC 13818-2 
(figure 7-2) specification documentation.

$ Alternate Sets an alternate zig zag scanning pattern of the AC 
coefficient of the DCT block as defined in the ISO/IEC 13818-2 (figure 
7-3) specification documentation. Use this setting when capturing or 
rendering video at a high data rate (for example, at a data rate of 100 
Mb/sec or higher).

6 Under Rounding Type, select one of the following:

$ MPEG-2 Rounds the AC coefficients up to the nearest whole number 
when calculating the quantization coefficient. 

$ Matrox Custom Truncates the AC coefficients to the lowest whole 
number when calculating the quantization coefficient. In some cases, this 
setting may yield less artifacts in graphics.

7 Select the Force Frame-based DCT setting to render macroblocks as 
frames rather than as fields. In some cases, graphics will yield less artifacts if 
this option is selected.

8 Click OK to save your settings. The settings you selected will be used each 
time you render material with your program, until you change the settings 
again.
pter 7, Using the Matrox Video for Windows Codecs
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system and installed hardware.



126

Cha
Using X.info to display RT.X2 information
The Matrox X.info program lets you display information about your Matrox 
RT.X2 system and installed hardware, and provides warnings when certain 
problems arise, such as when the temperature of your RT.X2 card exceeds the 
maximum operating temperature.

Matrox X.info runs continuously to monitor your system, whenever your 
computer is turned on. You can open Matrox X.info to display system and 
hardware details by double-clicking the  icon on your Windows taskbar. 

¦ Note If you do not see the icon, right-click the notification area of the taskbar 
and choose Properties, clear the Hide inactive icons option, and click OK.

Displaying system information
To display information about your Matrox RT.X2 system, select System from 
the Display Information About list. On this page, you can see Install 
Information, such as the install path and version of Matrox Mtx.utils.

You can also create an HTML log file of your system information, which can be 
useful for troubleshooting. To create this log, use the Browse button under 
System Information Log to select the path and name of the log, then click 
pter 8, Monitoring Your Matrox RT.X2 System
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Create. If Open file after scan is selected, the HTML system log opens after it 
is created.

If you had previously turned off certain Matrox warnings and want them to be 
re-enabled, click Re-enable Warnings. For example, some Matrox warnings 
provide an option to turn off the warning (that is, you can select Don’t display 
this message again). Clicking Re-enable Warnings allows these warnings to 
be displayed again.
Using X.info to display RT.X2 information
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Displaying hardware information
To display information about your Matrox RT.X2 hardware, select Hardware 
from the Display Information About list. Your RT.X card and display card are 
each represented by a tab.

Click a card’s tab to display a page with hardware information (for example, 
serial number and production date). You can also monitor the current and 
maximum operating temperatures for your RT.X2 card.

¡ Important Whether or not you have opened Matrox X.info, if your RT.X2 
card exceeds the maximum operating temperature, you’ll receive a warning 
message with further instructions as explained in the section “Error notification” 
on page 129.
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Monitoring your RT.X2 card’s operating 
temperatures
As shown in the X.info Hardware section, the RT.X2 Card page displays the 
current and maximum operating temperatures for your Matrox RT.X2 card. To 
avoid damage to your Matrox RT.X2 system, make sure that you don’t operate 
your RT.X2 card at or near the maximum temperature for a prolonged period of 
time. You should target your RT.X2 card to operate at least 10°C below the 
maximum operating temperature.

You should monitor the temperature of your RT.X2 card periodically and take 
measures as needed to lower the room temperature and/or improve the ventilation 
in your Matrox RT.X2 system. For details on how to ensure your system is 
properly ventilated, see your Matrox RT.X2 Installation Manual.

Error notification
X.info provides temperature warnings and warnings for other possible RT.X2 
hardware problems. Once X.info has detected a hardware problem, the Matrox 
X.info Notification dialog box will be displayed to give you details of the 
problem and further instructions. You will not be able to close this dialog box 
until the problem has been resolved.
Using X.info to display RT.X2 information
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Your notes
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Understanding Standard and Advanced

Pulldown
This appendix describes the 
most common pulldown 
methods, and explains how 
and when these pulldown 
methods are employed by 
Matrox RT.X2.



132

App
Overview
Part of your project’s workflow may involve the application of a pulldown 
technique to convert your input video to the video format of your sequence. 
Pulldown can also be applied to your output video to meet certain requirements. 
When a pulldown is required, Matrox RT.X2 performs either a standard 2:3 
pulldown or an advanced 2:3:3:2 pulldown.

Standard 2:3 pulldown
Standard 2:3 pulldown is often used as part of the telecine process to transfer 
24 fps film footage to 29.97 fps interlaced video. This pulldown method is also 
used to convert any 23.98 fps progressive video to 29.97 fps interlaced video, 
such as for converting 486p @ 23.98 fps video to NTSC. 

In order to convert 24 fps film or 23.98 progressive video to 29.97 fps interlaced 
video, additional video frames, and more specifically video fields, must be 
created and added to the video sequence. For example, to convert a sequence of 
four film or progressive frames, five frames of video are needed for a total of 10 
video fields. Therefore, one additional video frame or two video fields must be 
created. To accomplish this, the first and third frames of a four-frame film or 
progressive video sequence are each converted to two video fields. The second 
and fourth frames of the sequence are converted to three video fields to make up 
a total of five interlaced video frames. 

The following diagram demonstrates the process: 

Standard 2:3 pulldown is accomplished by representing the first frame of film or 
progressive video (frame A) as two fields of video (fields a1 and a2), the second 
frame (frame B) as three fields of video (fields b1, b2, and b3), the third frame 
(frame C) as two fields (fields c1 and c2), and the fourth frame (frame D) as three 
fields (fields d1, d2, and d3). This sequence repeats six times each second. 

A B C D

a1 a2 b1 b2 b3 d2d1c2c1 d3

Film frames @ 24 fps or progressive frames @ 23.98 fps

Video fields @ 29.97 fps

Frame A Frame C Frame DFrame B Frame E
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Performing a standard reverse pulldown (2:3 cadence) reverses the process by 
converting 29.97 fps interlaced video to 23.98 fps progressive video. This is 
achieved by discarding a video frame (two video fields) from the sequence. From 
the diagram above, a typical standard reverse pulldown would discard fields b3 
and d1. This means that video frames C and D must be read by the application to 
remove the additional fields. For standard reverse pulldown that is performed on 
compressed video, the application must decompress frames in order to remove 
the additional fields, and then it must recompress frames to complete the 
conversion.

Matrox RT.X2 implementation of standard 
reverse pulldown
In order for Matrox RT.X2 to properly perform a standard reverse pulldown, the 
material that is to be converted from 29.97 fps interlaced video to 23.98 fps 
progressive video must have been originally acquired at 23.98 fps. When Matrox 
RT.X2 performs a standard reverse 2:3 pulldown, the process identifies the A 
frames of a sequence as those frames that have time code ending in 0 or 5. For 
example, a frame with the time code 00:00:20:20 or 00:00:20:25 would be 
considered an A frame, and therefore would be used as the first frame in a 
pulldown sequence.

In the case of batch captures, when the first frame of a clip that is to be captured 
might not always be an A frame, Matrox RT.X2 advances to the next instance of 
an A frame in the clip to start the pulldown sequence (if it’s required). In order 
for Matrox RT.X2 to perform standard reverse 2:3 pulldown accurately, the clips 
must have A frames appearing at time codes 0 and 5. The clips must also be 
recorded to a tape that has continuous, non-drop frame time code. 

Advanced 2:3:3:2 pulldown
Advanced 2:3:3:2 pulldown was developed as an alternative to the standard 
pulldown method for making frame rate conversions in DV video. It is used to 
convert 486p @ 23.98 fps video to NTSC (486i @ 29.97 fps) video. This 
conversion is used when video footage is acquired by a DV camera at 23.98 fps 
and recorded to DV tape with the recorder set for advanced pulldown (called 
24PA or 24P Advanced mode on some devices). Advanced 2:3:3:2 pulldown 
differs from standard 2:3 pulldown in that the two middle frames of the video 
sequence are each converted to three video fields. 
Advanced 2:3:3:2 pulldown



134

App
The following diagram demonstrates the process:

Advanced 2:3:3:2 pulldown is accomplished by representing the first frame of 
progressive video (frame A) as two fields of video (fields a1 and a2), the second 
frame (frame B) as three fields of video (fields b1, b2, and b3), the third frame 
(frame C) as three fields (fields c1, c2, and c3), and the fourth frame (frame D) as 
two fields (fields d1 and d2). 

Performing an advanced reverse pulldown (2:3:3:2 cadence) reverses the process 
by converting 29.97 fps interlaced video to 23.98 fps progressive video. This is 
achieved by discarding a video frame (two video fields) from the sequence. From 
the diagram above, a typical advanced reverse pulldown would discard video 
fields b3 and c1. This means that the application can remove video frame C from 
the sequence without reading the other frames.

When compared to standard reverse pulldown, advanced reverse pulldown results 
in less degradation in the converted video because removing an entire frame from 
the sequence leaves the remaining frames in the sequence intact, and therefore 
preserves the native generation of the video.

Matrox RT.X2 implementation of advanced 
reverse pulldown
The advanced reverse pulldown process is simpler than a standard reverse 2:3 
pulldown because the additional frame, video frame C in the diagram above, is 
tagged when the 23.98 fps progressive footage is recorded to tape. This 
information is present in the DV stream and when Matrox RT.X2 performs an 
advanced reverse pulldown, it reads this information to identify the additional 
frame that is then removed from the sequence. Matrox RT.X2 can perform 
advanced reverse pulldown on clips that have been recorded to a DV tape that has 
continuous drop-frame or non-drop frame time code.

A B C D

a1 a2 b1 b2 b3 d1c3c2c1 d2

Progressive frames @ 23.98 fps

Video fields @ 29.97 fps

Frame A Frame C Frame DFrame B Frame E
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Overview
This appendix provides general information about using various Matrox RT.X2 
sequence presets and codecs for working with different types of sequences in 
Adobe Premiere Pro. Workflow diagrams and descriptions are used to help 
explain the specific workflow details.

Working with SD “24P” material
Matrox RT.X2 allows you to choose a Premiere Pro preset to work with SD 
material originally acquired at 23.98 fps. When you select the Matrox 486p @ 
23.98 fps sequence preset, you can edit SD material as 23.98 fps progressive 
video as long as the source video was originally acquired at 23.98 fps. This 
includes video that was captured to tape by a DV camera capable of shooting 
486p @ 23.98 fps video. You cannot use the 486p @ 23.98 fps preset to capture 
or edit video that was originally acquired as NTSC or PAL.

Regardless of it’s origin, SD material that is acquired at 23.98 fps must undergo a 
format conversion to NTSC (486i @ 29.97 fps) when it is recorded to tape. This 
means that the output from your source device and input to Matrox RT.X2 is 
always NTSC. Your source device outputs the 23.98 fps material as NTSC by 
applying a pulldown method when it records the material.

Some DV cameras that are capable of shooting 23.98 fps progressive video have 
the option of performing either a standard or advanced pulldown for recording 
material to tape. Matrox RT.X2 allows you to capture 486p @ 23.98 fps DV 
material natively over the 1394 interface to a Matrox .m2v file so that you can 
import the file to Adobe Encore for DVD authoring. During capture, Matrox 
RT.X2 detects the original pulldown method in the DV stream, and then performs 
either a standard or advanced reverse pulldown.

The analog output from your 486p @ 23.98 fps sequence on Matrox RT.X2 is 
always NTSC. Matrox RT.X2 provides the option to apply either an advanced or 
standard pulldown. In most cases, you would want to perform a standard 2:3 
pulldown when you export analog video from your 486p @ 23.98 fps sequence to 
tape. For more information about pulldown, see Appendix A, “Understanding 
Standard and Advanced Pulldown.”
endix B, Matrox RT.X2 Workflows
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486p @ 23.98 fps workflow example
The following diagram illustrates a typical 486p @ 23.98 fps workflow using 
Matrox RT.X2:

¦ Note You can also capture DV clips natively over the 1394 interface using the 
Adobe Premiere Pro DV capture format as explained in your Adobe Premiere Pro 
documentation. If you want to export your 486p @ 23.98 fps sequence to a 
DV-1394 device, you must copy or import your sequence to a native Adobe 
Premiere Pro DV-24p sequence.

DV camera performs either standard or
advanced pulldown (depending on mode
selection) when the acquired footage is
recorded to tape.

Analog export to tape
as NTSC video

Matrox .m2v file imported to
Adobe Encore for DVD

authoring

Matrox RT.X2
486p @ 23.98 fps

sequence

Depending on the user’s selection of
pulldown method, Matrox RT.X2 performs
either a standard or advanced pulldown.

DV-1394 input (capture to
Matrox .m2v file)

Matrox RT.X2 detects original pulldown
method, then performs either a standard
or advanced reverse pulldown during
capture.

SD video footage acquired
at 23.98 fps progressive

scan

NTSC video on tape
Working with SD “24P” material
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Working with HD sequences
Matrox RT.X2 lets you capture HD analog component input to MPEG-2 I-frame 
HD format, and capture HDV and DVCPRO HD material natively over the 1394 
interface (for HDV capture, however, you must use the Adobe Premiere Pro HDV 
capture format). You can mix the native HDV, DVCPRO HD, and MPEG-2 
I-frame HD clips in real time in the same HD sequence. You can also import 
file-based clips supported by Adobe Premiere Pro, such as XDCAM EX and 
AVCHD clips.

When your edits are complete, you can export your sequence to a DVCPRO HD 
device over the 1394 interface (depending on your sequence’s video format), or 
export to tape using your Matrox RT.X2’s HD analog component output. You can 
also choose to downconvert the video to NTSC or PAL to record to SD tape. The 
format in which you can export analog video depends on your sequence’s video 
format as explained in “Supported master output formats” on page 148. 

¦ Note To export your sequence to an HDV device over the 1394 interface, you 
must copy or import your Matrox sequence into a native Adobe Premiere Pro 
HDV sequence.

720p workflow example
Matrox RT.X2 supports creating 720p sequences at 23.98 fps, 25 fps, 29.97 fps, 
50 fps, and 59.94 fps. If you’re working with a 720p @ 23.98 fps or 25 fps 
sequence, Matrox RT.X2 supports capturing Panasonic VariCam material (you 
must select Enable VariCam capture when you perform the capture). In this 
case, RT.X2 will remove the redundant frames from the VariCam input during 
capture and create a clip in the same format as your sequence for editing.

Depending on your sequence’s video format, you can export your sequence to 
tape as 720p @ 50 fps or 59.94 fps video, or downconvert the video to NTSC or 
PAL. You can also export over the 1394 interface to DVCPRO HD for a 720p @ 
59.94 fps sequence.

Remarks
• Analog component input is not supported for 720p sequences, and DVCPRO 

HD capture over the 1394 interface is not supported for 720p @ 50 fps 
sequences.

• You can capture HDV clips natively over the 1394 interface using the Adobe 
Premiere Pro HDV capture format as explained in your Adobe Premiere Pro 
documentation.
endix B, Matrox RT.X2 Workflows
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The following diagram illustrates a typical workflow for working with a 720p 
sequence on Matrox RT.X2:

Matrox
720p sequence

Native HDV and
DVCPRO HD 720p

video footage on tape

Exported to tape
as SD video

(NTSC or PAL)
for broadcast

Exported to disk,
such as to an

MPEG-2 file for
DVD authoring,
or a Matrox .avi

file

Exported to tape as
720p @ 50 fps or
59.94 fps analog
component video

for broadcast

HDV and DVCPRO HD
clips captured natively
over the 1394 interface

Exported to
DVCPRO HD over
the 1394 interface

When capturing Panasonic
Varicam material, RT.X2 will
remove the redundant
frames and create a clip in
your sequence’s format for
editing (for 720p @ 23.98 fps
and 25 fps sequences only).
Working with HD sequences
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1440×1080i/p workflow example
The following diagram illustrates a typical workflow for working with a 
1440×1080i/p sequence on Matrox RT.X2:

Remarks
• HDV clips are captured natively over the 1394 interface using the Adobe 

Premiere Pro HDV capture format as explained in your Adobe Premiere Pro 
documentation.

• To output a 1440×1080p @ 23.98 fps sequence as 1080i @ 29.97 fps or 
NTSC, Matrox RT.X2 will perform a standard 2:3 pulldown.

Exported to disk, such
as to an MPEG-2 file

for DVD authoring, or a
Matrox .avi file

Clips captured natively over
the 1394 interface, or

Matrox MPEG-2 I-frame HD
codec used to capture HD
analog component video

Matrox
1440x1080i/p

sequence

Exported to tape as HD
analog component video for

broadcast

Native HDV (1080i/p), or
analog component video

footage (1080i only)

Exported to tape as SD
video (NTSC or PAL)

for broadcast
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1080i workflow example
When working in a 1080i @ 25 fps or 29.97 fps sequence, you can capture 
analog component video using the Matrox MPEG-2 I-frame HD codec, as well as 
capture DVCPRO HD video natively over the 1394 interface. You can export 
your sequence to tape in the same format as your sequence, or you can choose to 
downconvert the video to NTSC or PAL (NTSC for a 1080i @ 29.97 fps 
sequence, or PAL for a 1080i @ 25 fps sequence). You can also export your 
sequence natively over the 1394 interface to a DVCPRO HD device.

¦ Note If you want to capture and edit only HDV clips, you should create a 
1440×1080i/p @ 25 fps or 29.97 fps sequence. A 1440×1080i/p sequence 
provides better editing performance than a full-size 1080i/p (1920×1080) 
sequence, and supports capturing HDV material natively over the 1394 interface 
using the Adobe Premiere Pro HDV capture format. A 1440×1080i @ 25 fps or 
29.97 fps sequence also supports capturing analog component input to Matrox 
MPEG-2 I-frame HD format.
Working with HD sequences
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The following diagram provides a typical workflow for working with a 1080i @ 
25 fps or 29.97 fps sequence on Matrox RT.X2:

Film footage telecined and
transferred to HD tape.
Standard 2:3 pulldown
performed (for converting to
1080i @ 29.97 fps video only).

Matrox 1080i sequence

Matrox MPEG-2 I-frame
HD codec used to
capture clips, or

DVCPRO HD clips
captured natively over

the 1394 interface

1080i video on tape

Exported to tape
as SD video

(NTSC or PAL)
for broadcast

Exported to
DVCPRO HD
over the 1394

interface

Film footage shot
at 24 fps

Exported to disk,
such as to an

MPEG-2 file for
DVD authoring,
or a Matrox .avi

file

Exported to tape
as 1080i analog

component
video for

broadcast
endix B, Matrox RT.X2 Workflows
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Using the Matrox MPEG-2 I-frame HD codec 
for online editing

The Matrox MPEG-2 I-frame HD codec allows you to control the data rate of the 
video that you are capturing or exporting. At high data rates (100 Mb/sec or 
higher), the codec can be used to capture high-quality video for online editing. 
The Matrox VFW MPEG-2 I-frame HD codec allows you to render and play 
back MPEG-2 I-frame HD clips in VFW applications, such as Adobe After 
Effects.

MPEG-2 I-frame HD codec workflow example 
for online editing
In this workflow example, the Matrox MPEG-2 I-frame HD codec is used to 
capture video clips for online editing. The clips are captured with Matrox RT.X2 
at a data rate of 100 Mb/sec or higher and then used to complete an online editing 
sequence in Adobe Premiere Pro. A VFW application is also used to render the 
clips in a compositing project using the Matrox VFW MPEG-2 I-frame HD 
codec. When the edit is complete, it is exported to tape for broadcast.

This workflow scenario is represented in the following diagram:

Exported to tape as finishing-quality
HD video for broadcast

Matrox MPEG-2 I-frame HD codec
set at 100 Mb/sec or higher used to

capture clips

Analog component video
footage shot as 1080i @ 25 fps

or 29.97 fps

Matrox 1440x1080i or 1080i online
editing sequence

VFW application, such as
Adobe After Effects, uses
the MPEG-2 I-frame HD
clips. The compositing

project is rendered using
the Matrox VFW MPEG-2

I-frame HD codec.

Clips rendered using
the Matrox VFW

MPEG-2 I-frame HD
codec are imported into
the online editing
sequence.

MPEG-2 I-frame HD clips used
in a VFW application on the
RT.X2 system or an offline
editing station.
Using the Matrox MPEG-2 I-frame HD codec for online editing
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Using the Matrox MPEG-2 I-frame HD codec 
for offline editing

You can use the Matrox MPEG-2 I-frame HD codec to capture clips at a low data 
rate of 50 Mb/sec for offline editing. You can then edit the offline sequence on 
your RT.X2 system, and later recapture the clips at a high quality to complete 
your sequence as finishing-quality HD video for broadcast. This workflow is 
described below in the section, “MPEG-2 I-frame HD codec workflow example 
for offline editing on an RT.X2 system.”

As an alternative, you can transfer your project and the offline-quality clips 
you’ve captured to a remote editing workstation, such as a laptop, to complete 
your offline edit using Adobe Premiere Pro with the Matrox VFW MPEG-2 
I-frame HD codec (see “Installing the Matrox VFW software codecs on a system 
without the RT.X2 hardware” in your Matrox RT.X2 Installation Manual). Once 
your edit is complete, you transfer the project back to your RT.X2 system so that 
you can recapture your clips at a high quality and create a finishing-quality 
project for broadcast. This workflow is described in “MPEG-2 I-frame HD 
workflow example for offline editing on a remote system” on page 146.

MPEG-2 I-frame HD codec workflow example 
for offline editing on an RT.X2 system
In this workflow example, the Matrox MPEG-2 I-frame HD codec is used to 
capture video clips for offline editing. The clips are captured with Matrox RT.X2 
at a data rate of 50 Mb/sec and then used to complete an offline editing sequence. 
When the offline edit is complete, the project is trimmed (using the Adobe 
Premiere Pro Project Manager), and the offline-quality clips are unlinked and 
then recaptured using the Matrox MPEG-2 I-frame HD codec at a data rate of 
100 Mb/sec or higher. The online editing sequence is then exported to tape for 
broadcast. 
endix B, Matrox RT.X2 Workflows
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This workflow scenario is represented in the following diagram: 

Analog component video
footage shot as 1080i @ 25 fps

or 29.97 fps

Matrox MPEG-2 I-frame HD
codec set at 50 Mb/sec used

to capture clips

Matrox 1440x1080i or 1080i
offline editing sequence

Project is trimmed, offline-
quality clips are unlinked and
recaptured usng the MPEG-2

I-frame HD codec at
100 Mb/sec or higher

Exported to tape as finishing-
quality HD video for broadcast
Using the Matrox MPEG-2 I-frame HD codec for offline editing
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MPEG-2 I-frame HD workflow example for 
offline editing on a remote system
In this workflow example, the Matrox MPEG-2 I-frame HD codec is used to 
capture video clips for use in an offline editing project that is to be completed on 
a remote editing system. Because the remote system has the Matrox VFW 
software codecs installed, the system can be used with Adobe Premiere Pro to 
produce the offline edit (the project will open in Desktop mode). When the 
offline edit is complete and trimmed, the Premiere Pro project (.prproj) file is 
transferred back to the Matrox RT.X2 system. The offline-quality clips are then 
unlinked and recaptured as high-quality clips using the Matrox MPEG-2 I-frame 
HD codec at a high data rate. The final online editing sequence is then exported 
to tape for broadcast. 

This workflow scenario is represented in the following diagram:

Offline-quality clips are
unlinked and recaptured

using the Matrox
MPEG-2 I-frame HD

codec at 100 Mb/sec or
higher

Offline project
and clips
transferred to
remote system.

Matrox 1440x1080i
or 1080i offline

editing sequence

Matrox MPEG-2 I-
frame HD codec set at

50 Mb/sec used to
capture clips

Exported to tape as
finishing-quality HD
video for broadcast

Analog component
video footage shot

as 1080i @ 25 fps or
29.97 fps

Remote editing
system with Matrox

VFW codecs
installed. The offline

edit is completed and
trimmed on the

system using Adobe
Premiere Pro (the
project will open in

Desktop mode)

Offline edit
Premiere Pro
project
( ) file
transferred to
Matrox RT.X2
system.

.prproj
endix B, Matrox RT.X2 Workflows
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Supported video compression formats
The following table lists the supported video compression formats for performing 
various operations on Matrox RT.X2 depending on your sequence’s video format.

SD sequence
HD sequence (not 
supported on RT.X2 SD)

Capture1

1 If you want to capture DV material other than DVCPRO HD natively over the 1394 
interface, you must use a native Adobe Premiere Pro DV or HDV capture format as 
explained in your Adobe Premiere Pro documentation.

DV/DVCAM
DVCPRO
MPEG-2 I-frame
MPEG-2 IBP (for capture 
to .m2v files only)

DV-1394 input:
DVCPRO HD2

Analog component input:
MPEG-2 I-frame HD (for 
1440×1080i and 1080i 
sequences only) 

2 DVCPRO HD is supported only for 1080i, 1080p @ 29.97 fps, and 720p sequences 
(DV-1394 capture is not supported for 720p @ 50 fps sequences). DV-1394 export to 
DVCPRO HD is supported only for 1080i and 720p @ 59.94 fps sequences.

Playback3

3 Realtime playback also includes formats supported by Adobe Premiere Pro, such as 
XDCAM EX, P2, and AVCHD. For more information, see “A note about realtime 
playback capabilities” on page 12.

DV/DVCAM, DVCPRO, 
and DVCPRO50
8-bit Uncompressed
MPEG-2 I-frame

DVCPRO HD2

8-bit Uncompressed
MPEG-2 I-frame HD
Offline HD (for playback of 
legacy Matrox Axio offline 
HD projects)

Export to 
disk

All Matrox codecs are 
available for VFW export

All Matrox codecs are avail-
able for VFW export

Render 
previews

8-bit Uncompressed
MPEG-2 I-frame

DVCPRO HD (1080i only)
8-bit Uncompressed
MPEG-2 I-frame HD

DV-1394 
export to 

tape4

4 If you want to export your sequence to a DV-1394 device other than DVCPRO HD, you 
need to copy or import your Matrox sequence into a native Adobe Premiere Pro 
sequence. For more details on exporting to tape, see “Exporting your sequence to tape” 
on page 39.

Not supported in a Matrox 
sequence

DVCPRO HD2
Supported video compression formats
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Supported master output formats
The following table lists the supported master output formats for Matrox RT.X2 
depending on your sequence’s video format.

¦ Note Matrox RT.X2 SD supports SD sequences only.

Sequence video format Supported master output formats

NTSC NTSC

PAL PAL

486p @ 23.98 fps NTSC

486p @ 29.97 fps NTSC

576p @ 25 fps PAL

720p @ 23.98 fps 720p @ 59.94 fps or NTSC

720p @ 25 fps 720p @ 50 fps or PAL

720p @ 29.97 fps 720p @ 59.94 fps or NTSC

720p @ 50 fps 720p @ 50 fps or PAL

720p @ 59.94 fps 720p @ 59.94 fps or NTSC

1440×1080i @ 25 fps 1080i @ 25 fps or PAL

1440×1080i @ 29.97 fps 1080i @ 29.97 fps or NTSC

1440×1080p @ 23.98 fps
1080PsF @ 23.98 fps, 1080i @ 29.97 fps, 
or NTSC

1440×1080p @ 25 fps 1080PsF @ 25 fps or PAL

1440×1080p @ 29.97 fps 1080PsF @ 29.97 fps or NTSC

1080i @25 fps 1080i @ 25 fps or PAL

1080i @ 29.97 fps 1080i @ 29.97 fps or NTSC

1080p @ 23.98 fps
1080PsF @ 23.98 fps , 1080i @ 29.97 fps, 
or NTSC

1080p @ 25 fps 1080PsF @ 25 or PAL

1080p @ 29.97 fps 1080PsF @ 29.97 fps or NTSC
endix B, Matrox RT.X2 Workflows
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This appendix explains how 
you can register your Matrox 
product and obtain customer 
support.
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Appendix C, Matrox Customer Support

How to get Matrox customer support
If you have a problem that you’re unable to solve by referring to the 
documentation for your Matrox product, please contact your Matrox 
representative. He or she should be able to help you quickly correct any 
installation or system configuration problem.

If your representative is unable to solve your problem, contact Matrox for further 
information and assistance.

Registration
You can register your Matrox product in the Matrox Support section of our 
website at www.matrox.com/video/support.  

Only registered users are entitled to customer support, software updates, special 
promotional offers, and access to our user forum.

Keep up to date with our website
In addition to registering your Matrox product, our website offers you 
up-to-the-minute information about Matrox products and software updates. Be 
sure to place our site in your favorites or bookmarks: 
www.matrox.com/video/support.

Contacting us
Matrox is proud to offer worldwide customer support. Please use the contact 
information for your Matrox product and area as provided on our website at 
www.matrox.com/video/support.

http://www.matrox.com/video/support
http://www.matrox.com/video/support
www.matrox.com/video/support
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152

App
Use this glossary as a reference for many of 
the basic terms used in this manual and 
related documentation.

Numerics
1394 See IEEE-1394.

2:3 pulldown A method used to create 
additional video frames when 24 fps film 
footage or 23.98 fps progressive video is 
converted to 29.97 fps interlaced video, such 
as NTSC. To convert a four-frame sequence 
of film or progressive video, five frames of 
video are required. The 2:3 pulldown 
sequence accomplishes this by representing 
the first frame of film or progressive video as 
two fields (1 frame), the second frame as 
three fields (1.5 frames), the third frame as 
two fields (1 frame), and the fourth frame as 
three fields (1.5 frames). See also advanced 
2:3:3:2 pulldown.

2D Short for two-dimensional. An image 
that has height and width only.

3D Short for three-dimensional. An object 
in three dimensions has height, width, and 
depth. Various techniques are used to show 
3D images on 2D surfaces like your computer 
screen.

4:2:2P@ML 4:2:2 Profile@Main Level. 
An international standard video compression 
profile introduced by MPEG-2. It supports 
4:2:2 luminance/chrominance sampling at up 
to 720 × 608 pixel resolution, and data 
transfer rates up to 50 Mb/sec (5.96 MB/sec). 
This profile is used for high-quality 
distribution and for archiving. See also 
MP@ML.

A
A/B roll Typically, A/B roll is an editing 
technique where scenes or sounds on two 
source reels (called roll A and roll B) are 
played simultaneously to create dissolves, 

wipes, and other effects. On nonlinear editing 
systems, A/B roll refers to using two source 
streams (.avi, .wav, .tga, and so on) to create 
an effect.

advanced 2:3:3:2 pulldown A method 
that is often used to convert 23.98 fps 
progressive video to NTSC when the video is 
acquired by a camera shooting at 23.98 fps 
and recorded to DV tape. Advanced 2:3:3:2 
pulldown differs from standard 2:3 pulldown 
in that the two middle frames of a four-frame 
sequence are each converted to three video 
fields. This results in less image degradation 
when a reverse pulldown is performed to 
convert the video back to 23.98 fps 
progressive video.

AGP slot Connection slot to a type of 
expansion bus found in many computers. The 
AGP slot is used to house the AGP display 
card.

alpha key An effect that makes parts of a 
foreground image fully or partially 
transparent based on alpha (transparency) 
values stored within the image’s file, so that 
an underlying image can show through. See 
also chroma key and luma key.

analog component video See 
component video.

analog signal A video or audio signal that 
varies continuously, as opposed to a digital 
signal which varies only by fixed steps.

anti-aliasing A technique that smooths 
jagged edges in computer-generated text or 
graphics.

aspect ratio A width-to-height ratio. For 
example, a 12-by-9-inch image has an aspect 
ratio of 4:3 (four-to-three). Most TV screens 
have a 4:3 aspect ratio. HDTV screens have a 
16:9 aspect ratio.
Glossary of terms
endix D, Matrox RT.X2 Glossary
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assemble editing Recording new video 
and audio material sequentially onto tape. 
Because all the signals are recorded (video, 
audio, and control track), the new material 
completely replaces any previously recorded 
material on the tape. See also insert editing.

AVI Audio Video Interleaved. A video file 
format designed for the Microsoft Windows 
environment. See also codec.

A/V drive A hard drive capable of storing 
high-bandwidth audio/video data.

B
B-frame (Bi-directional frame) A frame 
created during the MPEG or MPEG-2 IBP 
compression process. A B-frame is generated 
by forwards and backwards referencing of the 
P-frames and I-frames respectively, which 
allows it to have the highest compression ratio 
of the three frame types. B-frames contain 
only predictive data (that is, not enough data 
to make up an entire picture), and therefore 
cannot be edited independently.

BIOS Basic Input/Output System settings 
for system components, peripherals, etc. This 
information is stored in a special 
battery-powered memory and is usually 
accessible for changes at computer start-up. 

bitmap A graphics image in which a set of 
values defines each pixel’s relative brightness 
and color.

black level The level of brightness at 
which no light is emitted from the screen 
(reference black). The standard black level is 
7.5 IRE for NTSC video, or 0 IRE for 
NTSC-EIAJ (Japan) and PAL video. Also 
called setup (NTSC video only). See also 
white level, super black, and super white.

Blue Book standard See DV.

bus A shared set of hardware lines that lets 
different parts of your computer transfer 
information between one another. A card 
inserted into an expansion slot of your 
computer makes an electrical connection to 
the bus and effectively becomes part of your 
computer system.

C
capture The process of digitizing video or 
audio material, usually from a VTR or 
camera, and storing it in a file on a hard disk.

chroma key An effect that makes portions 
of a foreground image fully or partially 
transparent based on the color of that image, 
so that an underlying image can show 
through. See also alpha key and luma key.

chrominance The color portion of a video 
signal that carries the hue and saturation 
information. See also luminance.

codec Compressor/decompressor. A 
processor that compresses video to reduce its 
file size by eliminating redundancies in 
information. It also decompresses files to play 
them back.

color bars A standard test signal that 
appears as a series of vertical rows of color by 
which the chrominance and video levels of a 
camera’s output or a recorded signal can be 
checked.

color correction effect A Matrox effect 
that allows various color properties of an 
image to be adjusted. There are controls for 
adjusting the intensity level for hue, 
saturation, contrast, and brightness. The color 
correction effect can correct improper color 
levels of an image that are due to varying 
lighting conditions or incorrect camera 
settings. See also white balancing. 
endix D, Matrox RT.X2 Glossary
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component video A video signal having 
separate channels for the video information, 
as opposed to a combined (composite) signal. 
Y, R-Y, B-Y video is a component video 
signal.

composite video A video signal 
containing luminance and chrominance 
information that has been combined using a 
video standard such as NTSC or PAL. 
Composite video often uses a single RCA or 
BNC cable connection. See also component 
video.

contrast The difference in brightness 
between the lightest and darkest areas of an 
image on the screen.

CPU Central processing unit. The central 
processor of a computer that performs 
calculations and interprets and executes 
commands.

CPU-based effect An effect that takes 
advantage of your computer’s CPU to play 
back in real time. Matrox Flex CPU effects, 
such as the Matrox color correction effects, 
are CPU-based effects. Compare with 
GPU-based effect.

crawl Sideways movement of text across a 
screen. See also roll (1). 

crossfade See dissolve.

cut A direct switch from one video and/or 
audio source to another.

D
D-9 Originally known as Digital-S. A 
variant of the DV format developed by JVC 
that uses a data rate of 50 Mb/sec (5.96 
MB/sec), which is double the data rate of 
most other DV formats. Video is sampled at 
4:2:2 for both NTSC and PAL sources to give 
enhanced chroma resolution. It uses a 1/2” 
metal particle tape.

D10 See IMX.

Digital8 A camcorder video format 
developed by Sony. Digital8 camcorders use 
the DV format to record digital video and 
audio onto 8mm and Hi-8 tapes via any 
device that has an IEEE-1394 interface. 

Digital-S See D-9.

digital signal A signal representing video 
or audio information as binary digits that can 
be easily regenerated with no noise or 
distortion. See also analog signal.

Digital Video See DV.

digitize To convert analog information, 
such as a video signal from a VTR or camera, 
into digital information that can be processed 
and stored by a computer.

Direct memory access (DMA) A 
technique used to rapidly transfer data 
between an attached device, such as a disk 
drive, and the computer’s main memory 
without needing to pass the data through the 
CPU.

DirectX A Microsoft-developed program 
that enables interfaces to support advanced 
hardware features without being written 
specifically for each hardware model. 
DirectShow (formerly called ActiveMovie) is 
part of DirectX.

display card A card that has its own 
memory and processor to handle graphics and 
enhance display capabilities. Also called 
graphics card. See also GPU.

dissolve A transition in which one image 
smoothly fades to another image. It is 
characterized by the gradual ending of one 
image occurring simultaneously with the 
gradual beginning of another. Also called 
crossfade.
endix D, Matrox RT.X2 Glossary
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driver Software that controls a device, such 
as a display card, and enables it to work with 
other software.

drop-frame time code For NTSC video, 
time code is normally produced by a 
generator that counts at 30 frames per second. 
NTSC color signals, however, actually have a 
display frequency rate close to 29.97 frames 
per second. Drop-frame time code 
compensates for this time difference by 
dropping two frames from the count every 
minute except for every tenth minute so that 
the time code matches clock time.

DV Digital Video. A standard digital bit 
stream and compression format (known as the 
Blue Book standard) used to record video and 
audio onto a digital tape. DV is intra-frame 
based, saving each frame separately, and uses 
a fixed 5:1 compression ratio to reduce the 
size of video files. DV’s data rate is fixed at 
25 Mb/sec (2.98 MB/sec). Video is sampled 
at 4:1:1 for NTSC sources or 4:2:0 for PAL 
sources. See also DVCAM, DVCPRO, 
DVCPRO50, and D-9.

DVCAM A variant of the DV format 
developed by Sony that records a 15 micron 
track on a metal evaporated (ME) tape at a 
data rate of 25 Mb/sec (2.98 MB/sec). Video 
is sampled at 4:1:1 for NTSC sources or 4:2:0 
for PAL sources.

DVCPRO A variant of the DV format 
developed by Panasonic that records an 18 
micron track on metal particle tape at a data 
rate of 25 Mb/sec (2.98 MB/sec). Video is 
sampled at 4:1:1 for both NTSC and PAL 
sources. See also DVCPRO HD.

DVCPRO HD A high-definition variant of 
the DVCPRO format developed by Panasonic 
that uses a data rate of 100 Mb/sec. Matrox 
RT.X2 supports DVCPRO HD for 1080i and 
720p sequences.

DVCPRO50 A variant of the DV format 
developed by Panasonic that uses a data rate 
of 50 Mb/sec (5.96 MB/sec), which is double 
the data rate of most other DV formats. Video 
is sampled at 4:2:2 for both NTSC and PAL 
sources to give enhanced chroma resolution. 
It uses the same type of tape as DVCPRO.

DVD Digital Versatile Disc or Digital Video 
Disc. A type of compact disc that can hold 
from 4.7 gigabytes (GB) to 17 GB of 
information. The greatest advantage that 
DVD has over CD is that it can store video as 
well as audio and computer data. For video 
storage, DVD uses MPEG-2 compression, to 
provide better quality than standard VHS.

DVE Digital Video Effect. Generally, an 
effect that resizes and repositions a picture on 
the screen.

DVI Digital Video Interface. A video 
interface technology that maximizes the 
quality of flat-panel LCD monitors and 
modern display cards.

E
Edit Decision List (EDL) A file 
containing a list of edit decision statements 
used to create a video production.

edit master The first generation (original) 
of a final edited tape.

expansion slot Electrical connection slot 
mounted on a computer's motherboard (main 
circuit board). It allows several peripheral 
devices to be connected inside a computer. 
See also AGP slot, PCI slot, PCI Express slot, 
and PCI-X slot.

F
fade to black A transition commonly used 
to signify the end of a scene, in which an 
image or sound smoothly fades to a black 
screen or silence (also called a fade-out 
endix D, Matrox RT.X2 Glossary
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transition). Similarly, you could start a new 
scene with a fade up from black (or fade-in) 
transition.

field One-half of the horizontal lines 
needed to make a complete scan of an 
interlaced video frame. In the NTSC system, 
two consecutive fields of 262.5 lines each 
create a frame of 525 scan lines. In the PAL 
system, two consecutive fields of 312.5 lines 
each create a frame of 625 scan lines.

FireWire Apple Computer’s original 
implementation of the technology that would 
be standardized as IEEE-1394 in 1995.

Flex CPU effect See CPU-based effect.

frame A single video image. An interlaced 
video frame is comprised of two consecutive 
fields (the odd and even fields).

G
garbage matte effect An effect often 
used to crop unwanted objects from a 
foreground image in a chroma or luminance 
key effect. You define the shape of the 
garbage matte, and only the underlying image 
is shown outside the matte.

GOP Group of Pictures. The sequence of I, 
B and/or P-frames produced during MPEG or 
MPEG-2 compression. This sequence of 
frames contains all of the information 
required to reproduce a complete video 
segment. The longer the GOP, the less 
editable it is.

GPU Graphics processing unit. A processor 
that is used primarily for computing 3D 
functions, such as processing 3D DVEs and 
lighting effects. Because the calculations 
required to process these effects are 
CPU-intensive, the GPU lifts this burden from 
the CPU to allow it to perform more 

efficiently. A high-performance display card 
is sometimes referred to as a GPU.

graphics card See display card.

graphics overlay Text or a graphics 
image that’s superimposed on video. Also 
called super.

H
hardware-accelerated effect An effect 
that requires the assistance of dedicated 
hardware to play back in real time. Compare 
with CPU-based effect.

HD Short for HDTV. 

HDTV High Definition Television. A 
digital television format with image 
resolutions up to 1080 vertical scan lines. 
HDTV has a 16:9 aspect ratio. Also called 
HD. See also SDTV.

HDV A high-definition video format that 
uses MPEG-2 video compression at a data 
rate of about 19 Mb/sec for HDV-1 or
25 Mb/sec for HDV-2, and records to standard 
DV format digital video cassettes.

hue The tint or tone of a color. For 
example, the difference between the color 
green and red is its hue.

I
IBP compression See MPEG-2 IBP.

IEEE-1394 An international standard data 
transfer protocol created by Apple Computer 
under the FireWire trademark and 
standardized by the Institute of Electrical and 
Electronics Engineers (IEEE). It enables 
simple, low-cost, realtime data transfer 
between computers and consumer and 
prosumer electronics products, such as DV 
camcorders and DV decks. Commonly 
referred to as 1394.
endix D, Matrox RT.X2 Glossary
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I-frame compression See MPEG-2 
I-frame.

I-frame (Intra-frame) A frame created 
during the MPEG or MPEG-2 compression 
process that contains all the information 
required to reproduce a complete image. It 
allows random access points within a video 
stream, and acts as a reference point for 
B-frames and P-frames to be built. I-frames 
are editable because they contain enough data 
to construct an entire video frame, unlike 
B-frames or P-frames. 

IMX A video recording format developed 
by Sony, and standardized by SMPTE as D10, 
that is used to record video and audio onto a 
hard disk or tape. The IMX data format is 
fully MPEG-2 compliant and supports video 
data rates of 30, 40, and 50 Mb/sec. Video is 
sampled at 4:2:2 for both NTSC and PAL 
sources.

insert editing Recording new video 
and/or audio material onto a prerecorded (or 
striped) tape. Insert edits can be made in any 
order, unlike assemble edits, which must be 
made sequentially.

inter-frame compression A video 
compression method that compares a series of 
frames in a video sequence and removes the 
redundant data. Inter-frame compression 
treats all the frames in the sequence as an 
interdependent group. As a result, most of the 
frames can’t be edited independently. Also 
called temporal redundancy reduction. 
Contrast with intra-frame compression. See 
also GOP.

interlaced scanning A method of 
creating a video image by drawing only the 
odd numbered lines on the screen in one pass, 
then the even numbered lines in the next pass. 
Two passes are therefore required to create a 
complete frame of video. NTSC and PAL 

displays are interlaced. See also progressive 
scanning. 

interleave A technique used to incorporate 
the video and audio portions of a video clip 
into one file. See also AVI. 

intra-frame compression A video 
compression method that removes redundant 
information from within a frame. Intra-frame 
compression treats each frame of a video 
segment independently. Several video 
compression formats use the intra-frame 
method. These include Motion-JPEG, DV, 
and MPEG-2 I-frame. Also called spatial 
redundancy reduction. Contrast with 
inter-frame compression. See also I-frame 
(Intra-frame).

IRE unit An arbitrary unit designated by 
the Institute of Radio Engineers to define the 
amplitude of a video signal. 1 IRE is equal to 
approximately 7 mV.

J
JPEG (pronounced “jay-peg”) Joint 
Photographic Experts Group. A compression 
and storage standard used for still, digital 
images. See also Motion-JPEG.

K
key effect See alpha key, chroma key, and 
luma key.

L
LTC Longitudinal Time Code. Time code 
that is generally encoded as an audio signal 
onto a linear audio track of a tape. This type 
of time code can be read only while the tape is 
moving. See also VITC.

luma key An effect that makes portions of 
a foreground image fully or partially 
transparent based on the luminance of that 
image, so that an underlying image can show 
through. See also alpha key and chroma key.
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luminance The brightness portion of a 
video signal. The luminance of a pixel 
determines its brightness on a scale from 
black to white. See also chrominance.

luminance key See luma key.

M
mark in To select the first frame of a clip.

mark out To select the last frame of a clip.

M-JPEG See Motion-JPEG.

Motion-JPEG A compression and storage 
standard used for motion video. The JPEG 
compression process is applied to each video 
field, in succession. Also called M-JPEG.

MP@ML Main Profile@Main Level. An 
MPEG-2 video compression profile that 
supports 4:2:0 luminance/chrominance 
sampling at up to 720×576 pixel resolution, 
and data transfer rates up to 15 Mb/sec (1.79 
MB/sec). This profile is used for broadcast 
transmission and distribution on DVD. See 
also 4:2:2P@ML. 

MPEG A video compression standard that 
specifies a series of compression profiles and 
image resolution levels, introduced in 1990 by 
the Motion Picture Experts Group. MPEG 
takes advantage of the redundancy inherent in 
video data through a combination of 
inter-frame and intra-frame redundancy 
reduction. The MPEG standard supports data 
transfer rates of up to 1.5 Mb/sec (0.2 
MB/sec). Also called MPEG-1. See also 
MPEG-2, inter-frame (IBP) compression, and 
intra-frame (I-frame) compression.

MPEG-1 See MPEG.

MPEG-2 A video compression standard 
that improves upon the MPEG standard by 
supporting data rates of up to 100 Mb/sec (12 
MB/sec), scalable modes, field or frame 

searching, and much larger screen sizes. See 
also intra-frame (I-frame) compression, 
inter-frame (IBP) compression, 4:2:2P@ML, 
and MP@ML.

MPEG-2 IBP An MPEG-2 compression 
type that uses inter-frame compression to 
create a group of I, B, and P-frames. Used for 
broadcast transmissions and distribution on 
DVD. See also GOP. 

MPEG-2 I-frame An MPEG-2 
compression type that uses only intra-frame 
compression (that is, only I-frames are 
created). Used for high-quality distribution 
and for archiving.

MPEG HD An HD video recording format 
developed by Sony that uses 
industry-standard MPEG-2 IBP compression 
and supports data rates of 17.5, 25, and 
35 Mb/sec. Sony XDCAM HD devices use 
MPEG HD compression for video recording.

mV Abbreviation for millivolt 
(one-thousandth of a volt). Unit of 
measurement sometimes used to define the 
amplitude of a video signal. See also IRE 
unit.

MXF Material eXchange Format. A file 
exchange format standardized by SMPTE that 
assures interoperability among devices and 
systems. Panasonic P2 (Professional Plug-in) 
as well as Sony XDCAM and XDCAM HD 
use .mxf files rather than .mov, .avi, or .mpg 
files, for example. MXF is designed for 
today’s file-based workflows and provides a 
common way of packaging video and audio 
along with metadata so that information about 
the content is maintained as it flows through 
the production process.

N
nonlinear editing Random access editing 
that generally uses video and audio clips 
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stored on disks. Nonlinear editing programs 
let you rearrange and edit clips without 
having to redo the entire production, and 
provide instant cueing to any frame in a clip 
without waiting for tapes to rewind.

NTSC National Television Systems 
Committee. The NTSC RS-170A standard 
defines a method of broadcasting a color 
signal that can be received by both 
monochrome and color TVs. It uses a 
composite interlaced display comprised of 
525 scan lines per frame, refreshed at a rate of 
approximately 30 frames per second. 
Broadcast systems in North America and 
Japan use the NTSC standard.

O
OP1a An Operational Pattern (OP) for the 
MXF file format that interleaves the video 
and audio into a single .mxf file. Sony 
XDCAM .mxf files use the OP1a Operational 
Pattern. See also OP-Atom.

OP-Atom An Operational Pattern (OP) for 
the MXF file format that separates the video 
and audio into separate .mxf files, but retains 
the common metadata among related files. 
Panasonic P2 .mxf files use the OP-Atom 
Operational Pattern. See also OP1a.

organic wipe A wipe effect that uses a 
grayscale gradient pattern to switch from one 
image to another by gradually revealing the 
second image according to the pattern.

P
PAL Phase Alternate Line. A video 
standard that uses a composite interlaced 
display comprised of 625 scan lines per 
frame, refreshed at a rate of 25 frames per 
second. This is the broadcast video standard 
for most of Europe.

PCI slot Connection slot to a type of 
expansion bus found in many computers. It is 

smaller in size than older ISA slots and 
provides connections to the PCI host bus at 
speeds up to 66 MHz.

PCIe slot See PCI Express slot.

PCI Express slot A type of PCI slot that 
uses a different and much faster 
communications protocol than a 32-bit PCI 
slot. PCI Express can accommodate the 
higher speeds required for high-performance 
peripherals such as display cards and network 
controllers. PCI Express slots are available in 
different sizes (x1, x4, x8, and x16). The 
Matrox RT.X2 card is installed in a PCI 
Express slot. Also called PCIe slot.

PCI-X slot A type of PCI slot that 
increases the speed at which data can move 
within the computer from 66 MHz to up to 
133 MHz.

P-frame (Predicted frame) A frame 
created during the MPEG or MPEG-2 IBP 
compression process. A P-frame is created by 
using motion vectors to predict the 
differences between it and the closest 
previous I-frame or P-frame. This forward 
prediction allows for higher compression than 
with I-frames, but not as high as with 
B-frames. P-frames, like B-frames, contain 
only predictive data and therefore cannot be 
edited independently. 

pixel Picture element. The smallest portion 
of an image that can be written to a display. 
Each pixel in an image represents a single dot 
on the computer screen. A picture’s resolution 
depends on the number of pixels on the 
screen.

Plug and Play A hardware standard for 
auto-configuration. It refers to the ability of 
computer hardware to detect and configure 
expansion devices such as your Matrox 
hardware. Windows supports Plug and Play.
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plug-in Software that adds functionality 
and/or features to an application. For 
example, the Matrox realtime plug-in for 
Adobe Premiere Pro adds realtime Matrox 
effects and transitions to Adobe Premiere Pro.

proc amp An electronic device that adjusts 
the different aspects of a video signal, such as 
its hue, saturation, and contrast.

progressive scanning A method of 
creating a video image by drawing all the 
lines of a screen sequentially so that the 
complete image is displayed in one pass. 
VGA displays and some HDTV formats use 
progressive scanning. Progressive scanning 
produces smoother pictures than interlaced 
scanning, but uses more bandwidth.

pulldown detection A method of 
identifying the extra video frames that are 
added when 24 fps film footage or 23.98 fps 
progressive video is converted to 29.97 fps 
interlaced video. See also 2:3 pulldown and 
advanced 2:3:3:2 pulldown.

R
realtime effect An effect that is played 
back instantly, without having to be rendered 
by an editing program.

render To compute an image or effect 
using a nonlinear editing, compositing, or 
animation program. The result is generally 
saved in a file on the computer.

RGB parade A specialized scope that 
displays the red, green, and blue components 
of a video signal.

RGB video A component video signal that 
uses three signals to carry the separate Red, 
Green, and Blue channels of colored images.

roll 1. Vertical movement of text across the 
screen. Also called scroll. See also crawl. 

2. Unwanted vertical roll of a video image, 
indicating unstable sync.

RS-232 A non-differential serial data 
transmission standard used for computer 
connections. See also serial control.

RS-422 A differential serial data 
transmission standard that is often used for 
linking video production equipment (VTRs, 
mixers, etc.). Because this standard is 
differential, RS-422 connections are less 
subject to interference and noise than RS-232 
connections. See also serial control.

S
saturation A measure of the depth of a 
color. Fully saturated colors are vivid, while 
colors that lack saturation look washed out or 
faded.

scroll See roll (1).

SD Short for SDTV.

SDTV Standard Definition Television. A 
television format with image resolutions up to 
525 vertical scan lines for NTSC video and 
625 vertical scan lines for PAL video. SDTV 
can have a 4:3 or 16:9 aspect ratio. See also 
HDTV.

SECAM Séquentiel Couleur Avec Mémoire 
(sequential color with memory). A color 
television system developed in France and the 
former USSR. It uses a composite interlaced 
display comprised of 625 scan lines per 
frame, refreshed at a rate of 25 frames per 
second. The color difference signals are 
transmitted sequentially on alternate lines.

serial control A method of remotely 
controlling a device via a data line. The 
control data is transmitted in serial form (that 
is, one bit after another), such as for RS-232 
and RS-422 connections.
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setup See black level.

SMPTE Society of Motion Picture and 
Television Engineers. A professional society 
of motion picture and television engineers 
that prepares standards and documentation for 
television production.

spatial redundancy reduction See 
intra-frame compression.

striping a tape Preparing a tape for 
editing by recording continuous control track, 
time code, and a video signal (such as black 
or color bars).

super See graphics overlay.

super black Video that is darker than the 
standard black level. See also super white.

super white Video that is brighter than the 
standard white level. See also super black.

SVCD Super Video CD. A standard for 
storing video and audio on a CD that provides 
better video quality than VCD and standard 
VHS. Video is compressed using MPEG-2 at 
2500 Kbps, and audio is compressed as 
MPEG-1, layer II, at 224 Kbps. An SVCD 
can hold about 30 minutes of material. Super 
Video CDs will play back on some DVD 
set-top players. 

S-Video A component video signal in 
which the luminance (Y) and chrominance 
(C) information are separate. S-VHS 
videocassette recorders use the S-Video 
format. Also called Y/C video.

sync A circuit or signal that directs the 
electron gun in a camera or TV picture tube to 
hold a picture steady on the screen. It also 
synchronizes the electronics of other video 
equipment.

sync generator An electrical device that 
generates sync (timing) signals used to 

synchronize video equipment and keep 
pictures stable on the screen.

T
TBC See time base corrector.

telecine process A process that transfers 
film (negative or positive) to SD or HD video 
tape. The telecine process shines a light 
source through each frame, converting the 
optical images to an electronic signal that is 
then recorded to video tape. 

temporal redundancy reduction See 
inter-frame compression.

time base corrector (TBC) An 
electronic device that, when connected to the 
output of a VTR, corrects the stability and 
timing of the VTR’s playback video. This is 
achieved by stripping the unstable horizontal 
and vertical sync pulses from the video signal, 
and replacing them with new, clean sync 
pulses.

time code A sequential code number 
assigned to successive video frames on tape. 
Each frame has its own time code, which is 
electronically encoded on the tape in the form 
hours:minutes:seconds:frames. See also 
drop-frame time code, LTC, and VITC.

timeline The graphical representation 
(normally a horizontal line) of a video 
sequence. It is usually divided into 
hours:minutes:seconds:frames, and is used to 
position video, audio, graphics, and video 
effects that make up the sequence.

tonal range The range of light and dark 
areas in an image. Tonal range can be divided 
into three different areas: shadows, midtones, 
and highlights. Shadows are the darkest areas 
of an image, highlights are the lightest areas, 
and midtones are the areas with tones 
between the lightest and darkest areas.
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V
VCD Video CD. A standard for storing 
video and audio on a CD that provides 
slightly better video quality than standard 
VHS. Video is compressed using MPEG-1 at 
1100 Kbps, and audio is compressed as 
MPEG-1, layer II, at 224 Kbps. A VCD can 
hold about 60 minutes of material. Video CDs 
can play back on most DVD set-top players. 
See also SVCD.

vectorscope A device that measures the 
phase and amplitude of the color components 
of a video signal.

VITC Vertical Interval Time Code. Time 
code that is encoded onto the vertical 
blanking interval of a video signal. VITC can 
be read by a VTR whenever an image is 
displayed, but not usually during high-speed 
operation. See also LTC.

voice-over Narration added to a video 
segment and mixed in louder than the original 
background sounds.

W
WAV An audio data file format developed 
by Microsoft and IBM. This format is the 
standard for Windows and can be played by 
most applications that can support sound.

white balancing A color correction 
technique that adjusts the color levels of an 
image using white or gray as a color reference 
point. White balancing assumes that when a 
white object can be made to look white, the 
other color levels will also be accurate. White 
balancing is used to correct improper color 
levels of an image that are due to varying 
lighting conditions or incorrect camera 
settings. White balancing can be performed 
using the Matrox color correction effect, and 
is also available as a setting on most cameras.

white level The brightest “legal” level of a 
video signal (reference white), which is at 100 
IRE. See also black level, super black, and 
super white.

wipe A transition in which one image is 
gradually replaced by another image that is 
revealed in a given pattern. For example, the 
second image could be revealed from the top 
of the screen downwards until it fills the 
entire screen. See also organic wipe.

X
x-y-z coordinate system A 3D 
positioning system that includes a third (z) 
axis running perpendicular to the horizontal 
(x) and vertical (y) axes. The x-y-z coordinate 
system is used in computer graphics for 
creating models with height, width, and 
depth, and for moving models in 3D space.

Y
Y waveform A specialized scope that 
displays the luminance (Y) values of a video 
signal.

Y/C video See S-Video.

YC waveform A specialized scope that 
displays the combined luminance (Y) and 
chrominance (C) of a video signal.

Y, Pb, Pr video See Y, R-Y, B-Y video.

Y, R-Y, B-Y video An analog component 
video signal comprised of three channels: Y 
(luminance), R-Y (red minus luminance), and 
B-Y (blue minus luminance). Also called Y, 
Pb, Pr video.
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1080i @ 25 fps sequence

working with 141
1080i @ 29.97 fps sequence

working with 141
1440x1080i/p sequences

working with 140
3ds Max WYSIWYG plug-in

See Autodesk 3ds Max WYSIWYG plug-in
486p @ 23.98 fps sequence

working with 136
720p sequences

working with 138, 139

A
A/V synchronization

adjusting for playback of clips 14, 99
A/V Tools

See Matrox A/V Tools
Adobe After Effects WYSIWYG plug-in

about 114
required steps 115
See also Matrox WYSIWYG plug-ins

Adobe Encore
capturing material for DVD authoring 20
exporting sequence for DVD authoring 36

Adobe Photoshop WYSIWYG plug-in
about 114
required steps 115
See also Matrox WYSIWYG plug-ins

Adobe Premiere Pro
applying Matrox video effects 49
applying Matrox video transitions 49
available Matrox effects 48
capture settings 20
creating Matrox chroma key effects 78

overview 77
creating Matrox color correction

primary 52
secondary 67

creating Matrox luma key effect 85
overview 84

creating Matrox wipe transitions 88
creating new Matrox project 11

displaying warnings in Events panel  12
DV-1394 output settings 18
enabling/disabling Motion effect  16
enabling/disabling realtime effects  15
exporting sequence to Matrox AVI file  33
exporting sequence to tape 39
general settings 13
loading Matrox sequence presets  11
sequence settings 13
setting up RS-422 device control  37
setting up scratch disks 11
speed changes 90
video preview settings 19

Advanced pulldown
description of  133
See also Standard pulldown

After Effects WYSIWYG plug-in
See Adobe After Effects WYSIWYG plug-in

Allow super black 17
Allow super white 17
Analog output type

selecting 17
Anamorphic video

outputting 16
Aspect ratio

creating SD project in 16:9 format 45
selecting conversion setting for output video 16
selecting for source video 22, 101

Audio capture settings
in Adobe Premiere Pro 24
in Matrox A/V Tools 103
in Matrox AV/Tools 103
monitoring audio levels  27
selecting channels 25, 104

Audio levels
monitoring for capture 27
recording and playback volume controls 10

Auto balance
performing using color correction 62

Auto key
performing using the chroma key graph 81
performing using the selective key graph 75

Autodesk 3ds Max WYSIWYG plug-in
about  114
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required steps 115
See also Matrox WYSIWYG plug-ins

Autodesk Combustion WYSIWYG plug-in
about 114
required steps 116
See also Matrox WYSIWYG plug-ins

Automatic Gain Control
selecting 23, 102

AVI files
capturing using Adobe Premiere Pro 20
capturing using Matrox A/V Tools 100, 105
exporting using Adobe Premiere Pro 33
naming in Matrox A/V Tools 105
rendering using Matrox VFW codecs 118, 121

C
Calibration, monitor

See DVI monitor calibration
Capture format

selecting for video capture 22, 101
Capturing using Adobe Premiere Pro

monitoring audio levels for  27
specifying Matrox settings for 20

Capturing using Matrox A/V Tools 105
from tape without device control  106
live video 105
specifying audio settings for 103
specifying video settings for 100

Chroma clamper effect
using 90

Chroma filtering and chroma interpolation
for rendering to VFW files 121

Chroma key effect
creating 78
overview 77
using the chroma key graph 81

Chroma key graph
using 81

Chroma key shadow effect
creating 78
overview 77

Clip information
updating in Matrox A/V Tools 106

Codec
Matrox DV/DVCAM 22, 35, 101

Matrox DVCPRO 22, 35, 101
Matrox DVCPRO HD 35
Matrox DVCPRO50 35
Matrox MPEG-2 IBP 31
Matrox MPEG-2 I-frame 22, 29, 35, 102
Matrox MPEG-2 I-frame + Alpha 35
Matrox MPEG-2 I-frame HD 22, 29, 35, 102
Matrox MPEG-2 I-frame HD + Alpha 35
Matrox Uncompressed HD 36
Matrox Uncompressed HD + Alpha 36
Matrox Uncompressed SD 36
Matrox Uncompressed SD + Alpha 36
Matrox VFW codecs 121

Color balance graph
using 59

Color correction
adjusting tonal range 58
color matching clips 63
performing an auto balance 62
primary 52
secondary 67

using the selective key graph 72
using RGB curves 56
using Split View in the Program Monitor 55
using the color balance graph 59
using the luma mapping graph 65
using the Split View option 54

Color matching clips
using color balance graph 63

Color pass effect
creating with secondary color correction 76

Color space conversion options
for rendering to VFW files 120

Combustion WYSIWYG plug-in
See Autodesk Combustion WYSIWYG plug-in

Compression formats
supported 147

Compressor
selecting for VFW render 121

Customer support 150

D
Device control

exporting to tape using DV-1394 in Premiere Pro 43
exporting to tape using RS-422 in Premiere Pro 39
obtaining frame-accurate RS-422 export to tape 42
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setting up RS-422 in Premiere Pro 37
Drop frame time code

displaying in Matrox A/V Tools 97
Dropped frames in video playback

reporting 15
DV/DVCAM codec

See Matrox DV/DVCAM codec
DV-1394 device

as source in Adobe Premiere Pro 21
settings in Adobe Premiere Pro 18

DV-1394 device control
exporting to tape with 43

DV-1394 output settings 18
DVCPRO codec

See Matrox DVCPRO codec
DVCPRO HD material

capturing native 22
exporting to DV-1394 device 43

DVI monitor calibration
calibrating your DVI monitor 6
enabling and disabling the Matrox DVI calibration 
settings 8
loading Matrox DVI calibration settings 7
overview 6

DVI output
forcing to 60 Hz for WYSIWYG preview 115

DVI output type
selecting 17

DVL files
saving and loading 107

E
Editing video format

selecting in Matrox A/V Tools 97
Effect presets 49
Error notification

in Events panel 12
with X.info 129

Events panel
displaying warnings in 12

Exporting to disk
Matrox AVI files 33
MPEG-2 for DVD authoring 36
See also Rendering using VFW programs

Exporting to tape 39
enabling DV-1394 output for DVCPRO HD 18
using DV-1394 device control in Premiere Pro 43
using RS-422 device control in Premiere Pro 39

eyeon Fusion WYSIWYG plug-in
about  114
required steps 116
See also Matrox WYSIWYG plug-ins

F
Fusion WYSIWYG plug-in

See eyeon Fusion WYSIWYG plug-in

G
General settings

in Adobe Premiere Pro 13
in Matrox A/V Tools 98

Glossary 152

H
Hardware information

displaying with X.info 128
HD sequences

supported compression formats 147
working with 138

I
Input aspect ratio

selecting 22, 101
Input device

selecting 21
Input format

selecting 22, 101
Input source

selecting for audio capture 24, 103
selecting for video capture 21, 101

Internet site, Matrox 150
Isolating colors in a clip

using secondary color correction 76

K
Key colors

modifying using the chroma key graph 81
Keyboard shortcuts

for Matrox A/V Tools 111
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L
Letterbox video

outputting 16
LightWave 3D WYSIWYG plug-in

See NewTek LightWave 3D WYSIWYG plug-in
Luma key effect

creating 85
overview 84
using the luma key graph 86

Luma key graph
using 86

Luma mapping graph
using 65

Luminance range settings
for rendering to VFW files 120

M
M2V files

capturing using Adobe Premiere Pro 20, 28
Mask

applying to Matrox effects 50
applying using Select Mask 51

Master output format
selecting 16
supported formats based on sequence format 148

Matrox
contacting us 150
WWW site 150

Matrox A/V Tools
about 92
audio capture settings 103
CAM button 93
capture settings 100
capturing clips 105
capturing from tape without device control  106
capturing live video 105
changing In/Out icons 106
clip ID and clip names 105
clip list 107

adding clips 107
copying clips 108
deleting clips 108
detaching and resizing 109
moving clips 108
playing back clips 107

saving and loading 107
defining options 96
Disk button 93
editing clips 106
general settings 98
grabbing a single-frame image 109
keyboard shortcuts 111
pop-up menu 94
time code

displaying 96
transport controls 94
video capture settings 100
video output settings 100

Matrox DV/DVCAM codec
selecting for capture 22, 101
selecting for export in Premiere Pro 35
selecting for VFW render 121

Matrox DVCPRO codec
selecting for capture 22, 101
selecting for export in Premiere Pro 35
selecting for VFW render 121

Matrox DVCPRO HD codec
configuring for VFW render 122
selecting for export in Premiere Pro 35
selecting for VFW render 121

Matrox DVCPRO50 codec
selecting for export in Premiere Pro 35
selecting for VFW render 121

Matrox DVI Calibration Utility
using 6

Matrox MPEG-2 IBP codec
configuring in Adobe Premiere Pro 31

Matrox MPEG-2 I-frame + Alpha codec
configuring for VFW render 123
selecting for export in Premiere Pro 35
selecting for VFW render 121

Matrox MPEG-2 I-frame codec
configuring for VFW render 123
configuring in Adobe Premiere Pro 29
selecting for capture 22, 102
selecting for export in Premiere Pro 35
selecting for VFW render 121

Matrox MPEG-2 I-frame HD + Alpha codec
configuring for VFW render 123
selecting for export in Premiere Pro 35
selecting for VFW render 121
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Matrox MPEG-2 I-frame HD codec
configuring for VFW render 123
configuring in Adobe Premiere Pro 29
selecting for capture 22, 102
selecting for export in Premiere Pro 35
selecting for VFW render 121
using for offline editing 144
using for online editing 143
workflow example for offline editing on remote sys-
tem 146
workflow example for offline editing on RT.X2 144
workflow example for online editing 143

Matrox Player
using as the default 12

Matrox project
creating a new 11
realtime playback capabilites in Premiere Pro 12

Matrox RT technology
enabling/disabling 15

Matrox RT.X2
documentation 3
glossary 152
monitoring using X.info 126
supported compression formats 147
supported master output formats 148
workflows 136

Matrox RT.X2 LE
See Matrox RT.X2

Matrox RT.X2 SD
See also Matrox RT.X2

Matrox Uncompressed HD + Alpha codec
configuring for VFW render 122
selecting for export in Premiere Pro 36
selecting for VFW render 122

Matrox Uncompressed HD codec
configuring for VFW render 122
selecting for export in Premiere Pro 36
selecting for VFW render 122

Matrox Uncompressed SD + Alpha codec
configuring for VFW render 122
selecting for export in Premiere Pro 36
selecting for VFW render 122

Matrox Uncompressed SD codec
configuring for VFW render 122
selecting for export in Premiere Pro 36
selecting for VFW render 122

Matrox video effects
filtering in Effects panel  48
how to apply 49

Matrox video transitions
filtering in Effects panel  48
how to apply 49

Matrox WYSIWYG Control Panel
using 114

Matrox WYSIWYG plug-ins
about  114
required steps 115

Matrox X.info
using 126

Monitor calibration
See DVI monitor calibration

Monitoring your system
with X.info 126

Motion effect
enabling/disabling realtime 16

MPEG-2 IBP codec
See Matrox MPEG-2 IBP codec

MPEG-2 I-frame codec
See Matrox MPEG-2 I-frame codec

MPEG-2 I-frame HD codec
See Matrox MPEG-2 I-frame HD codec

MPEG-2 I-frame HD settings
selecting in Adobe Premiere Pro 29

MPEG-2 I-frame settings
selecting in Adobe Premiere Pro 29

MTX files
loading Matrox DVI calibration settings 7
saving Matrox DVI calibration settings 7

Mulit-camera sequence
displaying camera previews on video monitor 12

N
NewTek LightWave 3D WYSIWYG plug-in

about  114
required steps 116
See also Matrox WYSIWYG plug-ins

Non-drop frame time code
displaying in Matrox A/V Tools 97

NTSC setup level
selecting for analog video 17
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P
Panasonic VariCam

capturing material from 23, 138
Photoshop WYSIWYG plug-in

See Adobe Photoshop WYSIWYG plug-in
Player settings

defining 12
Preconfigured Matrox video effects

applying 49
Proc amps

adjusting using Matrox color correction 68
Pulldown

description of advanced 133
description of standard 132
used in 1440x1080p @ 23.98 fps sequence 140
used in 486p @ 23.98 fps sequence 136

Pulldown method
selecting for video output  17

R
Registering your Matrox product  150
Rendering using Matrox VFW codecs

before you start  119
selecting color space conversion options 120
selecting compressor  121

Reporting dropped frames
during video playback 15

RGB curves
using 56

RS-422 device control
obtaining frame-accurate export to tape 42
setting up 37

S
Scratch disks

specifying 11
Scrubbing mode

selecting 14, 98
SD sequences

supported compression formats 147
Secondary color correction

creating a color pass effect 76
Select Mask

using 51

Selective key graph
using 72

Sequence presets
for SD "24P" material 136
loading for Matrox RT.X2 11
See also Matrox RT.X2 workflows

Sequence settings
in Adobe Premiere Pro 13

Setup level
selecting for NTSC analog video 17

Sound card
recording and playback volume controls 10

Speed changes
selecting speed control method 90

Split View
using 54
working with in the Program Monitor 55

Standard pulldown
description of 132
See also Advanced pulldown

Style conventions
of this manual 2

Super black
allowing for output video 17

Super white
allowing for output video 17

System information
displaying with X.info 126

T
Technical support 150
Temperatures

monitoring 129
TGA files

creating using Matrox A/V Tools 109
Time code

displaying in Matrox A/V Tools 96, 97

V
VariCam capture 23, 138
Video capture settings

in Adobe Premiere Pro 20
in Matrox A/V Tools 101

Video for Windows programs 118
rendering Matrox AVI file 121
Index
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Video formats
expressed in RT.X2 documentation 3

Video luma level 14, 99
Video output settings

in Adobe Premiere Pro 16
in Matrox A/V Tools 100

Video preview settings
in Adobe Premiere Pro 19

Volume controls
recording and playback settings 10

VU meters 27

W
Warnings

displayed for hardware issues by X.info 129
displaying in Adobe Premiere Pro’s Events panel 12
re-enabling using X.info 127

WAV files
capturing using Adobe Premiere Pro 24
capturing using Matrox A/V Tools 103

Widescreen format
editing SD material on Matrox RT.X2 45

Wipe transitions
creating 88

Workflows
for Matrox RT.X2 136

WWW site, Matrox 150
WYSIWYG Control Panel

See Matrox WYSIWYG Control Panel
WYSIWYG plug-ins

See Matrox WYSIWYG plug-ins

X
X.info

error notification 129
hardware information 128
monitoring temperatures 129
system information 126
using 126

XMP files
created for M2V clips 28
Index
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